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Introduction

This book is drawn from more than 20 years of IT experience. I have taken that
experience and translated it into a Windows Server 2016 book that will help
you not only prepare for the MCSA: Windows Server 2016 exams but also
develop a clear understanding of how to install and configure Windows Server
2016 while avoiding all of the possible configuration pitfalls.

Many Microsoft books just explain the Windows operating system, but with
MCSA: Windows Server 2016 Complete Study Guide, 1 go a step further by
providing many in-depth, step-by-step procedures to support my explanations
of how the operating system performs at its best.

Microsoft Windows Server 2016 is the newest version of Microsoft’s server
operating system software. Microsoft has taken the best of Windows Server
2003, Windows Server 2008, and Windows Server 2012 and combined them
into the latest creation, Windows Server 2016.

Windows Server 2016 eliminates many of the problems that plagued the
previous versions of Windows Server, and it includes a much faster boot time
and shutdown. It is also easier to install and configure, and it barely stops to
ask the user any questions during installation. In this book, I will show you
what features are installed during the automated installation and where you
can make changes if you need to be more in charge of your operating system
and its features.

This book takes you through all the ins and outs of Windows Server 2016,
including installation, configuration, Group Policy Objects, auditing, backups,
and so much more.

Windows Server 2016 has improved on Microsoft’s desktop environment,
made networking easier, enhanced searching capability, and improved
performance—and that’s only scratching the surface.

When all is said and done, this is a technical book for IT professionals who
want to take Windows Server 2016 to the next step and get certified. With this
book, you will not only learn Windows Server 2016 and ideally pass the exams,
but you will also become a Windows Server 2016 expert.

The Microsoft Certification Program

Since the inception of its certification program, Microsoft has certified more
than 2 million people. As the computer network industry continues to increase
in both size and complexity, this number is sure to grow—and the need for
proven ability will also increase. Certifications can help companies verify the

Hi va- Net wor k. Corr 2
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skills of prospective employees and contractors.

The Microsoft certification tracks for Windows Server 2016 include the
following:

MCSA: Windows Server 2016 The MCSA is now the lowest-level
certification you can achieve with Microsoft in relation to Windows Server
2016. It requires passing three exams: 70-740, 70-741, and 70-742.

MCSE: Cloud Platform and Infrastructure The MCSE certifications, in
relation to Windows Server 2016, require that you become an MCSA first and
then pass two additional exams. The additional exams will vary depending on
which of the two MCSE tracks you choose. For more information, visit

Microsoft’s website at www.microsoft.com/learning.

How Do You Become Certified on Windows Server 2016?

Attaining Microsoft certification has always been a challenge. In the past,
students have been able to acquire detailed exam information—even most of
the exam questions—from online “brain dumps” and third-party “cram” books
or software products. For the new generation of exams, this is simply not the
case.

Microsoft has taken strong steps to protect the security and integrity of its new
certification tracks. Now prospective candidates must complete a course of
study that develops detailed knowledge about a wide range of topics. It
supplies them with the true skills needed, derived from working with the
technology being tested.

The new generations of Microsoft certification programs are heavily weighted
toward hands-on skills and experience. It is recommended that candidates
have troubleshooting skills acquired through hands-on experience and working
knowledge.

Fortunately, if you are willing to dedicate the time and effort to learn Windows
Server 2016, you can prepare yourself well for the exam by using the proper
tools. By working through this book, you can successfully meet the
requirements to pass the Windows Server 2016 exams.

MCSA Exam Requirements

Candidates for MCSA certification on Windows Server 2016 must pass at least
the following three Windows Server 2016 exams:

= 70-740: Installation, Storage, and Compute with Windows Server 2016
m 70-741: Networking with Windows Server 2016
= 70-742: Identity with Windows Server 2016
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‘% For those who have a qualifying certification, they can take the

Upgrading exam “Upgrading Your Skills to MCSA: Windows Server 2016”
(Exam 70-743). The objectives for this exam span the three individual
exams. This book covers all of the objectives for the Upgrading exam. For
details about the exam, visit Microsoft’s website at
www.microsoft.com/learning.

g J

Microsoft provides exam objectives to give you a general overview of possible
areas of coverage on the Microsoft exams. Keep in mind, however, that exam
objectives are subject to change at any time without prior notice and at
Microsoft’s sole discretion. Visit the Microsoft Learning website
(www.microsoft.com/learning) for the most current listing of exam objectives.
The published objectives and how they map to this book are listed later in this
Introduction.

( N\

‘éﬁ For a more detailed description of the Microsoft certification

programs, including a list of all the exams, visit the Microsoft Learning

website at: www.microsoft.com/learning.

(& J

Tips for Taking the Windows Server 2016 Exams
Here are some general tips for achieving success on your certification exam:

m Arrive early at the exam center so that you can relax and review your study
materials. During this final review, you can look over tables and lists of
exam-related information.

= Read the questions carefully. Do not be tempted to jump to an early
conclusion. Make sure you know exactly what the question is asking.

= Answer all questions. If you are unsure about a question, mark it for review
and come back to it at a later time.

= On simulations, do not change settings that are not directly related to the
question. Also, assume the default settings if the question does not specify
or imply which settings are used.

= For questions about which you’re unsure, use a process of elimination to
get rid of the obviously incorrect answers first. This improves your odds of
selecting the correct answer when you need to make an educated guess.

Exam Registration

At the time this book was released, Microsoft exams are given two ways. You
can take the exam live online or through the more than 1,000 Authorized VUE
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Testing Centers around the world. For the location of a testing center near you,
go to VUE’s website at www.vue.com. If you are outside of the United States
and Canada, contact your local VUE registration center.

Find out the number of the exam that you want to take and then register with
the VUE registration center nearest to you. At this point, you will be asked for
advance payment for the exam. The exams are $165 each, and you must take
them within one year of payment. You can schedule exams up to six weeks in
advance or as late as one working day prior to the date of the exam. You can
cancel or reschedule your exam if you contact the center at least two working
days prior to the exam. Same-day registration is available in some locations,
subject to space availability. Where same-day registration is available, you
must register a minimum of two hours before test time.

When you schedule the exam, you will be provided with instructions regarding
appointment and cancellation procedures, ID requirements, and information
about the testing center location. In addition, you will receive a registration
and payment confirmation letter from VUE.

Who Should Read This Book?

This book is intended for individuals who want to earn their MCSA: Windows
Server 2016 certification.

This book will not only help anyone who is looking to pass the Microsoft
exams, it will also help anyone who wants to learn the real ins and outs of the
Windows Server 2016 operating system.

What’s Inside?

Here is a glance at what’s in each chapter:

Chapter 1: Installing Active Directory In the first chapter, I will explain
the benefits of using Active Directory. I will explain how Forests, Trees, and
Domains work and I will also show you how to install Active Directory.

Chapter 2: Administer Active Directory This chapter shows you how to
create accounts in Active Directory. I will show you how to do bulk imports
into Active Directory and also how to create and manage groups. I will also
show you how to create and manage service accounts.

Chapter 3: Maintaining Active Directory In this chapter I explain how to
configure Active Directory components like an RODC, DFSR, and trusts. I will
also show you how to configure and use Active Directory snapshots.

Chapter 4: Implementing GPOs This chapter will show you how to
implement and configure Group Policy Objects (GPOs).

Chapter 5: Understanding Certificates This chapter takes you through


http://www.vue.com
https://technet24.ir
https://technet24.ir

the different ways to create and manage configure certificates. I will show you
how to install and configure a Certificate Server.

Chapter 6: Configure Access and Information Protection Solutions
You will see the different ways that you can setup and configure Active
Directory Federation Services. I will also show you how to configure a Web
Application Proxy.

What’s Included with the Book

This book includes many helpful items intended to prepare you for the MCSA:
Windows Server 2016 certification.

Assessment Test There is an assessment test at the conclusion of the
Introduction that can be used to evaluate quickly where you are with Windows
Server 2016. This test should be taken prior to beginning your work in this
book, and it should help you identify areas in which you are either strong or
weak. Note that these questions are purposely more simple than the types of
questions you may see on the exams.

Objective Map and Opening List of Objectives Later in this
Introduction, I include a detailed exam objective map showing you where each
of the exam objectives are covered. Each chapter also includes a list of the
exam objectives that are covered.

Helpful Exercises Throughout the book, I have included step-by-step
exercises of some of the more important tasks that you should be able to
perform. Some of these exercises have corresponding videos that can be
downloaded from the book’s website. Also, in the following section I have a
recommended home lab setup that will be helpful in completing these tasks.

Exam Essentials The end of each chapter also includes a listing of exam
essentials. These are essentially repeats of the objectives, but remember that
any objective on the exam blueprint could show up on the exam.

Chapter Review Questions Each chapter includes review questions. These
are used to assess your understanding of the chapter and are taken directly
from the chapter. These questions are based on the exam objectives, and they
are similar in difficulty to items you might actually receive on the MCSA:
Windows Server 2016 exams.

’% The Sybex Interactive Online Test Bank, flashcards, videos, and
glossary can be accessed at http://www.wiley.com/go/sybextestprep.

Interactive Online Learning Environment and Test Bank

Hi va- Net wor k. Corr 2
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The interactive online learning environment that accompanies this study guide
provides a test bank with study tools to help you prepare for the certification
exams and increase your chances of passing them the first time! The test bank
includes the following elements:

Sample Tests All of the questions in this book are provided, including the
assessment test, which you’ll find at the end of this Introduction, and the
chapter tests that include the review questions at the end of each chapter. In
addition, there is a practice exam. Use these questions to test your knowledge
of the study guide material. The online test bank runs on multiple devices.

Electronic Flashcards One set of questions is provided in digital flashcard
format (a question followed by a single correct answer). You can use the
flashcards to reinforce your learning and provide last-minute test prep before
the exam.

Glossary The key terms from this book and their definitions are available as a
fully searchable PDF.

Videos Some of the exercises include corresponding videos. These videos
show you how the author does the exercises. There is also a video that shows
you how to set up virtualization so that you can complete the exercises within a
virtualized environment. The author also has videos to help you on the

Microsoft exams at www.youtube.com/c/williampanek.

Recommended Home Lab Setup

To get the most out of this book, you will want to make sure you complete the
exercises throughout the chapters. To complete the exercises, you will need one
of two setups. First, you can set up a machine with Windows Server 2016 and
complete the labs using a regular Windows Server 2016 machine.

The second way to set up Windows Server 2016 (the way I set up Server 2016)
is by using virtualization. I set up Windows Server 2016 as a virtual hard disk
(VHD), and I did all the labs this way. The advantages of using virtualization
are that you can always just wipe out the system and start over without losing a
real server. Plus, you can set up multiple virtual servers and create a full lab
environment on one machine.

I created a video for this book showing you how to set up a virtual machine and
how to install Windows Server 2016 onto that virtual machine.

How to Contact Sybex/Author

Sybex strives to keep you supplied with the latest tools and information you
need for your work. Please check the website at
www.wiley.com/go/sybextestprep, where I'll post additional content and
updates that supplement this book should the need arise.
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You can contact me by going to my website at www.willpanek.com. You can
also watch free videos on Microsoft networking at
www.youtube.com/c/williampanek. If you would like to follow information
about Windows Server 2016 from Will Panek, please visit Twitter
@AuthorWillPanek.

Certification Objectives Maps

Table 1.1 provides the objective mappings for the 70-742 exam. In addition to
the book chapters, you will find coverage of exam objectives in the flashcards,
practice exams, and videos on the book’s companion website at
www.wiley.com/go/sybextestprep.

TABLE 1.1 70-742 exam objectives

Objective Chapter

Install and configure Active Directory Domain Services (AD DS)
(20—-25%)

Install and configure domain controllers 1

Install a new forest, add or remove a domain controller from a 1
domain, upgrade a domain controller, install AD DS on a Server

Core installation, install a domain controller from Install from

Media (IFM), resolve DNS SRV record registration issues, configure

a global catalog server, transfer and seize operations master roles,
install and configure a read-only domain controller (RODC),
configure domain controller cloning.

Create and manage Active Directory users and computers

Automate the creation of Active Directory accounts; create, copy, 2
configure, and delete users and computers; configure templates;
perform bulk Active Directory operations; configure user rights;
implement offline domain join; manage inactive and disabled
accounts; automate unlocking of disabled accounts using Windows
PowerShell; automate password resets using Windows PowerShell.

Create and manage Active Directory groups and organizational 2
units (OUs)
Configure group nesting; convert groups, including security, 2

distribution, universal, domain local, and domain global; manage
group membership using Group Policy; enumerate group
membership; automate group membership management using
Windows PowerShell; delegate the creation and management of
Active Directory groups and OUs; manage default Active Directory
containers; create, copy, configure, and delete groups and OUs.

Manage and maintain AD DS (15—20%)
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Configure service authentication and account policies 2

Create and configure Service Accounts, create and configure Group 2
Managed Service Accounts (gMSAs), configure Kerberos

Constrained Delegation (KCD), manage Service Principal Names
(SPNs), configure virtual accounts, configure domain and local user
password policy settings, configure and apply Password Settings
Objects (PSOs), delegate password settings management, configure
account lockout policy settings, configure Kerberos policy settings
within Group Policy.

Maintain Active Directory 3

Back up Active Directory and SYSVOL, manage Active Directory 3
offline, perform offline defragmentation of an Active Directory
database, clean up metadata, configure Active Directory snapshots,
perform object- and container-level recovery, perform Active
Directory restore, configure and restore objects by using the Active
Directory Recycle Bin, configure replication to Read-Only Domain
Controllers (RODCs), configure Password Replication Policy (PRP)
for RODC, monitor and manage replication, upgrade SYSVOL
replication to Distributed File System Replication (DFSR).

Configure Active Directory in a complex enterprise environment 3

Configure a multi-domain and multi-forest Active Directory 3
infrastructure; deploy Windows Server 2016 domain controllers
within a pre-existing Active Directory environment; upgrade
existing domains and forests; configure domain and forest
functional levels; configure multiple user principal name (UPN)
suffixes; configure external, forest, shortcut, and realm trusts;
configure trust authentication; configure SID filtering; configure
name suffix routing; configure sites and subnets; create and
configure site links; manage site coverage; manage registration of
SRV records; move domain controllers between sites; configure
account policies.

Create and manage Group Policy (25-30%)
Create and manage Group Policy Objects (GPOs) 4

Configure a central store; manage starter GPOs; configure GPO 4
links; configure multiple local Group Policies; back up, import,

copy, and restore GPOs; create and configure a migration table;

reset default GPOs; delegate Group Policy management; detect

health issues using the Group Policy Infrastructure Status

dashboard.

Configure Group Policy processing 4
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Configure processing order and precedence, configure blocking of 4
inheritance, configure enforced policies, configure security filtering
and Windows Management Instrumentation (WMI) filtering,
configure loopback processing, configure and manage slow-link
processing and Group Policy caching, configure client-side

extension (CSE) behavior, force a Group Policy update.

Configure Group Policy processing 4

Configure software installation, configure folder redirection, 4
configure scripts, configure administrative templates, import

security templates, import a custom administrative template file,
configure property filters for administrative templates.

Configure Group Policy preferences 4

Configure printer preferences, define network drive mappings, 4
configure power options, configure custom registry settings,

configure Control Panel settings, configure Internet Explorer

settings, configure file and folder deployment, configure shortcut
deployment, configure item-level targeting.

Implement Active Directory Certificate Services (AD CS) (10—15%)
Install and configure AD CS 5

Install Active Directory Integrated Enterprise Certificate Authority 5
(CA), install offline root and subordinate CAs, install standalone

CAs, configure Certificate Revocation List (CRL) distribution

points, install and configure Online Responder, implement
administrative role separation, configure CA backup and recovery.

Manage certificates 5

Manage certificate templates; implement and manage certificate 5
deployment, validation, and revocation; manage certificate renewal;
manage certificate enrollment and renewal for computers and users
using Group Policies; configure and manage key archival and
recovery.

Implement identity federation and access solutions (15—20%)
Install and configure Active Directory Federation Services (AD FS) 6

Upgrade and migrate previous AD FS workloads to Windows Server 6
2016; implement claims-based authentication, including Relying
Party Trusts; configure authentication policies; configure multi-
factor authentication; implement and configure device registration;
integrate AD FS with Microsoft Passport; configure for use with
Microsoft Azure and Office 365; configure AD FS to enable
authentication of users stored in LDAP directories.

Implement Web Application Proxy (WAP) 6

Hi va- Net wor k. Corr 2


https://technet24.ir
https://technet24.ir
http://www.hiva-network.com/

Install and configure WAP, implement WAP in pass-through mode, 6
implement WAP as AD FS proxy, integrate WAP with AD FS,
configure AD FS requirements, publish web apps via WAP, publish
Remote Desktop Gateway applications, configure HTTP to HTTPS
redirects, configure internal and external Fully Qualified Domain
Names (FQDNSs).

Install and configure Active Directory Rights Management Services 6
(AD RMS)

Install a licensor certificate AD RMS server, manage AD RMS 6
Service Connection Point (SCP), manage AD RMS templates,
configure Exclusion Policies, back up and restore AD RMS.

‘—5’1 Exam objectives are subject to change at any time without prior

notice and at Microsoft’s sole discretion. Please visit Microsoft’s website
(www .microsoft.com/learning) for the most current listing of exam
objectives.
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Assessment Test

1. What is the maximum number of domains that a Windows Server 2016
computer configured as a domain controller may participate in at one time?

A. Zero
B. One
C. Two
D. Any number of domains
2. Which of the following file systems are required for Active Directory?
A. FAT
B. FAT32
C. HPFS
D. NTFS

3. Which of the following services and protocols are required for Active
Directory? Choose all that apply.

A. NetBEUI
B. TCP/IP
C. DNS

D. DHCP

4. Which of the following PowerShell commands allows you to view Active
Directory users?

A. Get-ADUser
B. Get-User
C. View-User
D. See-ADUser

5. Which of the following PowerShell commands allows you to enable an
active directory account after it’s been locked out?

A. Release-ADAccount
B. Enable-ADAccount
C. Unlock-ADAccount
D. Enable-Account
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. You need to create a new user account using the command prompt. Which
command would you use?

A. dsmodify
B. dscreate
C. dsnew
D. dsadd

. What kind of trust is setup between one domain and another domain in the
same forest?

A. External trust
B. Forest trust

C. Shortcut trust
D. Domain trust

. You need to deactivate the Global Catalog option on some of your domain
controllers. At which level in Active Directory would you deactivate
GlobalCatalogs?

A. Server

B. Site

C. Domain
D. Forest

. You want to allow the new Sales Director to have permissions to reset
passwords for all users within the sales OU. Which of the following is the
best way to do this?

A. Create a special administration account within the OU and grant it full
permissions for all objects within Active Directory.

B. Move the user’s login account into the OU that he or she is to
administer.

C. Move the user’s login account to an OU that contains the OU (that is,
the parent OU of the one that he or she is to administer).

D. Use the Delegation of Control Wizard to assign the necessary
permissions on the OU that he or she is to administer.

. You need to create OUs in Active Directory. In which MMCs can you
accomplish this task? Choose all that apply.

A. Active Directory Administrative Center

B. Active Directory Sites and Services
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C. Active Directory Users and Computers
D. Active Directory Domains and Trusts

11. You want a GPO to take effect immediately, and you need to use Windows
PowerShell. Which PowerShell cmdlet command would you use?

A. Invoke-GPUpdate
B. Invoke-GPForce

C. Invoke-GPResult
D. Invoke-GPExecute

2. GPOs assigned at which of the following level(s) will override GPO settings
at the domain level?

A. OU

B. Site

C. Domain

D. Both OU and site

3. A system administrator wants to ensure that only the GPOs set at the OU
level affect the Group Policy settings for objects within the OU. Which
option can they use to do this (assuming that all other GPO settings are the
defaults)?

A. The Enforced option

B. The Block Policy Inheritance option
C. The Disable option

D. The Deny permission

4. To disable GPO settings for a specific security group, which of the following
permissions should you apply?

A. Deny Write

B. Allow Write

C. Enable Apply Group Policy
D. Deny Apply Group Policy

15. You want to configure modifications of the Certification Authority role
service to be logged. What should you enable? (Choose all that apply.)

A. Enable auditing of system events.
B. Enable logging.

C. Enable auditing of privilege use.
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7.

D. Enable auditing of object access.
E. You should consider enabling auditing of process tracking.

You need to add a certificate template to the Certificate Authority. What
PowerShell command would you use?

A. Get-CSTemplate
B. Add-CSTemplate
C. Add-CATemplate
D. New-Template

You need to see all of the location sets for the CRL distribution point (CDP).
What PowerShell command would you use?

A. View-CACrlDistributionPoint
B. See-CACrlDistributionPoint
C. Add-CACrlDistributionPoint
D. Get-CACrlDistributionPoint

You have a server named Server1 that runs Windows Server 2016. You need
to configure Server1 as a Web Application Proxy. Which server role or role
service should you install on Serveri1?

A. Remote Access

B. Active Directory Federation Services
C. Web Server (IIS)

D. DirectAccess and VPN (RAS)

You have installed Active Directory Federation Services server and the Web
Application Proxy. Which two inbound TCP ports should you open on the
firewall? Each correct answer presents part of the solution.

A. 443
B. 390
C. 8443

D. 49443

You need to modify configuration settings for a server application role of an
application in AD FS. What PowerShell command do you use?

A. Add-AdfsServerApplication
B. Set-AdfsServerApplication
C. Get-AdfsServerApplication
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D. Install-AdfsServerApplication
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Answers to Assessment Test

1.

11.

B. A domain controller can contain Active Directory information for only
one domain. If you want to use a multidomain environment, you must use
multiple domain controllers configured in either a tree or a forest setting.
See Chapter 1 for more information.

D. NTFS has file-level security, and it makes efficient usage of disk space.
Since this machine is to be configured as a domain controller, the
configuration requires at least one NTFS partition to store the Sysvol
information. See Chapter 1 for more information.

B, C. TCP/IP and DNS are both required when installing Active Directory.
See Chapter 1 for more information.

A. The Get-ADUser command allows you to view Active Directory user
accounts using PowerShell. See Chapter 2 for more information.

C. Administrators can use the Unlock-ADAccount command to unlock an
Active Directory account. See Chapter 2 for more information.

D. The dsadd command allows you to add an object (user’s account) to the
Active Directory database. See Chapter 2 for more information.

C. Shortcut trusts are trusts setup between two domains in the same forest.
See Chapter 3 for more information.

B. The NTDS settings for the site level are where you would activate and
deactivate Global Catalogs. See Chapter 3 for more information.

D. The Delegation of Control Wizard is designed to allow administrators to
set up permissions on specific Active Directory objects. See Chapter 3 for
more information.

A, C. Administrators can create new Organizational Units (OUs) by using
either the Active Directory Administrative Center or Active Directory Users
and Computers. See Chapter 3 for more information.

A. You would use the Windows PowerShell Invoke-GPUpdate cmdlet. This
PowerShell cmdlet allows you to force the GPO to reapply the policies
immediately. See Chapter 4 for more information.

A. GPOs at the OU level take precedence over GPOs at the domain level.
GPOs at the domain level, in turn, take precedence over GPOs at the site
level. See Chapter 4 for more information.

B. The Block Policy Inheritance option prevents group policies of higher-
level Active Directory objects from applying to lower-level objects as long as
the Enforced option is not set. See Chapter 4 for more information.
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4. D. To disable the application of Group Policy on a security group, you
should deny the Apply Group Policy option. This is particularly useful when
you don’t want GPO settings to apply to a specific group, even though that
group may be in an OU that includes the GPO settings. See Chapter 4 for
more information.

5. B, D. To enable AD FS auditing, you must check the boxes for Success
Audits and Failure Audits on the Events tab of the Federation Service
Properties dialog box. You must also enable Object Access Auditing in Local
Policy or Group Policy. See Chapter 5 for more information.

6. C. The Add-CATemplate command allows an administrator to add a
certificate template to the CA. See Chapter 5 for more information.

7. D. Administrators can use the Get-CACrlDistributionPoint command to
view all the locations set for the CRL distribution point (CDP). See Chapter
5 for more information.

8. A.To use the Web Application Proxy, you must install the Remote Access
role. See Chapter 6 for more information.

9. A, D. Touse a Web Application Proxy and AD FS, you should set your
firewall to allow for ports 443 and 49443. See Chapter 6 for more
information.

0. B. The Set-AdfsServerApplication command allows an administrator to
modify configuration settings for a server application role of an application
in AD FS. See Chapter 6 for more information.
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Chapter 1
Installing Active Directory

THE FOLLOWING 70-742 EXAM OBJECTIVES ARE COVERED IN
THIS CHAPTER:

v Install and configure domain controllers

= This objective may include but is not limited to: Install a new forest; add
or remove a domain controller from a domain; upgrade a domain
controller; install AD DS on a Server Core installation; install a domain
controller from Install from Media (IFM); resolve DNS SRV record
registration issues; install and configure a read-only domain controller
(RODC); configure domain controller cloning

i han .One of the most important tasks that you will complete on a
network is setting up your domain. To set up your domain properly, you must
know how to install and configure your domain controllers.

After I show you how to install and configure your domain controller, you’ll
explore the concept of domain functional levels, which essentially determine
what sorts of domain controllers you can use in your environment. For
instance, in the Windows Server 2008 domain functional level, you can have
Windows Server 2008/2008 R2, Windows Server 2012/2012 R2, and
Windows Server 2016 domain controllers, but the functionality of the domain
is severely limited. Also, you CAN NOT have any domain controllers below the
domain function level (no domain controllers below 2008 in this example).

Once you understand how to plan properly for your domain environment, you
will learn how to install Active Directory, which you will accomplish by
promoting a Windows Server 2016 computer to a domain controller. I will also
discuss a feature in Windows Server 2016 called a read-only domain controller
(RODC), and I will show you how to install Active Directory using Windows
PowerShell.

‘éﬁ For these exercises, I assume you are creating a Windows Server
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t2016 machine in a test environment and not on a live network. J

Verifying the File System

When you’re planning your Active Directory deployment, the file system that
the operating system uses is an important concern for two reasons. First, the
file system can provide the ultimate level of security for all the information
stored on the server itself. Second, it is responsible for managing and tracking
all of this data. The Windows Server 2016 platform supports three file systems:

= File Allocation Table 32 (FAT32)
= Windows NT File System (NTFS)
= Resilient File System (ReFS)

Although ReFS was new to Windows Server 2012, NTFS has been around for
many years, and NTFS in Windows Server 2016 has been improved for better
performance.

If you have been working with servers for many years, you may have noticed a
few changes to the server file system choices. For example, in Windows Server
2003, you could choose between FAT, FAT32, and NTFS. In Windows Server
2016, you could choose between FAT32, NTFS, and ReFS (see Figure 1.1).

MNew Simple Volume Wizard )4

Format Partition
To store data on this partition, you must format it first,

Choose whether you want to format this volume, and § so, what settings you want to use.

(O Do nct format this volume
(®) Format this volume with the following settings:
File system: NTFS W
: = = FAT32
Allocation unit size: NTFS L}
ReFs
Volume label:

Perform a quick format
[ ] Enable file and folder compression

< Back Next » Cancel
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FIGURE 1.1 Format options on Windows Server 2016

Resilient File System (ReFS)

Windows Server 2016 includes a file system called Resilient File System
(ReFS). ReFS was created to help Windows Server maximize the availability of
data and online operation. ReFS allows the Windows Server 2016 system to
continue to function despite some errors that would normally cause data to be
lost or the system to go down. ReFS uses data integrity to protect your data
from errors and also to make sure that all of your important data is online
when that data is needed.

One of the issues that IT members have had to face over the years is the
problem of rapidly growing data sizes. As we continue to rely more and more
on computers, our data continues to get larger and larger. This is where ReFS
can help an IT department. ReFS was designed specifically with the issues of
scalability and performance in mind, which resulted in some of the following
ReFS features:

Availability If your hard disk becomes corrupt, ReFS has the ability to
implement a salvage strategy that removes the data that has been corrupted.
This feature allows the healthy data to continue to be available while the
unhealthy data is removed. All of this can be done without taking the hard disk
offline.

Scalability One of the main advantages of ReFS is the ability to support
volume sizes up to 2”78 bytes using 16 KB cluster sizes, while Windows stack
addressing allows 2”64 bytes. ReFS also supports file sizes of 2" 64-1 bytes,
2764 files in a directory, and the same number of directories in a volume.

Robust Disk Updating ReFS uses a disk updating system referred to as an
allocate-on-write transactional model (also known as copy on write). This
model helps to avoid many hard disk issues while data is written to the disk
because ReFS updates data using disk writes to multiple locations in an atomic
manner instead of updating data in place.

Data Integrity ReFS uses a check-summed system to verify that all data that
is being written and stored is accurate and reliable. ReFS always uses allocate-
on-write for updates to the data, and it uses checksums to detect disk
corruption.

Application Compatibility ReFS allows for most NTFS features and also
supports the Win32 API. Because of this, ReFS is compatible with most
Windows applications.

NTFS

Let’s start with some of the features of NTFS. There are many benefits to using
NTFS, including support for the following;:
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Disk Quotas To restrict the amount of disk space used by users on the
network, system administrators can establish disk quotas. By default,
Windows Server 2016 supports disk quota restrictions at the volume level.
That is, you can restrict the amount of storage space that a specific user uses on
a single disk volume. Third-party solutions that allow more granular quota
settings are also available.

File System Encryption One of the fundamental problems with network
operating systems (NOSs) is that system administrators are often given full
permission to view all files and data stored on hard disks, which can be a
security and privacy concern. In some cases, this is necessary. For example, to
perform backup, recovery, and disk management functions, at least one user
must have all permissions. Windows Server 2016 and NTFS address these
issues by allowing for file system encryption. Encryption essentially scrambles
all of the data stored within files before they are written to the disk. When an
authorized user requests the files, they are transparently decrypted and
provided. By using encryption, you can prevent the data from being used in
case it is stolen or intercepted by an unauthorized user—even a system
administrator.

Dynamic Volumes Protecting against disk failures is an important concern
for production servers. Although earlier versions of Windows NT supported
various levels of Redundant Array of Independent Disks (RAID) technology,
software-based solutions had some shortcomings. Perhaps the most significant
was that administrators needed to perform server reboots to change RAID
configurations. Also, you could not make some configuration changes without
completely reinstalling the operating system. With Windows Server 2016
support for dynamic volumes, system administrators can change RAID and
other disk configuration settings without needing to reboot or reinstall the
server. The result is greater data protection, increased scalability, and
increased uptime. Dynamic volumes are also included with ReFS.

Mounted Drives By using mounted drives, system administrators can map a
local disk drive to an NTFS directory name. This helps them organize disk
space on servers and increase manageability. By using mounted drives, you can
mount the c:\users directory to an actual physical disk. If that disk becomes
full, you can copy all of the files to another, larger drive without changing the
directory path name or reconfiguring applications.

Remote Storage System administrators often notice that as soon as they add
more space, they must plan the next upgrade. One way to recover disk space is
to move infrequently used files to external hard drives. However, backing up
and restoring these files can be quite difficult and time-consuming. System
administrators can use the remote storage features supported by NTFS to off-
load seldom-used data automatically to a backup system or other devices. The
files, however, remain available to users. If a user requests an archived file,
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Windows Server 2016 can automatically restore the file from a remote storage
device and make it available. Using remote storage like this frees up system
administrators’ time and allows them to focus on tasks other than
micromanaging disk space.

Self-Healing NTFS In previous versions of the Windows Server operating
system, if you had to fix a corrupted NTFS volume, you used a tool called
chkdsk.exe. The disadvantage of this tool is that the Windows Server’s
availability was disrupted. If this server was your domain controller, that could
stop domain logon authentication.

To help protect the Windows Server 2016 NTFS file system, Microsoft now
uses a feature called self-healing NTFS. Self-healing NTFS attempts to fix
corrupted NTFS file systems without taking them offline. Self-healing NTFS
allows an NTFS file system to be corrected without running the chkdsk.exe
utility. New features added to the NTFS kernel code allow disk inconsistencies
to be corrected without system downtime.

Security NTFS allows you to configure not only folder-level security but also
file-level security. NTFS security is one of the biggest reasons most companies
use NTFS. ReFS also allows folder- and file-level security.

Setting Up the NTFS Partition

Although the features mentioned in the previous section likely compel most
system administrators to use NTFS, additional reasons make using it
mandatory. The most important reason is that the Active Directory data store
must reside on an NTFS partition. Therefore, before you begin installing Active
Directory, make sure you have at least one NTFS partition available. Also, be
sure you have a reasonable amount of disk space available (at least 4 GB).
Because the size of the Active Directory data store will grow as you add objects
to it, also be sure that you have adequate space for the future.

Exercise 1.1 shows you how to use the administrative tools to view and modify
disk configuration.

‘% Before you make any disk configuration changes, be sure you

completely understand their potential effects; then perform the test in a lab
environment and make sure you have good, verifiable backups handy.
Changing partition sizes and adding and removing partitions can result in
a total loss of all information on one or more partitions.

& J

If you want to convert an existing partition from FAT or FAT32 to NTFS, you
need to use the convERT command-line utility. For example, the following
command converts the c: partition from FAT to NTFS:
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CONVERT c: /fs:ntfs

-

EXERCISE 1.1

Viewing the Disk Configurations

1. Right-click on the Start button and then choose Computer
Management.

2. Under Storage, click Disk Management (see Figure 1.2).

The Disk Management program shows you the logical and physical
disks that are currently configured on your system.

3. Use the View menu to choose various depictions of the physical and
logical drives in your system.

4. To see the available options for modifying partition settings, right-click
any of the disks or partitions. This step is optional.

5. Close Computer Management.
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FIGURE 1.2 Disk Management

Verifying Network Connectivity
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Although a Windows Server 2016 computer can be used by itself without
connecting to a network, you will not harness much of the potential of the
operating system without network connectivity. Because the fundamental
purpose of a network operating system is to provide resources to users, you
must verify network connectivity.

Basic Connectivity Tests

Before you begin to install Active Directory, you should perform several checks
of your current configuration to ensure that the server is configured properly
on the network. You should test the following:

Network Adapter At least one network adapter should be installed and
properly configured on your server. A quick way to verify that a network
adapter is properly installed is to use the Computer Management
administrative tool. Under Device Manager, Network Adapters branch, you
should have at least one network adapter listed. If you do not, use the Add
Hardware icon in Control Panel to configure hardware.

TCP/IP Make sure that TCP/IP is installed, configured, and enabled on any
necessary network adapters. The server should also be given a valid IP address
and subnet mask. Optionally, you may need to configure a default gateway,
DNS servers, WINS servers, and other network settings. If you are using
DHCP, be sure that the assigned information is correct. It is always a good idea
to use a static IP address for servers because IP address changes can cause
network connectivity problems if they are not handled properly.

Internet Access If the server should have access to the Internet, verify that it
is able to connect to external web servers and other machines outside of the
local area network (LAN). If the server is unable to connect, you might have a
problem with the TCP/IP configuration.

LAN Access The server should be able to view other servers and workstations
on the network. If other machines are not visible, make sure that the network
and TCP/IP configurations are correct for your environment.

Client Access Network client computers should be able to connect to your
server and view any shared resources. A simple way to test connectivity is to
create a share and test whether other machines are able to see files and folders
within it. If clients cannot access the machine, make sure that both the client
and the server are configured properly.

Wide Area Network Access If you're working in a distributed environment,
you should ensure that you have access to any remote sites or users who will
need to connect to this machine. Usually, this is a simple test that can be
performed by a network administrator.

Tools and Techniques for Testing Network Configuration
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In some cases, verifying network access can be quite simple. You might have
some internal and external network resources with which to test. In other
cases, it might be more complicated. You can use several tools and techniques
to verify that your network configuration is correct.

‘% The Windows Server 2016 exams will include a lot of PowerShell

commands. One easy way to start getting familiar with PowerShell is to use
it whenever you need to run a network configuration command. All of the
following commands work in PowerShell.

G J/

Using the Ipconfig Utility By typing ipconfig/all at the command prompt,
you can view information about the TCP/IP settings of a computer. Figure 1.3
shows the types of information you’ll receive.

BN Adrureitrpten Windows Paworbhel — o b4 .

Windows Powershe s
Copyright (C) ’DlE Microsoft Corporation. All rights reserwved.
PS C:\Users)\Administrator> Ipconfig

lindows IP Configuration

unnel adapter Local Area Connection® 12:

Media State . .

. « : Media disconnected
Connection- Jpec1f1c DNS Suffix .

Ethernet adapter Ethernet:

Connection-specific DNS suffix
Link-local IPvE Address . . .
IPv4 Address. . .

Subnet Mask . . .

Default Gateway .

unnel adapter isatap.localdomain:

Media State . .
Connection- 5pec1f1c DNS Suffix

. i localdomain
: Te80:

:4d43:2490:ccB9a: B33
92.168. 140,180

.255.255.0

?.168.140.2

: Media disconnected
. : localdomain

unnel adapter Teredo Tumneling Pseudo-Interface:

Connection-specific DNS
IPvE Address. .
Link=local IPve nddre
pefault Gateway .

PS5 C:'WUsersi\Administrators

suffix

L4

. : 2001:0
. + FTeB0:

:9d38:953¢c:c23: 1 734b

180a:3f57
t€23:180a:3F57:734b

%9

FIGURE 1.3 Viewing TCP/IP information with the ipconfig utility

Using the ping Command The ping command was designed to test
connectivity to other computers. You can use the command simply by typing
ping and then an IP address or hostname at the command line. The following
are some steps for testing connectivity using the ping command.

Ping Other Computers on the Same Subnet You should start by pinging
a known active IP address on the network to check for a response. If you

Hi va- Net wor k. Comr
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receive one, then you have connectivity to the network.

Next check to see whether you can ping another machine using its hostname. If
this works, then local name resolution works properly.

Ping Computers on Different Subnets To ensure that routing is set up
properly, you should attempt to ping computers that are on other subnets (if
any exist) on your network. If this test fails, try pinging the default gateway.
Any errors may indicate a problem in the network configuration or a problem
with a router.

( N\

When You Don’t Receive a Response

Some firewalls, routers, or servers on your network or on the Internet
might prevent you from receiving a successful response from a ping
command. This is usually for security reasons (malicious users might
attempt to disrupt network traffic using excessive pings as well as redirects
and smurf attacks). If you do not receive a response, do not assume that
the service is not available. Instead, try to verify connectivity in other ways.
For example, you can use the TRACERT command to demonstrate
connectivity beyond your subnet, even if other routers ignore Internet
Control Message Protocol (ICMP) responses. Because the display of a
second router implies connectivity, the path to an ultimate destination
shows success even if it does not display the actual names and addresses.

G /

Using the TraceRT Command The TraceRT command works just like the ping
command except that the TraceRT command shows you every hop along the
way. So if one router or switch is down, the TracerRT command will show you
where the trace stops.

Browsing the Network To ensure that you have access to other computers
on the network, be sure that they can be viewed by clicking Network. This
verifies that your name resolution parameters are set up correctly and that
other computers are accessible. Also, try connecting to resources (such as file
shares or printers) on other machines.

( N\

’% By default, Network Discovery is turned off. To browse the

network, you must first enable Network Discovery from the Control Panel
in the Network and Sharing Center > Advanced Sharing settings.

(& J/

Browsing the Internet You can quickly verify whether your server has
access to the Internet by visiting a known website, such as www.microsoft.com.
Success ensures that you have access outside of your network. If you do not
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have access to the web, you might need to verify your proxy server settings (if
applicable) and your DNS server settings.

By performing these simple tests, you can ensure that you have a properly
configured network connection and that other network resources are available.

Understanding Domain and Forest Functionality

Windows Server 2016 Active Directory uses a concept called domain and
forest functionality. The functional level that you choose during the Active
Directory installation determines which features your domain can use.

About the Domain Functional Level
Windows Server 2016 will support the following domain functional levels:
= Windows Server 2008
= Windows Server 2008 R2
= Windows Server 2012
= Windows Server 2012 R2
= Windows Server 2016

Which function level you use depends on the domain controllers you have
installed on your network. This is an important fact to remember. You can use
any version of Windows Server as long as those servers are member servers
only. You can only use Domain Controllers as low as your function level.

For example, if the Domain Function Level is Windows Server 2012 R2, then
all domain controllers must be running Windows Server 2012 R2 or higher.
You can have Windows Server 2008 R2 member servers but all of your domain
controllers need to be at least 2012 R2.

( N

’% ‘Windows Server 2016 no longer supports the Windows Server

2003 function levels. With Windows Server 2003 being no longer
supported, the Windows Server 2003 function levels have been removed.

G J/

Table 1.1 shows the features available in Windows Server 2008, Windows
Server 2008 R2, Windows Server 2012, Windows Server 2012 R2, and
Windows Server 2016 domain function levels.

TABLE 1.1 Comparing domain functional levels

Domain Windows Windows Windows Windows Windows
Functional Server Server Server Server Server
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Feature

Privileged access
management

Authentication
assurance

Fine-grained
password policies

Last interactive
logon information

Advanced
Encryption
Services (AES 128
and 256) support
for the Kerberos

protocol

Distributed File
System replication
support for Sysvol

Read-only domain
controller (RODC)

Ability to redirect
the Users and
Computers
containers

Ability to rename
domain controllers

Logon time stamp

updates

Kerberos KDC key
version numbers

Passwords for
InetOrgPerson

objects

Converts NT
groups to domain
local and global

groups

SID history
Group nesting
Universal groups

2008
Disabled

Disabled

Enabled

Enabled

Enabled

Enabled

Enabled

Enabled

Enabled

Enabled

Enabled

Enabled

Enabled

Enabled
Enabled
Enabled

2008 R2

Disabled

Enabled

Enabled

Enabled

Enabled

Enabled

Enabled

Enabled

Enabled

Enabled

Enabled

Enabled

Enabled

Enabled
Enabled
Enabled

2012
Disabled

Enabled

Enabled

Enabled

Enabled

Enabled

Enabled

Enabled

Enabled

Enabled

Enabled

Enabled

Enabled

Enabled
Enabled
Enabled

2012 R2
Enabled

Enabled

Enabled

Enabled

Enabled

Enabled

Enabled

Enabled

Enabled

Enabled

Enabled

Enabled

Enabled

Enabled
Enabled
Enabled

2016
Enabled

Enabled

Enabled

Enabled

Enabled

Enabled

Enabled

Enabled

Enabled

Enabled

Enabled

Enabled

Enabled

Enabled
Enabled
Enabled
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About Forest Functionality

Windows Server 2016 forest functionality applies to all of the domains in a
forest. All domains have to be upgraded to Windows Server 2016 before the
forest can be upgraded to Windows Server 2016.

There are five levels of forest functionality:

Windows Server 2008

Windows Server 2008 R2

Windows Server 2012

Windows Server 2012 R2

Windows Server 2016

Windows Server 2008, Windows Server 2008 R2, Windows Server 2012,
Windows Server 2012 R2, and Windows Server 2016 have many of the same
forest features. Some of these features are described in the following list:

Global Catalog Replication Enhancements When an administrator adds
a new attribute to the global catalog, only those changes are replicated to other
global catalogs in the forest. This can significantly reduce the amount of
network traffic generated by replication.

Defunct Schema Classes and Attributes You can never permanently
remove classes and attributes from the Active Directory schema. However, you
can mark them as defunct so that they cannot be used. With Windows Server
2003, Windows Server 2008/2008 R2, Windows Server 2012/2012 R2, and
Windows Server 2016 forest functionality, you can redefine the defunct schema
attribute so that it occupies a new role in the schema.

Forest Trusts Previously, system administrators had no easy way of granting
permission on resources in different forests. Windows Server 2003, Windows
Server 2008/2008 R2, Windows Server 2012/2012 R2, and Windows Server
2016 resolve some of these difficulties by allowing trust relationships between
separate Active Directory forests. Forest trusts act much like domain trusts,
except that they extend to every domain in two forests. Note that all forest
trusts are intransitive.

Linked Value Replication Windows Server 2003, Windows Server
2008/2008 R2, Windows Server 2012/2012 R2, and Windows Server 2016 use
a concept called linked value replication. With linked value replication, only
the user record that has been changed is replicated (not the entire group). This
can significantly reduce network traffic associated with replication.

Renaming Domains Although the Active Directory domain structure was
originally designed to be flexible, there were several limitations. Because of

Hi va- Net wor k. Corr 2
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mergers, acquisitions, corporate reorganizations, and other business changes,
you may need to rename domains. In Windows Server 2003, Windows Server
2008/2008 R2, Windows Server 2012/2012 R2, and Windows Server 2016 you
can change the DNS and NetBIOS names for any domain. Note that this
operation is not as simple as just issuing a rename command. Instead, there’s a
specific process that you must follow to make sure the operation is successful.
Fortunately, when you properly follow the procedure, Microsoft supports
domain renaming even though not all applications support it.

Other Features Windows Server 2008/2008 R2, Windows Server
2012/2012 R2, and Windows Server 2016 also support the following features:

= Improved replication algorithms and dynamic auxiliary classes are

designed to increase performance, scalability, and reliability.

m Active Directory Federation Services (AD FS), also known as Trustbridge,

handles federated identity management. Federated identity management
is a standards-based information technology process that enables
distributed identification, authentication, and authorization across
organizational and platform boundaries. The ADFS solution in Windows
Server 2008, Windows Server 2008 R2, Windows Server 2012, Windows
Server 2012 R2, and Windows Server 2016 helps administrators address
these challenges by enabling organizations to share a user’s identity
information securely.

m Active Directory Lightweight Directory Services (AD LDS) was developed

for organizations that require flexible support for directory-enabled
applications. AD LDS, which uses the Lightweight Directory Access
Protocol (LDAP), is a directory service that adds flexibility and helps
organizations avoid increased infrastructure costs.

Active Directory Recycle Bin (Windows Server 2008 R2 Forest level or
higher) provides administrators with the ability to restore deleted objects in
their entirety while AD DS is running. Before this, if you deleted an Active
Directory object, you needed to recover it from a backup. Now you can
recover the object from the AD recycle bin.

-

\

features are covered in greater detail later in this book.

‘% Many of the concepts related to domain and forest functional

Planning the Domain Structure

Once you have verified the technical configuration of your server for Active
Directory, it’s time to verify the Active Directory configuration for your
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organization. Since the content of this chapter focuses on installing the first
domain in your environment, you really need to know only the following
information prior to beginning setup:

m The DNS name of the domain

The computer name or the NetBIOS name of the server (which will be used
by previous versions of Windows to access server resources)

In which domain function level the domain will operate

Whether other DNS servers are available on the network

= What type of and how many DNS servers are available on the network

‘% DNS is a requirement of Active Directory. You can install DNS

during the Active Directory installation. For more information about DNS,
please read MCSA Windows Server 2016 Study Guide: Exam 70-742, 2nd
Edition (Sybex, 2017), or Chapter 11 in the MCSA Windows Server 2016
Complete Study Guide: Exam 70-740, Exam 70-741, Exam 70-742, and
Exam 70-743, 2nd Edition, by William Panek (Sybex, 2017).
However, if you will be installing additional domain controllers in your
environment or will be attaching to an existing Active Directory structure, you
should also have the following information:

= If this domain controller will join an existing domain, you should know the
name of that domain. You will also either require a password for a member
of the Enterprise Administrators group for that domain or have someone
with those permissions create a domain account before promotion.

= You should know whether the new domain will join an existing tree and, if
so, the name of the tree it will join.

= You should know the name of a forest to which this domain will connect (if
applicable).

Installing Active Directory

Installing Active Directory is an easy and straightforward process as long as
you plan adequately and make the necessary decisions beforehand. There are
many ways that you can install Active Directory. You can install Active
Directory by using the Windows Server 2016 installation disk (Install from
Media (IFM)), using Server Manager, or using Windows PowerShell. But
before you can do the actual installation, you must first make sure that your
network is ready for the install.
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In the following sections, you’ll look at the benefits and required steps to install
the first domain controller in a given environment.

New to Active Directory

As with any new version of Windows Server, Microsoft has made some
improvements to Active Directory. The following changes have been made to
Windows Server 2016 Active Directory:

Privileged Access Management Privileged access management (PAM)
allows you to alleviate security concerns about the Active Directory
environment. Some of these security issues include credential theft techniques
(pass-the-hash & spear phishing) along with other types of similar attacks.
PAM allows an administrator to create new access solutions that can be
configured by using Microsoft Identity Manager (MIM).

Azure AD Join Azure Active Directory Join allows you to setup an Office 365
based Azure network and then easily join your end-users systems to that
domain.

Microsoft Passport Microsoft Passport allows your users to setup a key-
based authentication that allows your users to authenticate by using more than
just their password (biometrics or PIN numbers). Your users would then log on
to their systems using a biometric or PIN number that is linked to a certificate
or an asymmetrical key pair.

Read-Only Domain Controllers

Windows Server 2016 supports another type of domain controller called the
read-only domain controller (RODC). This is a full copy of the Active Directory
database without the ability to write to Active Directory. The RODC gives an
organization the ability to install a domain controller in a location (onsite or
offsite) where security is a concern.

RODCs need to get their Active Directory database from another domain
controller. If there are no domain controllers setup yet for a domain, RODCs
will not be available (the option will be greyed out). Implementing an RODC is
the same as adding another domain controller to a domain. The installation is
exactly the same except that when you get to the screen to choose Domain
Controller options, you check the box for RODC. Again, this is ONLY available
if there are other domain controllers already in the domain.

Adprep

When you are adding a new user to Active Directory, you fill in fields such as
First Name, Last Name, and so on. These fields are called attributes. The
problem is that when you go to install Windows Server 2016, its version of
Active Directory has newer attributes than the previous versions of Active
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Directory. Thus, you need to set up your current version of Active Directory so
that it can accept the installation of Windows Server 2016 Active Directory.
This is why you use Adprep. Adprep is required to run in order to add the first
Windows Server 2016 domain controller to an existing domain or forest.

You would need to run Adprep /forestprep to add the first Windows Server
2016 domain controller to an existing forest. Adprep /forestprep must be run
by an administrator who is a member of the Enterprise Admins group, the
Schema Admins group, and the Domain Admins group of the domain that
hosts the schema master.

You would need to run Adprep /domainprep to add the first Windows Server
2016 domain controller to an existing domain. Again, to achieve this
command, you must be a member of the Domain Admins group of the domain
where you are installing the Windows Server 2016 domain controller.

Adprep /rodcprep must be run to add the first Windows Server 2016 RODC to
an existing forest. The administrator who runs this command must be a
member of the Enterprise Admins group.

One feature that is new to the Windows Server 2016 Active Directory
installation process is that, if needed, Adprep will automatically be executed
during the normal Active Directory Domain Services installation.

Active Directory Prerequisites

Before you install Active Directory into your network, you must first make sure
that your network and the server meet some minimum requirements. Table 1.2
will show you the requirements needed for Active Directory.

TABLE 1.2 Active Directory requirements

Requirement Description

Adprep When adding the first Windows Server 2016 domain
controller to an existing Active Directory domain, Adprep
commands run automatically as needed.

Credentials When installing a new AD DS forest, the administrator must
be set to local Administrator on the first server. To install an
additional domain controller in an existing domain, you need
to be a member of the Domain Admins group.

DNS Domain Name System needs to be installed for Active
Directory to function properly. You can install DNS during
the Active Directory installation.

NTFS The Windows Server 2016 drives that store the database, log
files, and SYSVOL folder must be placed on a volume that is
formatted with the NTFS file system.

i/
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RODCs Read Only Domain Controllers can be installed as long as
another domain controller (Windows Server 2008 or newer)
already exists on the domain. Also the Forest functional level
must be at least Windows Server 2003.

TCP/IP You must configure the appropriate TCP/IP settings on your
domain, and you must configure the DNS server addresses.

The Installation Process

Windows Server 2016 computers are configured as either member servers (if
they are joined to a domain) or standalone servers (if they are part of a
workgroup). The process of converting a server to a domain controller is
known as promotion. Through the use of a simple and intuitive wizard in
Server Manager, system administrators can quickly configure servers to be
domain controllers after installation. Administrators also have the ability to
promote domain controllers using Windows PowerShell.

The first step in installing Active Directory is promoting a Windows Server
2016 computer to a domain controller. The first domain controller in an
environment serves as the starting point for the forest, trees, domains, and the
operations master roles.

Exercise 1.2 shows the steps you need to follow to promote an existing
Windows Server 2016 computer to a domain controller. To complete the steps
in this exercise, you must have already installed and configured a Windows
Server 2016 computer. You also need a DNS server that supports SRV records.
If you do not have a DNS server available, the Active Directory Installation
Wizard automatically configures one for you.

( N

EXERCISE 1.2

Promoting a Domain Controller

1. Install the Active Directory Domain Services by clicking the Add Roles
And Features link in Server Manager’s Dashboard view.

2. At the Before You Begin screen, click Next.

3. The Select Installation Type screen will be next. Make sure that the
Role-Based radio button is selected and click Next.

4. At the Select Destination Server screen, choose the local machine. Click
Next.

5. At the Select Server Roles screen, click the check box for Active
Directory Domain Services.

6. After you check the Active Directory Domain Services box, a pop-up
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10.

11.

12.
13.
14.

15.

16.

17.

18.
19.

20.
21.

menu will appear asking you to install additional features. Click the
Add Features button.

Click Next.

At the Select Features screen, accept the defaults and click Next.
Click Next at the information screen.

Click the Install button at the Confirmation Installation screen.

The Installation Progress screen will show you how the installation is
progressing.

After the installation is complete, click the Close button.

On the left side window, click the AD DS link.

Click the More link next to Configuration Required for Active Directory
Domain Services.

Under the Post-Deployment Configuration section, click the Promote
This Server To A Domain Controller link.

At this point, you will configure this domain controller. You are going to
install a new domain controller in a new domain in a new forest. At the
Deployment Configuration screen, choose the Add A New Forest radio
button. You then need to add a root domain name. In this exercise, I
will use stormwindAD.com (see Figure 1.4). Click Next.

At the Domain Controller Options screen, set the following options (see
Figure 1.5):
» Function levels: Windows Server 2012 R2 (for both)

= Verify that the DNS and Global Catalog check boxes are checked.
Notice that the RODC check box is greyed out. This is because
RODCs need to get their Active Directory database from another
domain controller. Since this is the first domain controller in the
forest, RODCs are not possible. If you need an RODC, complete the
previous steps on a member server in a domain where domain
controllers already exist.

s Password: P@ssword
Then click Next.
At the DNS screen, click Next.

At the additional options screen, accept the default NetBIOS domain
name and click Next.

At the Paths screen, accept the default file locations and click Next.
At the Review Options screen (see Figure 1.6), verify your settings and
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click Next. At this screen, there is a View Script button. This button
allows you to grab a PowerShell script based on the features you have
just set up.

22. At the Prerequisites Check screen, click the Install button (as long as
there are no errors). Warnings are OK just as long as there are no errors

(see Figure 1.7).

23. After the installation completes, the machine will automatically reboot.
Log in as the administrator.

24. Close Server Manager.

25. Click the Start button on the keyboard and choose Administrative
Tools.

26. You should see new MMC snap-ins for Active Directory.

27. Close the Administrative Tools window.

\
fio Active Directory Domain Services Configuration Wizard - O >
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FIGURE 1.4 New Forest screen


https://technet24.ir
https://technet24.ir

fs Active Directory Domain Services Configuration Wizard — a o

. . TARGET SERVER
Domain Controller Options WINSRV2016
Ceployment Configuration
it 3 Select functional level of the new forest and root domain
Domain Controller Options R . - :
: d Forest functional level: Windows Server 2012 R2 =
DNsOQpligns |~ - —— -
Adgitiansl Options Domain functional level: _ Windeows Server 2012 R2 ]
Paths Specify domain controller capabilities
Review Options Damain Name System (DNS) sarver
Preregquisites Check ] Global Cataleg (GC)
Read only domain contraller (RODC)
Type the Directory Senaces Restore Mode (DSRM) password
Passworg: - sasseas
Confurm pﬂ!ﬁwﬂl’ﬂ: sEaEEEES
Mere about domain controller options
| < Previous I E Mext > i Install - Cancel
FIGURE 1.5 Domain Controller Options
fiu Active Directory Domain Services Configuration Wizard = ;] b4
. . TARGET SERVER
Review Options WINSRV201S
Deployment Configuration |  Review your selections:
Domain Conoller Ootions Configure this server as the first Active Directory domain controller in a new forest. A |
DNS Optons The new domain name i “StormWindAD.com™, This is alzo the name of the new forest.
ddith o
FaoRIOn 81 Oy The NetBIOS name of the domain: STORMWINDAD
Paths
Forest Functional Level Windows Server 2012 R2
Prerequlsites Check Domain Functional Level: Windaws Server 2012 R2
Additional Options:
Glgbal catalog: Yes
DS Server: Yes
 Create DNS Delegation: No v |
These sattings can be exported to a Windows PowerShell scnipt to automate
additional installations View script

More about installation options

[(EIEH'iMIl Hext > | [ [rstall _

Hi va- Net wor k. Conr 2]


https://technet24.ir
https://technet24.ir
https://technet24.ir
http://www.hiva-network.com/

FIGURE 1.6 Review Options screen
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FIGURE 1.7 Prerequisites Check screen

In Exercise 1.3, you will learn how to install Active Directory on a Server Core
installation. You will use Windows Server 2016 Datacenter Server Core. Before
actually installing AD DS, you will learn how to configure the computer name,
the time, the administrator password, and a static TCP/IP address, and then
you will install DNS.

Exercise 1.3 will have you install Active Directory onto a Datacenter Server
Core server using Microsoft PowerShell. If you need to install Active Directory
onto any Windows Server 2016 server using PowerShell, it’s the same steps in
this exercise.

( )

EXERCISE 1.3

Installing AD DS on Server Core Using PowerShell

1. At the Server Core command prompt, type cd\windows\system32 and
press Enter.

2. Type timedate.cpl and set your date, local time zone, and time. Click
OK.

3. Type Netsh and press Enter.

4. Type Interface, and press Enter.

5. Type 1pv4, and press Enter.
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6. Type show IP and press Enter. This will show you the current TCP/IP
address and the interface with which the TCP/IP address is associated.

7. As you can see, interface 12 is my Ethernet interface. To change this
interface, type the following command and press Enter:

Set address name="12" source=static address=192.168.0.165
mask=255.255.255.0 gateway=192.168.0.1

I used 192.168.0.x for my address. You can replace the address, mask,
and gateway based on your local settings.

8. Type show IP and press Enter. You should see that the new address is
now manual and set to the IP address you set.

9. Type Exit and press Enter.
10. Type Net User Administrator * and press Enter.

11. Type in your password and then confirm the password. I used p@ssword
for my password.

12. Type the following command and press Enter:

Netdom renamecomputer %computername% /newname:ServerA

13. Type Y and press Enter.

14. Type shutdown /R /T 0 and press Enter. This will reboot the machine.
After the reboot, log back into the system.

15. Type Powershell and press Enter.

16. At the PowerShell prompt, type Add-WindowsFeature DNS and press
Enter. This will add DNS to the server.

17. At the PowerShell prompt, type Add-windowsFeature AD-Domain-
services and press Enter.

18. At the PowerShell prompt, type Import-Module ADDSDeployment.
19. At the PowerShell prompt, type Install-ADDSForest.
20. Type in your domain name and press Enter. I used Sybex.com.

21. Next you will be asked for your Safe mode administrator password.
Type in P@ssword and then confirm it.

22. Type Y and press Enter.

Active Directory will install, and the machine will automatically reboot.

-

Now that we have installed Active Directory onto two different types of

systems, let’s take a look at how to install an RODC. In Exercise 1.4 I will show

you how to add a RODC to a domain. To do this exercise, you need another
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domain controller in the domain.

Vs

1.

10.

11.

12.
13.
14.

15.

16.

17.

EXERCISE 1.4

Creating an RODC Server

Install the Active Directory Domain Services by clicking the Add Roles
And Features link in Server Manager’s Dashboard view.

. At the Before You Begin screen, click Next.

. The Select Installation Type screen will be next. Make sure that the

Role-Based radio button is selected and click Next.

At the Select Destination Server screen, choose the local machine. Click
Next.

At the Select Server Roles screen, click the check box for Active
Directory Domain Services.

. After you check the Active Directory Domain Services box, a pop-up

menu will appear asking you to install additional features. Click the
Add Features button.

Click Next.

At the Select Features screen, accept the defaults and click Next.
Click Next at the information screen.

Click the Install button at the Confirmation Installation screen.

The Installation Progress screen will show you how the installation is
progressing.

After the installation is complete, click the Close button.
On the left side window, click the AD DS link.

Click the More link next to Configuration Required for Active Directory
Domain Services.

Under the Post-Deployment Configuration section, click the Promote
This Server To A Domain Controller link.

At this point, you will configure this domain controller. You are going to
install a new domain controller in an existing domain. At the
Deployment Configuration screen, choose the Add A Domain Controller
to an existing Domain. You then need to add the name of another
domain controller in that domain.

At the Domain Controller Options screen, set the following options:
» Verify that the RODC check box is checked.

~N
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» Password: P@ssword
Then click Next.
18. At the Paths screen, accept the default file locations and click Next.

19. At the Review Options screen, verify your settings and click Next. At
this screen, there is a View Script button. This button allows you to grab
a PowerShell script based on the features you have just set up.

20. At the Prerequisites Check screen, click the Install button (as long as
there are no errors). Warnings are OK just as long as there are no
errors.

21. After the installation completes, the machine will automatically reboot.
Log in as the administrator.

22. Close Server Manager.

(& J

Deploying Active Directory in Windows Azure

Well, before I jump into this topic, I must first explain what I am talking about.
Windows Azure is a Microsoft cloud platform that allows you to put your server
data into the cloud. Deploying Active Directory with Infrastructure as a Service
(IaaS) means you are using virtualization for the deployment.

So, to put this in a nutshell, this type of install is actually not too far off from
the install you already did. You create a virtual server and then install Active
Directory. Then you upload that virtual server to the cloud.

Now that you understand what this section is about, let’s talk about some of
the tasks that are different from the normal way you install Active Directory
virtually. There are three main differences when installing Active Directory
IaaS on Windows Azure.

Windows Azure virtual machines may need to have connectivity to
the corporate network. Microsoft states that you don’t have to have
connectivity to your onsite corporate network, but you will lose functionality.
Thus, Microsoft recommends that you set up connectivity, and to do that, you
must use Windows Azure Virtual Network. Windows Azure Virtual Network
includes a site-to-site or site-to-point virtual private network (VPN)
component capable of seamlessly connecting Windows Azure virtual machines
and onsite machines.

Static IP addresses are not supported on Windows Azure virtual
machines. Normally, when setting up a server, we all use static IP addresses.
This is actually required on a DHCP server, DNS server, and so on. But when
you deploy Active Directory IaaS in Windows Azure, you must use Dynamic
TCP/IP addressing, and this requires that you set up Windows Azure Virtual
Network.
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IP addresses for Windows Azure virtual machines are attached to Windows
Azure Virtual Network, and that TCP/IP address persists for the lifetime of the
virtual machine. Because of this, the Windows Server Active Directory
requirements for IP addressing are met, and the requirements for DNS are also
met if you want the server to have both roles.

Windows Azure allows for two distinct disk types for virtual
machines. The selection of the virtual machine disk type is important when
deploying domain controllers. Windows Azure allows both “operating system
disks” and “data disks.” Most of the time you will use data disks when
installing Active Directory on the virtual machine. Data disks use write-
through caching, guaranteeing durability of writes, and this is important to the
integrity of any Windows Server active machine. There are some other factors
of which you should be aware when choosing your disk type. Please check
Microsoft’s website for more details when choosing a disk type.

Installing Additional Domain Controllers by Using Install from
Media

There may be times when you need to install additional domain controllers
without having a lot of additional replication traffic. When you can install a
domain controller without the need of additional replication traffic, the
installation is much quicker. This is the perfect time to install an additional
domain controller by using the Install from Media (IFM) method.

Windows Server 2016 allows you to install a domain controller using the IFM
method by using the Ntdsutil utility. The Ntdsutil utility allows you to create
installation media for an additional domain controller in a domain. One issue
that you must remember is that any objects that were created, modified, or
deleted since the IFM was created must be replicated. By creating the IFM as
close (time wise) as the installation of the domain controller guarantees that all
objects will be created at the time the domain controller is installed.

One other way that you can also create the IFM is by restoring a backup of a
similar domain controller in the same domain to another location.

Verifying Active Directory Installation

Once you have installed and configured Active Directory, you’ll want to verify
that you have done so properly. In the following sections, you’ll look at
methods for doing this.

Using Event Viewer

The first (and perhaps most informative) way to verify the operations of Active
Directory is to query information stored in the Windows Server 2016 event log.
You can do this using the Windows Server 2016 Event Viewer. Exercise 1.5
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walks you through this procedure. Entries seen with the Event Viewer include
errors, warnings, and informational messages.

( N

‘% To complete the steps in Exercise 1.5, you must have configured

the local machine as a domain controller.

(. J
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EXERCISE 1.5

Viewing the Active Directory Event Log

1. Open Administrative tools by pressing the Windows key and choosing
Administrative Tools.

2. Open the Event Viewer snap-in from the Administrative Tools program
group.

3. In the left pane, under Applications And Services Logs, select Directory
Service.

4. In the right pane, you can sort information by clicking column
headings. For example, you can click the Source column to sort by the
service or process that reported the event.

5. Double-click an event in the list to see the details for that item. Note
that you can click the Copy button to copy the event information to the
Clipboard. You can then paste the data into a document for later
reference. Also, you can move between items using the up and down
arrows. Click OK when you have finished viewing an event.

6. Filter an event list by right-clicking the Directory Service item in the left
pane and selecting Filter Current Log. Note that filtering does not
remove entries from the event logs—it only restricts their display.

7. To verify Active Directory installation, look for events related to the
proper startup of Active Directory, such as Event ID 1000 (Active
Directory Startup Complete) and 1394 (Attempts To Update The Active
Directory Database Are Succeeding). Also, be sure to examine any error
or warning messages because they could indicate problems with DNS or
other necessary services.

8. When you've finished viewing information in the Event Viewer, close
the application.
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Gaining Insight Through Event Viewer

Despite its simple user interface and somewhat limited GUI functionality,
the Event Viewer tool can be your best ally in isolating and troubleshooting
problems with Windows Server 2016. The Event Viewer allows you to view
information that is stored in various log files that are maintained by the
operating system. This includes information from the following logs:

Application Stores messages generated by programs running on your
system. For example, SQL Server 2012 might report the completion of a
database backup job within the Application log.

Security Contains security-related information as defined by your
auditing settings. For example, you could see when users have logged onto
the system or when particularly sensitive files have been accessed.

System Contains operating system-related information and messages.
Common messages might include a service startup failure or information
about when the operating system was last rebooted.

Directory Service Stores messages and events related to how Active
Directory functions. For example, you might find details related to
replication here.

DNS Server Contains details about the operations of the DNS service.
This log is useful for troubleshooting replication or name-resolution
problems.

Other Log Files Contain various features of Windows Server 2016 and
the applications that may run on this operating system, which can create
additional types of logs. These files allow you to view more information
about other applications or services through the familiar Event Viewer
tool.

Additionally, developers can easily send custom information from their
programs to the Application log. Having all of this information in one place
really makes it easy to analyze operating system and application messages.
Also, many third-party tools and utilities are available for analyzing log
files.

Although the Event Viewer GUI does a reasonably good job of letting you
find the information you need, you might want to extract information to
analyze other systems or applications. One especially useful feature of the
Event Viewer is its ability to save a log file in various formats. You can
access this feature by clicking Action > Save As. You'll be given the option
of saving in various formats, including tab- and comma-delimited text files.
You can then open these files in other applications (such as Microsoft
Excel) for additional data analysis.
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Overall, in the real world, the Event Viewer can be an excellent resource for
monitoring and troubleshooting your important servers and workstations.

In addition to providing information about the status of events related to
Active Directory, the Event Viewer shows you useful information about other
system services and applications. You should routinely use this tool.

Using Active Directory Administrative Tools

After a server has been promoted to a domain controller, you will see that
various tools are added to the Administrative Tools program group, including
the following;:

Active Directory Administrative Center This is a Microsoft Management
Console (MMC) snap-in that allows you to accomplish many Active Directory
tasks from one central location. This MMC snap-in allows you to manage your
directory services objects, including doing the following tasks:

= Reset user passwords

= Create or manage user accounts

m Create or manage groups

m Create or manage computer accounts

= Create or manage organizational units (OUs) and containers

m Connect to one or several domains or domain controllers in the same
instance of Active Directory Administrative Center

= Filter Active Directory data

Active Directory Domains and Trusts Use this tool to view and change
information related to the various domains in an Active Directory
environment. This MMC snap-in also allows you to set up shortcut trusts.

Active Directory Sites and Services Use this tool to create and manage
Active Directory sites and services to map to an organization’s physical
network infrastructure.

Active Directory Users and Computers User and computer management
is fundamental for an Active Directory environment. The Active Directory
Users and Computers tool allows you to set machine- and user-specific settings
across the domain. This tool is discussed throughout this book.

Active Directory Module for Windows PowerShell Windows
PowerShell is a command-line shell and scripting language. The Active
Directory Module for Windows PowerShell is a group of cmdlets used to
manage your Active Directory domains, Active Directory Lightweight Directory
Services (AD LDS) configuration sets, and Active Directory Database Mounting
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Tool instances in a single, self-contained package. The Active Directory Module
for Windows PowerShell is a normal PowerShell window. The only difference
is that the Active Directory PowerShell module is pre-loaded when you choose
the Active Directory Module for Windows PowerShell.

A good way to make sure that Active Directory is accessible and functioning
properly is to run the Active Directory Users and Computers tool. When you
open the tool, you should see a configuration similar to that shown in Figure
1.8. Specifically, you should make sure the name of the domain you created
appears in the list. You should also click the bomain controllers folder and
make sure that the name of your local server appears in the right pane. If your
configuration passes these two checks, Active Directory is present and
configured.

T Active Directory Users and Cemputers — 0 x

File Action View Help

g AWM OEeE HM TR TIR
o Active Directary Users and Com || Name Type Description
- 3:””;!":“;; ] Builtin builtinDomain
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M rE "l | Computers Container Default container for up...
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. e =| Domain Con... Organizational... Default container for do..
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2| Domain Controllers i 45 2 Dt :
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| Managed Service Accou
Users

FIGURE 1.8 Viewing Active Directory information using the Active Directory
Users and Computers tool

Testing from Clients

The best test of any solution is simply to verify that it works the way you had
intended in your environment. When it comes to using Active Directory, a good
test is to ensure that clients can view and access the various resources
presented by Windows Server 2016 domain controllers. In the following
sections, you’ll look at several ways to verify that Active Directory is
functioning properly.
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Verifying Client Connectivity

If you are unable to see the recently promoted server on the network, there is
likely a network configuration error. If only one or a few clients are unable to
see the machine, the problem is probably related to client-side configuration.
To fix this, make sure that the client computers have the appropriate TCP/IP
configuration (including DNS server settings) and that they can see other
computers on the network.

If the new domain controller is unavailable from any of the other client
computers, you should verify the proper startup of Active Directory using the
methods mentioned earlier in this chapter. If Active Directory has been
started, ensure that the DNS settings are correct. Finally, test network
connectivity between the server and the clients by accessing the network or by
using the ping command.

Joining a Domain

If Active Directory has been properly configured, clients and other servers
should be able to join the domain. Exercise 1.6 outlines the steps you need to
take to join a Windows 7, Windows 8/8.1, or Windows 10 computer to the
domain.

To complete this exercise, you must have already installed and properly
configured at least one Active Directory domain controller and a DNS server
that supports SRV records in your environment. In addition to the domain
controller, you need at least one other computer, not configured as a domain
controller, running one of the following operating systems: Windows 7,
Windows 8, Windows 8.1, Windows 10, Windows Server 2008, Windows
Server 2008 R2, Windows Server 2012, Windows Server 2012 R2, or Windows
Server 2016.

Once clients are able to join the domain successfully, they should be able to
view Active Directory resources using the Network icon. This test validates the
proper functioning of Active Directory and ensures that you have connectivity
with client computers.

( )

’% Exercise 1.6 is being done from a Windows 10 Enterprise

computer.

G J/
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EXERCISE 1.6

Joining a Computer to an Active Directory Domain
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1. Right-click on the Start menu and choose System.

2. Go to the section called Computer Name. On the right side, click the
Change Settings link.

3. Next to the section To Rename This Computer Or Change Its Domain
Or Workgroup, click the Change button.

4. In the Member Of section, choose the Domain option. Type the name of
the Active Directory domain that this computer should join. Click OK.

5. When prompted for the username and password of an account that has
permission to join computers to the domain, enter the information for
an administrator of the domain. Click OK to commit the changes. If you
successfully joined the domain, you will see a dialog box welcoming you
to the new domain.

6. You will be notified that you must reboot the computer before the
changes take place. Select Yes when prompted to reboot.

- J

Creating and Configuring Application Data Partitions

Organizations store many different kinds of information in various places. For
the IT departments that support this information, it can be difficult to ensure
that the right information is available when and where it is needed. Windows
Server 2016 uses a feature called application data partitions, which allows
system administrators and application developers to store custom information
within Active Directory. The idea behind application data partitions is that
since you already have a directory service that can replicate all kinds of
information, you might as well use it to keep track of your own information.

Developing distributed applications that can, for example, synchronize
information across an enterprise is not a trivial task. You have to come up with
a way to transfer data between remote sites (some of which are located across
the world), and you have to ensure that the data is properly replicated. By
storing application information in Active Directory, you can take advantage of
its storage mechanism and replication topology. Application-related
information stored on domain controllers benefits from having fault-tolerance
features and availability.

Consider the following simple example to understand how this can work.
Suppose your organization has developed a customer Sales Tracking and
Inventory application. The company needs to make the information that is
stored by this application available to all of its branch offices and users located
throughout the world. However, the goal is to do this with the least amount of
IT administrative effort. Assuming that Active Directory has already been
deployed throughout the organization, developers can build support into the
application for storing data within Active Directory. They can then rely on
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Active Directory to store and synchronize the information among various sites.
When users request updated data from the application, the application can
obtain this information from the nearest domain controller that hosts a replica
of the Sales Tracking and Inventory data.

Other types of applications can also benefit greatly from the use of application
data partitions. Now that you have a good understanding of the nature of
application data partitions, let’s take a look at how you can create and manage
them using Windows Server 2016 and Active Directory.

Creating Application Data Partitions

By default, after you create an Active Directory environment, you will not have
any customer application data partitions. Therefore, the first step in making
this functionality available is to create a new application data partition. You
can use several tools to do this:

Third-Party Applications or Application-Specific Tools Generally, if
you are planning to install an application that can store information in the
Active Directory database, you'll receive some method of administering and
configuring that data along with the application. For example, the setup
process for the application might assist you in the steps you need to take to set
up a new application data partition and to create the necessary structures for
storing data.

( N\

‘% Creating and managing application data partitions are advanced

Active Directory—related functions. Be sure that you have a solid
understanding of the Active Directory schema, Active Directory replication,
LDAP, and your applications’ needs before you attempt to create new
application data partitions in a live environment.

G /

Active Directory Service Interfaces ADSI is a set of programmable objects
that can be accessed through languages such as Visual Basic Scripting Edition
(VBScript), Visual C#, Visual Basic .NET, and many other language
technologies that support the Component Object Model (COM) standard.
Through the use of ADSI, developers can create, access, and update data stored
in Active Directory and in any application data partitions.

The LDP Tool You can view and modify the contents of the Active Directory
schema using LDAP-based queries. The LDP tool allows you to view
information about application data partitions.

Ldp.exe is a graphical user interface (GUI) tool that allows an administrator to
configure Lightweight Directory Access Protocol (LDAP) directory service.
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Administrators have the ability to use the LDP tool to administer an Active
Directory Lightweight Directory Services (AD LDS) instance. To use the LDP
tool, you must be an administrator or equivalent.

Ntdsutil The ntdsutil utility is the main method by which system
administrators create and manage application data partitions on their
Windows Server 2016 domain controllers. This utility’s specific commands are
covered later in this chapter.

‘% Creating and managing application data partitions can be fairly

complex. Such a project’s success depends on the quality of the
architecture design. This is a good example of where IT staff and
application developers must cooperate to ensure that data is stored
effectively and that it is replicated efficiently.

& J

You can create an application data partition in one of three different locations
within an Active Directory forest:

= As a new tree in an Active Directory forest
= As a child of an Active Directory domain partition

For example, you can create an Accounting application data partition
within the Finance.MyCompany.com domain.

= As a child of another application data partition
This method allows you to create a hierarchy of application data partitions.

As you might expect, you must be a member of the Enterprise Admins or
Domain Admins group to be able to create application data partitions.
Alternatively, you can be delegated the appropriate permissions to create new
partitions.

Now that you have a good idea of the basic ways in which you can create
application data partitions, let’s look at how replicas (copies of application data
partition information) are handled.

Managing Replicas

A replica is a copy of any data stored within Active Directory. Unlike the basic
information that is stored in Active Directory, application partitions cannot
contain security principals. Also, not all domain controllers automatically
contain copies of the data stored in an application data partition. System
administrators can define which domain controllers host copies of the
application data. This is an important feature because, if replicas are used
effectively, administrators can find a good balance between replication traffic
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and data consistency. For example, suppose that three of your organization’s
30 locations require up-to-date accounting-related information. You might
choose to replicate the data only to domain controllers located in the places
that require the data. Limiting replication of this data reduces network traffic.

Replication is the process by which replicas are kept up-to-date. Application
data can be stored and updated on designated servers in the same way basic
Active Directory information (such as users and groups) is synchronized
between domain controllers. Application data partition replicas are managed
using the Knowledge Consistency Checker (KCC), which ensures that the
designated domain controllers receive updated replica information.
Additionally, the KCC uses all Active Directory sites and connection objects
that you create to determine the best method to handle replication.

Removing Replicas

When you perform a demotion on a domain controller, that server can no
longer host an application data partition. If a domain controller contains a
replica of application data partition information, you must remove the replica
from the domain controller before you demote it. If a domain controller is the
machine that hosts a replica of the application data partition, then the entire
application data partition is removed and will be permanently lost. Generally,
you want to do this only after you're absolutely sure that your organization no
longer needs access to the data stored in the application data partition.

Using ntdsutil to Manage Application Data Partitions

The primary method by which system administrators create and manage
application data partitions is through the ntdsutil command-line tool. You can
launch this tool simply by entering ntdsutil at a command prompt. The
ntdsutil command is both interactive and context sensitive. That is, once you
launch the utility, you’ll see an ntdsutil command prompt. At this prompt, you
can enter various commands that set your context within the application. For
example, if you enter the domain management command, you’ll be able to use
domain-related commands. Several operations also require you to connect to a
domain, a domain controller, or an Active Directory object before you perform
a command.

( N\

‘éﬁ For complete details on using ntdsutil, see the Windows Server
2016 Help and Support Center.
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Table 1.3 describes the domain management commands supported by the
ntdsutil tool. You can access this information by typing in the following
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sequence of commands at a command prompt:

ntdsutil
domain management
Help

TABLE 1.3 ntdsutil domain management commands

ntdsutil Domain Management Command
Help or ?

Connection Or Connections

Create NC PartitionDistinguishedNameDNSName

Delete NC PartitionDistinguishedName

List NC Information PartitionDistinguishedName

List NC Replicas PartitionDistinguishedName

Precreate PartitionDistinguishedNameServerDNSName

Purpose

Displays information
about the commands
that are available
within the Domain
Management menu of
the ntdsutil
command.

Allows you to connect
to a specific domain
controller. This will set
the context for further
operations that are
performed on specific
domain controllers.

Creates a new
application directory
partition.

Removes an
application data
partition.

Shows information
about the specified
application data
partition.

Returns information
about all replicas for
the specific application
data partition.

Pre-creates cross-
reference application
data partition objects.
This allows the
specified DNS server
to host a copy of the
application data
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partition.

Remove NC Replica Removes a replica

PartitionDistinguishedNameDCDNSName from the specified
domain controller.

Select Operation Target Selects the naming
context that will be
used for other
operations.

Set NC Reference Domain Specifies the reference

PartitionDistinguishedNameDomainDistinguishedName Jomain for an

application data
partition.
Set NC Replicate NotificationDelay Defines settings for

PartitionDistinguishedNameFirstDCNotificationDelay how often replication
OtherDCNotificationDelay will occur for the

specified application
data partition.

‘% The ntdsutil commands are all case insensitive. Mixed case was

used in the table to make them easier to read. NC in commands stands for
“naming context,” referring to the fact that this is a partition of the Active
Directory schema.

(& J

Figure 1.9 provides an example of working with ntdsutil. The following
commands were entered to set the context for further operations:

ntdsutil

domain management
connections

connect to server localhost
connect to domain ADTest
quit

list

Hi va- Net wor k. Corr 2
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FIGURE 1.9 Viewing ntdsutil commands on the local domain controller

Configuring DNS Integration with Active Directory

There are many benefits to integrating Active Directory and DNS services:

= You can configure and manage replication along with other Active
Directory components.

» You can automate much of the maintenance of DNS resource records
through the use of dynamic updates.

= You will be able to set specific security options on the various properties of
the DNS service.

Exercise 1.7 shows the steps that you must take to ensure that these integration
features are enabled. You’ll look at the various DNS functions that are specific
to interoperability with Active Directory.

Before you begin this exercise, make sure that the local machine is configured
as an Active Directory domain controller and that DNS services have been
properly configured. If you instructed the Active Directory Installation Wizard
to configure DNS automatically, many of the settings mentioned in this section
may already be enabled. However, you should verify the configuration and be
familiar with how the options can be set manually.
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EXERCISE 1.7

Configuring DNS Integration with Active Directory

1. Open Administrative Tools by pressing the Windows key and choosing
Administrative Tools.

2. Open the DNS snap-in from the Administrative Tools program group.

3. Right-click the icon for the local DNS server and select Properties. Click
the Security tab. Notice that you can now specify which users and
groups have access to modify the configuration of the DNS server. Make
any necessary changes and click OK.

4. Expand the local server branch and the Forward Lookup zones folder.

5. Right-click the name of the Active Directory domain you created and
select Properties.

6. On the General tab (see Figure 1.10), verify that the type is Active
Directory—Integrated and that the Data Is Stored In Active Directory
message is displayed. If this option is not currently selected, you can
change it by clicking the Change button next to Type and choosing the
Store The Zone In Active Directory check box on the bottom.

7. Verify that the Dynamic Updates option is set to Secure Only. This
ensures that all updates to the DNS resource records database are made
through authenticated Active Directory accounts and processes.

The other options are Nonsecure And Secure (accepts all updates) and
None (to disallow dynamic updates).

8. Finally, notice that you can define the security permissions at the zone
level by clicking the Security tab. Make any necessary changes and click
OK.

~N
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FIGURE 1.10 General Tab of DNS zone properties

Summary

This chapter covered the basics of implementing an Active Directory forest and
domain structure, creating and configuring application data partitions, and
setting the functional level of your domain and forest.

You are now familiar with how you can implement Active Directory. We
carefully examined all of the necessary steps and conditions that you need to
follow to install Active Directory on your network. First you need to prepare for
the Domain Name System because Active Directory cannot be installed without
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the support of a DNS server.

You also need to verify that the computer you upgrade to a domain controller
meets some basic file system and network connectivity requirements so that
Active Directory can run smoothly and efficiently in your organization. These
are some of the most common things you will have to do when you deploy
Active Directory.

The chapter also covered the concept of domain functional levels, which
essentially determine the kinds of domain controllers you can use in your
environment.

You also learned how to install Active Directory, which you accomplish by
promoting a Windows Server 2016 computer to a domain controller using
Server Manager. You also learned how to verify the installation by testing
Active Directory from a client computer.

This chapter was limited in scope to examining the issues related to installing
and configuring the first domain in an Active Directory environment.

Exam Essentials

Know the prerequisites for promoting a server to a domain
controller. You should understand the tasks that you must complete before
you attempt to upgrade a server to a domain controller. Also, you should have
a good idea of the information you need in order to complete the domain
controller promotion process.

Understand the steps of the Active Directory Installation Wizard.
When you run the Active Directory Installation Wizard, you’ll be presented
with many different choices. You should understand the effects of the various
options provided in each step of the wizard.

Be familiar with the tools that you will use to administer Active
Directory. Three main administrative tools are installed when you promote a
Windows Server 2016 to a domain controller. Be sure that you know which
tools to use for which types of tasks.

Understand the purpose of application data partitions. The idea
behind application data partitions is that since you already have a directory
service that can replicate all kinds of security information, you can also use it
to keep track of application data. The main benefit of storing application
information in Active Directory is that you can take advantage of its storage
mechanism and replication topology. Application-related information stored
on domain controllers benefits from having fault-tolerance features and
availability.

Review Questions

Hi va- Net wor k. Corr 2
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You can find the answers in the Appendix.

1. You are the system administrator of a large organization that has recently
implemented Windows Server 2016. You have a few remote sites that do
not have very tight security. You have decided to implement read-only
domain controllers (RODCs). What forest and function levels does the
network need for you to do the install? (Choose all that apply.)

A. Windows Server 2016
B. Windows Server 2008 R2
C. Windows Server 2012 R2
D. Windows Server 2008

2. What is the maximum number of domains that a Windows Server 2016
computer configured as a domain controller may participate in at one time?

A. Zero
B. One
C. Two
D. Any number of domains

3. A system administrator is trying to determine which file system to use for a
server that will become a Windows Server 2016 file server and domain
controller. The company has the following requirements:

= The file system must allow for file-level security from within Windows
2016 Server.

= The file system must make efficient use of space on large partitions.
= The domain controller Sysvol must be stored on the partition.
Which of the following file systems meets these requirements?
A. FAT
B. FAT32
C. HPFS
D. NTFS

4. For security reasons, you have decided that you must convert the system
partition on your removable drive from the FAT32 file system to NTFS.
Which of the following steps must you take in order to convert the file
system? (Choose two.)

A. Run the command CONVERT /FS:NTFS from the command prompt.

B. Rerun Windows Server 2016 Setup and choose to convert the partition
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to NTFS during the reinstallation.

C. Boot Windows Server 2016 Setup from the installation CD-ROM and
choose Rebuild File System.

D. Reboot the computer.

5. Windows Server 2016 requires the use of which of the following protocols
or services in order to support Active Directory? (Choose two.)

DHCP
TCP/IP
NetBEUI
IPX/SPX
E. DNS

6. You are promoting a Windows Server 2016 computer to an Active Directory
domain controller for test purposes. The new domain controller will be
added to an existing domain. While you are using the Active Directory
Installation Wizard, you receive an error message that prevents the server
from being promoted. Which of the following might be the cause of the
problem? (Choose all that apply.)

S 0w

A. The system does not contain an NTFS partition on which the Sysvol
directory can be created.

B. You do not have a Windows Server 2016 DNS server on the network.
C. The TCP/IP configuration on the new server is incorrect.
D. The domain has reached its maximum number of domain controllers.

7. Your network contains a single Active Directory domain. The domain
contains five Windows Server 2008 R2 domain controllers. You plan to
install a new Windows Server 2016 domain controller. Which two actions
would you need to perform? (Each correct answer presents part of the
solution. Choose two.)

A. Run adprep.exe /rodcprep at the command line.

B. Run adprep.exe /forestprep at the command line.
C. Run adprep.exe /domainprep at the command line.
D

. From Active Directory Domains and Trusts, raise the functional level of
the domain.

E. From Active Directory Users and Computers, prestage the RODC
computer account.

8. You are the network administrator for a large company that creates
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widgets. Management asks you to implement a new Windows Server 2016
system. You need to implement federated identity management. Which of
the following will help you do this?

A. Active Directory Federation Services
B. Active Directory DNS Services

C. Active Directory IIS Services

D. Active Directory IAS Services

. You are the system administrator responsible for your company’s
infrastructure. You think you have an issue with name resolution, and you
need to verify that you are using the correct hostname. You want to test
DNS on the local system and need to see whether the hostname server-1
resolves to the IP address 10.1.1.1. Which of the following actions provides a
solution to the problem?

A. Add a DNS server to your local subnet.

B. Add the mapping for the hostname server-1 to the IP address 10.1.1.1in
the local system’s HOSTS file.

C. Add an A record to your local WINS server.
D. Add an MX record to your local DNS server.

. You have one Active Directory forest in your organization that contains one
domain named willpPanek.com. You have two domain controllers configured
with the DNS role installed. There are two Active Directory Integrated
zones named willPanek.com and WillPanekAD.com. One of your IT members
(who is not an administrator) needs to be able to modify the willPanek.com
DNS server, but you need to prevent this user from modifying the
willPanekAD.com SOA record. How do you accomplish this?

A. Modify the permissions of the willpanek.com zone from the DNS
Manager snap-in.

B. Modify the permissions of the willPanekAd.com zone from the DNS
Manager snap-in.

a

Run the Delegation Of Control Wizard in Active Directory.
D. Run the Delegation Of Control Wizard in the DNS snap-in.
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Chapter 2
Administer Active Directory

THE FOLLOWING 70-742 EXAM OBJECTIVES ARE COVERED IN
THIS CHAPTER:

v Create and manage Active Directory users and computers

= This objective may include but is not limited to: Automate the creation
of Active Directory accounts; create, copy, configure, and delete users
and computers; configure templates; perform bulk Active Directory
operations; configure user rights; implement offline domain join;
manage inactive and disabled accounts; automate unlocking of disabled

accounts using Windows PowerShell; automate password resets using
Windows PowerShell.

v Create and manage Active Directory groups and organizational
units (OUs)

» This objective may include but is not limited to: Configure group
nesting; convert groups, including security, distribution, universal,
domain local, and domain global; manage group membership using
Group Policy; enumerate group membership; automate group
membership management using Windows PowerShell; delegate the
creation and management of Active Directory groups and OUs; manage
default Active Directory containers; create, copy, configure, and delete
groups and OUs.

» .Configure service authentication and account policies

= This objective may include but is not limited to: Create and configure
Service Accounts; create and configure Group Managed Service
Accounts (gMSAs); configure Kerberos Constrained Delegation (KCD);
manage Service Principal Names (SPNs); configure virtual accounts;
configure domain and local user password policy settings; configure and
apply Password Settings Objects (PSOs); delegate password settings
management; configure account lockout policy settings; configure
Kerberos policy settings within Group Policy.

In previous chapters, you learned how to install Active
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Directory, but you still haven’t been introduced to the lower-level objects that
exist in Active Directory.

In this chapter, you will look at the structure of the various components within
a domain. You’'ll see how an organization’s business structure can be mirrored
within Active Directory through the use of organizational units for ease of use
and to create a seamless look and feel. Because the concepts related to
organizational units are quite simple, some system administrators may
underestimate their importance and not plan to use them accordingly. Make
no mistake: One of the fundamental components of a successful Active
Directory installation is the proper design and deployment of organizational
units.

You'll also see in this chapter the actual steps you need to take to create
common Active Directory objects and then learn how to configure and manage
them. Finally, you’ll look at ways to publish resources and methods for creating
user accounts automatically.

Active Directory Overview

One of the fundamental design goals for Active Directory is to define a single,
centralized repository of users and information resources. Active Directory
records information about all of the users, computers, and resources on your
network. Each domain acts as a logical boundary, and members of the domain
(including workstations, servers, and domain controllers) share information
about the objects within them.

The information stored within Active Directory determines which resources
are accessible to which users. Through the use of permissions that are assigned
to Active Directory objects, you can control all aspects of network security.

Throughout this chapter, you’ll learn the details of security as it pertains to
Active Directory. Note, however, that Active Directory security is only one
aspect of overall network security. You should also be sure that you have
implemented appropriate access control settings for the file system, network
devices, and other resources. Let’s start by looking at the various components
of network security, which include working with security principals and
managing security and permissions, access control lists (ACLs), and access
control entries (ACEs).

‘% ‘When you are setting up a network, you should always keep in

mind that 9o percent of all hacks on a network are internal. This means
internal permissions and security (as well as external security) need to be
as strong as possible while still allowing users to do their jobs.
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Understanding Active Directory Features

Active Directory is the heart and soul of a Microsoft domain, and I can never
talk enough about the roles and features included with Active Directory. Let’s
take a look at some of the advantages of Windows Server 2016 and Active
Directory.

Active Directory Certificate Services Active Directory Certificate Services
(AD CS) provides a customizable set of services that allows you to issue and
manage public key infrastructure (PKI) certificates. These certificates can be
used in software security systems that employ public key technologies.

Active Directory Domain Services Active Directory Domain Services (AD
DS) includes new features that make deploying domain controllers simpler and
lets you implement them faster. AD DS also makes the domain controllers
more flexible, both to audit and to authorize access to files. Moreover, AD DS
has been designed to make performing administrative tasks easier through
consistent graphical and scripted management experiences.

Active Directory Rights Management Services Active Directory Rights
Management Services (AD RMS) provides management and development tools
that let you work with industry security technologies, including encryption,
certificates, and authentication. Using these technologies allows organizations
to create reliable information protection solutions.

Kerberos Authentication Windows Server 2016 uses the Kerberos
authentication protocol and extensions for password-based and public-key
authentication. The Kerberos client is installed as a security support provider
(SSP), and it can be accessed through the Security Support Provider Interface
(SSPI).

Kerberos Constrained Delegation Kerberos constrained delegation (KCD)
is an authentication protocol that administrators can set up for delegating
client credentials for specific service accounts. For example, KCD may be a
requirement for services in SharePoint 2016. If you are planning on using
SharePoint 2016 Analysis Services and Power Pivot data, you will need to
configure KCD. KCD allows a service account to impersonate another service
account and this allows access to specific resources.

Managed Service Accounts The Managed Service Accounts is a Windows
Server 2016 account that is managed by Active Directory. Regular service
accounts are accounts that are created to run specific services such as
Exchange and SQL Server. Normally when an administrator creates a service
account, it’s up to that administrator to maintain the account (including
changing the password). Managed Service Accounts are accounts that
administrators create, but the accounts are managed by Active Directory
(including password changes). To create Managed Service Accounts, you must
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use the New-ADServiceAccount PowerShell command. You must use PowerShell
in order to create a Managed Service Account.

Group Managed Service Accounts The group Managed Service Account
(gMSA) provides the same functionality within the domain as Managed Service
Accounts, but gMSAs extend their functionality over multiple servers. These
accounts are very useful when a service account needs to work with multiple
servers, as with a server farm (for Network Load Balancing).

There are times when the authentication process requires that all instances of a
service use the same service account. This is where gMSAs are used. Once
group Managed Service Account are used, Windows Server 2016 will
automatically manage the password for the service account. The network
administrator will no longer be responsible to manage the service account
password.

Security Auditing Security auditing gives an organization the ability to help
maintain the security of an enterprise. By using security audits, you can verify
authorized or unauthorized access to machines, resources, applications, and
services. One of the best advantages of security audits is to verify regulatory
compliance.

TLS/SSL (Schannel SSP) Schannel is a security support provider (SSP) that
uses the Secure Sockets Layer (SSL) and Transport Layer Security (TLS)
Internet standard authentication protocols together. The Security Support
Provider Interface (SSPI) is an API used by Windows systems to allow security-
related functionality, including authentication.

Windows Deployment Services Windows Deployment Services allows an
administrator to install Windows operating systems remotely. Administrators
can use Windows Deployment Services to set up new computers by using a
network-based installation.

Understanding Security Principals

Security principals are Active Directory objects that are assigned security
identifiers (SIDs). An SID is a unique identifier that is used to manage any
object to which permissions can be assigned. Security principals are assigned
permissions to perform certain actions and access certain network resources.

The following basic types of Active Directory objects serve as security
principals:

User Accounts User accounts identify individual users on your network by
including information such as the user’s name and their password. User
accounts are the fundamental unit of security administration.

Groups There are two main types of groups: security groups and distribution
groups. Both types can contain user accounts. System administrators use
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security groups to ease the management of security permissions. They use
distribution groups, on the other hand, solely to send email. Distribution
groups are not security principals.

Computer Accounts Computer accounts identify which client computers are
members of particular domains. Because these computers participate in the
Active Directory database, system administrators can manage security settings
that affect the computer. They use computer accounts to determine whether a
computer can join a domain and for authentication purposes. As you’ll see later
in this chapter, system administrators can also place restrictions on certain
computer settings to increase security. These settings apply to the computer
and, therefore, also apply to any user who is using it (regardless of the
permissions granted to the user account).

Note that other objects—such as OUs—do not function as security principals.
What this means is that you can apply certain settings (such as Group Policy)
on all of the objects within an OU; however, you cannot specifically set
permissions with respect to the OU itself. The purpose of OUs is to organize
other Active Directory objects logically based on business needs, add a needed
level of control for security, and create an easier way to delegate.

You can manage security by performing the following actions with security
principals:

= You can assign them permissions to access various network resources.
= You can give them user rights.
= You can track their actions through auditing (covered later in this chapter).

The major types of security principals—user accounts, groups, and computer
accounts—form the basis of the Active Directory security architecture. As a
system administrator, you will likely spend a portion of your time managing
permissions for these objects.

( )

‘éﬁ It is important to understand that, since a unique SID defines each

security principal, deleting a security principal is an irreversible process.
For example, if you delete a user account and then later re-create one with
the same name, you'll need to reassign permissions and group membership
settings for the new account. Once a user account is deleted, its SID is
deleted. This is why you should always consider disabling accounts instead
of deleting them.

& J

An Overview of OUs
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An organizational unit (OU) is a logical group of Active Directory objects, just
as the name implies. OUs serve as containers (see Figure 2.1) within which
Active Directory objects can be created, but they do not form part of the DNS
namespace. They are used solely to create organization within a domain.

= Active Directory Users and Computers

File  Action View Help

e MO EBe2 BHm Pl
) Active Directory Users and Com|| Name Type Descrigtion
e 1 Builtin builtinDomain
v - Storm"r"i'.rnd..ﬁ.ﬂ.mm -] Computers Centainer Default container for up...
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FIGURE 2.1 Active Directory OUs

OUs can contain the following types of Active Directory objects:
m Users
= Groups
=» Computers
= Shared Folder objects
= Contacts
= Printers
= InetOrgPerson objects
= Microsoft Message Queuing (MSMQ) Queue aliases
= Other OUs

Perhaps the most useful feature of OUs is that they can contain other OU
objects. As a result, system administrators can hierarchically group resources
and objects according to business practices. The OU structure is extremely
flexible and, as you will see later in this chapter, can easily be rearranged to
reflect business reorganizations.

Another advantage of OUs is that each can have its own set of policies.
Administrators can create individual and unique Group Policy objects (GPOs)
for each OU. GPOs are rules or policies that can apply to all of the objects
within the OU.

Each type of object has its own purpose within the organization of Active
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Directory domains. Later in this chapter, you’ll look at the specifics of User,
Computer, Group, and Shared Folder objects. For now, let’s focus on the
purpose and benefits of using OUs.

The Purpose of OUs

OUs are mainly used to organize the objects within Active Directory. Before
you dive into the details of OUs, however, you must understand how OUs,
users, and groups interact. Most important, you should understand that OUs
are simply containers that you can use to group various objects logically. They
are not, however, groups in the classical sense. That is, they are not used for
assigning security permissions. Another way of stating this is that the user
accounts, computer accounts, and group accounts that are contained in OUs
are considered security principals while the OUs themselves are not.

OUs do not take the place of standard user and group permissions. A good
general practice is to assign users to groups and then place the groups within
OUs. This enhances the benefits of setting security permissions and of using
the OU hierarchy for making settings.

An OU contains objects only from within the domain in which it resides. As
you’ll see in the section “Delegating Administrative Control” later in this
chapter, the OU is the finest level of granularity used for group policies and
other administrative settings.

Benefits of OUs
There are many benefits to using OUs throughout your network environment:

= QUs are the smallest unit to which you can assign directory permissions.

= You can easily change the OU structure, and it is more flexible than the
domain structure.

The OU structure can support many different levels of hierarchy.
Child objects can inherit OU settings.

You can set Group Policy settings on OUs.

You can easily delegate the administration of OUs and the objects within
them to the appropriate users and groups.

Now that you have a good idea of why you should use OUs, take a look at some
general practices you can use to plan the OU structure.

Planning the OU Structure

One of the key benefits of Active Directory is the way in which it can bring
organization to complex network environments. Before you can begin to
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implement OUs in various configurations, you must plan a structure that is
compatible with business and technical needs. In the following sections, you’ll
learn about several factors that you should consider when planning for the
structure of OUs.

Logical Grouping of Resources

The fundamental purpose of using OUs is to group resources (which exist
within Active Directory) hierarchically. Fortunately, hierarchical groups are
quite intuitive and widely used in most businesses. For example, a typical
manufacturing business might divide its various operations into different
departments as follows:

= Sales

= Marketing

= Engineering

= Research and Development
= Support

= Information Technology (IT)

Each of these departments usually has its own goals and mission. To make the
business competitive, individuals within each of the departments are assigned
to various roles. The following role types might be used:

= Managers
Clerical staff
Technical staff

= Planners

Each of these roles usually entails specific job responsibilities. For example,
managers should provide direction to general staff members. Note that the
very nature of these roles suggests that employees may fill many different
positions. That is, one employee might be a manager in one department and a
member of the technical staff in another. In the modern workplace, such
situations are quite common.

All of this information helps you plan how to use OUs. First the structure of
OUs within a given network environment should map well to the business’s
needs, including the political and logical structure of the organization as well
as its technical needs. Figure 2.2 shows how a business organization might be
mapped to the OU structure within an Active Directory domain.
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FIGURE 2.2 Mapping a business organization to an OU structure

When naming OUs for your organization, you should keep several
considerations and limitations in mind:

Keep the Names and Descriptions Simple The purpose of OUs is to
make administering and using resources simple. Therefore, it’s always a good
idea to keep the names of your objects simple and descriptive. Sometimes,
finding a balance between these two goals can be a challenge. For example,
although a printer name like “The LaserJet located near Bob’s cube” might
seem descriptive, it is certainly difficult to type. Also, imagine the naming
changes that you might have to make if Bob moves (or leaves the company)!

Pay Attention to Limitations The maximum length for the name of an OU
is 64 characters. In most cases, this should adequately describe the OU.
Remember, the name of an OU does not have to describe the object uniquely
because the OU is generally referenced only as part of the overall hierarchy.
For example, you can choose to create an OU named “IT” within two different
parent OUs. Even though the OUs have the same name, users and
administrators are able to distinguish between them based on their complete
pathname.

Pay Attention to the Hierarchical Consistency The fundamental basis of
an OU structure is its position in a hierarchy. From a design standpoint, this
means you cannot have two OUs with the same name at the same level.
However, you can have OUs with the same name at different levels. For
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example, you could create an OU named “Corporate” within the North America
OU and another one within the South America OU. This is because the fully
qualified domain name includes information about the hierarchy. When an
administrator tries to access resources in a Corporate OU, they must specify
which Corporate OU they mean.

For example, if you create a North America OU, the Canada OU should
logically fit under it. If you decide that you want to separate the North America
and Canada OUs into completely different containers, then you might want to
use other, more appropriate names. For example, you could change North
America to “U.S.” Users and administrators depend on the hierarchy of OUs
within the domain, so make sure that it remains logically consistent.

Based on these considerations, you should have a good idea of how best to
organize the OU structure for your domain.

Understanding OU Inheritance

When you rearrange OUs within the structure of Active Directory, you can
change several settings. When they are moving and reorganizing OUs, system
administrators must pay careful attention to automatic and unforeseen
changes in security permissions and other configuration options. By default,
OUs inherit the permissions of their new parent container when they are
moved.

By using the built-in tools provided with Windows Server 2016 and Active
Directory, you can move or copy OUs only within the same domain. You
cannot use the Active Directory Users and Computers tool to move OUs
between domains. To do this, use the Active Directory Migration Tool
(ADMT). This is one of the many Active Directory support tools.

Delegating Administrative Control

I already mentioned that OUs are the smallest component within a domain to
which administrative permissions and group policies can be assigned by
administrators. Now you’ll take a look specifically at how administrative
control is set on OUs.

‘% Delegation occurs when a higher security authority assigns

permissions to a lesser security authority. As a real-world example, assume
that you are the director of IT for a large organization. Instead of doing all
of the work yourself, you would probably assign roles and responsibilities
to other individuals. For example, if you worked within a multidomain
environment, you might make one system administrator responsible for all
operations within the Sales domain and another responsible for the
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Engineering domain. Similarly, you could assign the permissions for
managing all printers and print queue objects within your organization to
one individual user while allowing another individual user to manage all
security permissions for users and groups. In this way, you can distribute
the various roles and responsibilities of the IT staff throughout the
organization.

g J

Businesses generally have a division of labor that handles all of the tasks
involved in keeping the company’s networks humming. Network operating
systems (NOSs), however, often make it difficult to assign just the right
permissions; in other words, they do not support very granular permission
assignments. Sometimes, fine granularity is necessary to ensure that only the
right permissions are assigned. A good general rule of thumb is to provide
users and administrators with the minimum permissions they require to do
their jobs. This way, you can ensure that accidental, malicious, and otherwise
unwanted changes do not occur.

( N\

‘% You can use auditing to log events to the Security log in the Event

Viewer. This is a way to ensure that if accidental, malicious, and otherwise
unwanted changes do occur, they are logged and traceable.

g J

In the world of Active Directory, you delegate to define responsibilities for OU
administrators. As a system administrator, you will occasionally be tasked with
having to delegate responsibility to others—you can’t do it all, although
sometimes administrators believe that they can. You understand the old IT
logic of doing all of the tasks yourself for job security, but this can actually
make you look worse.

( N

‘—5’1 You can delegate control only at the OU level and not at the object
level within the OU.

(. J

If you do find yourself in a role where you need to delegate, remember that
Windows Server 2016 was designed to offer you the ability to do so. In its
simplest definition, delegation allows a higher administrative authority to
grant specific administrative rights for containers and subtrees to individuals
and groups. What this essentially does is eliminate the need for domain
administrators with sweeping authority over large segments of the user
population. You can break up this control over branches within your tree,
within each OU you create.
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‘% To understand delegation and rights, you should first understand

the concept of access control entries (ACEs). ACEs grant specific
administrative rights on objects in a container to a user or group. A
container’s access control list (ACL) is used to store ACEs.

. _J

When you are considering implementing delegation, keep these two concerns
in mind:

Parent-Child Relationships The OU hierarchy you create will be important
when you consider the maintainability of security permissions. OUs can exist
in a parent-child relationship, which means that permissions and group
policies set on OUs higher up in the hierarchy (parents) can interact with
objects in lower-level OUs (children). When it comes to delegating
permissions, this is extremely important. You can allow child containers to
inherit the permissions set on parent containers automatically. For example, if
the North America division of your organization contains 12 other OUs, you
could delegate permissions to all of them at once (saving time and reducing the
likelihood of human error) by placing security permissions on the North
America division. This feature can greatly ease administration, especially in
larger organizations, but it is also a reminder of the importance of properly
planning the OU structure within a domain.

Inheritance Settings Now that you've seen how you can use parent-child
relationships for administration, you should consider inheritance, the process
in which child objects take on the permissions of a parent container. When you
set permissions on a parent container, all of the child objects are configured to
inherit the same permissions. You can override this behavior, however, if
business rules do not lend themselves well to inheritance.

Applying Group Policies

One of the strengths of the Windows operating system is that it offers users a
great deal of power and flexibility. From installing new software to adding
device drivers, users can make many changes to their workstation
configurations. However, this level of flexibility is also a potential problem. For
instance, inexperienced users might inadvertently change settings, causing
problems that can require many hours to fix.

In many cases (and especially in business environments), users require only a
subset of the complete functionality the operating system provides. In the past,
however, the difficulty associated with implementing and managing security
and policy settings has led to lax security policies. Some of the reasons for this
are technical—it can be tedious and difficult to implement and manage security
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restrictions. Other problems have been political—users and management
might feel that they should have full permissions on their local machines,
despite the potential problems this might cause.

That’s where the idea of group policies comes in. Simply defined, group
policies are collections of rules that you can apply to objects within Active
Directory. Specifically, Group Policy settings are assigned at the site, domain,
and OU levels, and they can apply to user accounts and computer accounts. For
example, a system administrator can use group policies to configure the
following settings:

= Restricting users from installing new programs
= Disallowing the use of the Control Panel

= Limiting choices for display and Desktop settings

Creating OUs

Now that you have looked at several different ways in which OUs can be used
to bring organization to the objects within Active Directory, it’s time to look at
how you can create and manage them.

Through the use of the Active Directory Users and Computers administrative
tool, also called the MMC (Microsoft Management Console), you can quickly
and easily add, move, and change OUs. This graphical tool makes it easy to
visualize and create the various levels of hierarchy an organization requires.

Figure 2.3 shows a geographically based OU structure that a multinational
company might use. Note that the organization is based in North America and
that it has a corporate office located there. In general, the other offices are
much smaller than the corporate office located in North America.

Hi va- Net wor k. Corr 2
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Company Hierarchy I

Europe I

Africa Asia North America South America
I [ | [ 1
Ehinal Malaysia Francel Germany Argentina Brazil
1
India Vietnam UK Spain Peru Chile
Bombay
New Delhi [ I [ I [ I |
Austin Bﬂstnnl Canada chicagol L.A.I Maxico || N,
Corporate San Francisco
Engineering
HR
Marketing
Research
Sales

FIGURE 2.3 A geographically based OU structure

It’s important to note that this OU structure could have been designed in
several different ways. For example, I could have chosen to group all of the
offices located in the United States within an OU named “U.S.” However,
because of the large size of these offices, I chose to place these objects at the
same level as the Canada and Mexico OUs. This prevents an unnecessarily
deep OU hierarchy while still logically grouping the offices.

One nice feature when creating an OU is the ability to protect the OU from
being accidentally deleted. When you create an OU, you can check the Protect
Container From Accidental Deletion check box. This check box protects against
an administrator deleting the OU. To delete the OU, you must go into the
advanced view of the OU and uncheck the box.

Exercise 2.1 walks you through the process of creating several OUs for a
multinational business. You’ll be using this OU structure in later exercises
within this chapter.

( N\

‘% To perform the exercises included in this chapter, you must have

administrative access to a Windows Server 2016 domain controller.

(& J

4 N\
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EXERCISE 2.1

Creating an OU Structure

1. Open Active Directory Users and Computers by clicking Start >
Administrative Tools > Active Directory Users And Computers.

2. Right-click the name of the local domain and choose New >
Organizational Unit.

3. Type North America for the name of the first OU (see Figure 2.4).
Uncheck the box Protect Container From Accidental Deletion and click
OK to create this object.

4. Create the following top-level OUs by right-clicking the name of the
domain and choosing New > Organizational Unit. Also make sure to
uncheck Protect Container From Accidental Deletion for all OUs in
these exercises because you’ll be deleting some of these OUs in later
ones.

Africa

Asia

Europe

South America

Note that the order in which you create the OUs is not important. In
this exercise, you are simply using a method that emphasizes the
hierarchical relationship.

5. Create the following second-level OUs within the North America OU by
right-clicking the North America OU and selecting New >
Organizational Unit:

Austin
Boston
Canada
Chicago
Corporate
Los Angeles
Mexico
New York
San Francisco
6. Create the following OUs under the Asia OU:
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10.

11.

China
India
Malaysia
Vietnam
Create the following OUs under the Europe OU:
France
Germany
Spain
UK
Create the following OUs under the South America OU:
Argentina
Brazil
Chile
Peru

Create the following third-level OUs under the India OU by right-
clicking India within the Asia OU and selecting New > Organizational
Unit:

Bombay
New Delhi
Within the North America Corporate OU, create the following OUs:
Engineering
HR
Marketing
Research
Sales

When you have completed creating the OUs, close Active Directory.
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New Object - Organizational Unit X

— Createin: StormWindAD .com/

Name:

anrth Amenca

[ rotect container from accidental deletion

OK Cancel Help

FIGURE 2.4 New OU dialog box

Managing OUs

Managing network environments would still be challenging, even if things
rarely changed. However, in the real world, business units, departments, and
employee roles change frequently. As business and technical needs change, so
should the structure of Active Directory.

Fortunately, changing the structure of OUs within a domain is a relatively
simple process. In the following sections, you’ll look at ways to delegate control
of OUs and make other changes.

Moving, Deleting, and Renaming OUs

The process of moving, deleting, and renaming OUs is a simple one. Exercise
2.2 shows how you can easily modify and reorganize OUs to reflect changes in
the business organization. The specific scenario covered in this exercise
includes the following changes:

= The Research and Engineering departments have been combined to form a
department known as Research and Development (RD).

Hi va- Net wor k. Corr 2
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= The Sales department has been moved from the Corporate headquarters

office to the New York office.

m The Marketing department has been moved from the Corporate
headquarters office to the Chicago office.

This exercise assumes you have already completed the steps in Exercise 2.1.

Vs

2. Right-click the Engineering OU (located within North America >
click Yes. Note that if this OU contained objects, they would have all
been automatically deleted as well.

3. Right-click the Research OU and select Rename. Type RD to change
the name of the OU and press Enter.

4. Right-click the Sales OU and select Move. In the Move dialog box,
to move the OU.

Marketing OU and drop it onto the Chicago OU.

6. When you have finished, close the Active Directory Users and
Computers administrative tool.

-

EXERCISE 2.2

Modifying OU Structure

1. Open Active Directory Users and Computers by clicking Start >
Administrative Tools > Active Directory Users And Computers.

Corporate) and click Delete. When you are prompted for confirmation,

expand the North America branch and click the New York OU. Click OK

5. You will use an alternate method to move the Marketing OU. Drag the

Administering Properties of OUs

Although OUs are primarily created for organizational purposes within the
Active Directory environment, they have several settings that you can modify.

To modify the properties of an OU using the Active Directory Users and
Computers administrative tool, right-click the name of any OU and select
Properties. When you do, the OU Properties dialog box appears. In the
example shown in Figure 2.5, you’ll see the options on the General tab.

~N
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Arizona Properties ? X

General Managed By COM-

~rs Anzona
Description: ‘Etmnwm Studios Anzona Office
Street: 14646 N. Kiedand Blvd
Suite 120
City: Scottsdale
State/province: Anzona
Zp/Postal Code: 85254

Country/region: Untted States e

OK Cancel Apply

FIGURE 2.5 The General tab of the OUs Properties dialog box

In any organization, it helps to know who is responsible for managing an OU.
You can set this information on the Managed By tab (see Figure 2.6). The
information specified on this tab is convenient because it is automatically
pulled from the contact information on a user record. You should consider
always having a contact for each OU within your organization so that other
system administrators know whom to contact if they need to make any
changes.
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Arizona Properties ? X

General Managed By COM-+

Name: stormWindAD.com/Arzona/Tom Graunke |
Change.. Properties Clear
Office:
Street: 14646 N. Kiedand Blvd.
Suite 120
City: Scottsdale
State/province: Anzona
Country/region: United States

Telephone number; 800-850-9932

Fax number:

OK Cancel Apply
FIGURE 2.6 The Managed By tab of the OUs Properties dialog box

Delegating Control of OUs

In simple environments, one or a few system administrators may be
responsible for managing all of the settings within Active Directory. For
example, a single system administrator could manage all users within all OUs
in the environment. In larger organizations, however, roles and responsibilities
may be divided among many different individuals. A typical situation is one in
which a system administrator is responsible for objects within only a few OUs
in an Active Directory domain. Alternatively, one system administrator might
manage User and Group objects while another is responsible for managing file
and print services.

Fortunately, using the Active Directory Users and Computers tool, you can


https://technet24.ir
https://technet24.ir

quickly and easily ensure that specific users receive only the permissions they
need. In Exercise 2.3, you will use the Delegation of Control Wizard to assign
permissions to individuals. To complete these steps successfully, first you must
have created the objects in the previous exercises of this chapter.

( N\

EXERCISE 2.3

Using the Delegation of Control Wizard

1. Open Active Directory Users and Computers by clicking Start >
Administrative Tools > Active Directory Users And Computers.

2. Right-click the Corporate OU within the North America OU and select
Delegate Control. This starts the Delegation of Control Wizard. Click
Next to begin configuring security settings.

3. In the Users Or Groups page, click the Add button. In the Enter The
Object Names To Select field, enter Account Operators and click the
Check Names button. Click OK. Click Next to continue.

4. In the Tasks To Delegate page, select Delegate The Following Common
Tasks and place a check mark next to the following items:

Create, Delete, And Manage User Accounts
Reset User Passwords And Force Password Change At Next Logon
Read All User Information
Create, Delete, And Manage Groups
Modify The Membership Of A Group
5. Click Next to continue.

6. The Completing The Delegation Of Control Wizard page then provides
a summary of the operations you have selected. To implement the
changes, click Finish.

g J

Although the common tasks available through the wizard are sufficient for
many delegation operations, you may have cases in which you want more
control. For example, you might want to give a particular system administrator
permissions to modify only Computer objects. Exercise 2.4 uses the Delegation
of Control Wizard to assign more granular permissions. To complete these

steps successfully, you must have completed the previous exercises in this
chapter.

EXERCISE 2.4

Delegating Custom Tasks

Hi va- Net wor k. Corr 2
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. Open Active Directory Users and Computers by clicking Start >
Administrative Tools > Active Directory Users And Computers.

. Right-click the Corporate OU within the North America OU and select
Delegate Control. This starts the Delegation of Control Wizard. Click
Next to begin making security settings.

. In the Users Or Groups page, click the Add button. In the Enter The
Object Names To Select field, enter Server Operators and click the
Check Names button. Click OK and then click Next to continue.

. In the Tasks To Delegate page, select the Create A Custom Task To
Delegate radio button and click Next to continue.

. In the Active Directory Object Type page, choose Only The Following
Objects In The Folder and place a check mark next to the following
items. (You will have to scroll down to see them all.)

User Objects

Computer Objects

Contact Objects

Group Objects
Organizational Unit Objects
Printer Objects

. Click Next to continue.

. In the Permissions page, place a check mark next to the General option
and make sure the other options are not checked. Note that if the
various objects within your Active Directory schema had property-
specific settings, you would see those options here. Place a check mark
next to the following items:

Create All Child Objects
Read All Properties
Write All Properties

This gives the members of the Server Operators group the ability to
create new objects within the Corporate OU and the permissions to
read and write all properties for these objects.

. Click Next to continue.

. The Completing The Delegation Of Control Wizard page provides a
summary of the operations you have selected. To implement the
changes, click Finish.



https://technet24.ir
https://technet24.ir

() Real World S ;
\j:bl_f eal Worl cenario

Delegation: Who’s Responsible for What?

You're the IT director for a large, multinational organization. You've been
with the company for quite a while, that is, since the environment had only
a handful of offices and a few network and system administrators. Times
have changed, however. Now system administrators must coordinate the
efforts of hundreds of IT staffers in 14 countries.

For years now, a debate has been raging among IT administrators on the
question of when to create a new child domain and when to make it just an
OU. For example, let’s say you have a remote office in Concord, New
Hampshire. Do you give the remote office its own domain (as a child
domain), or do you just make the Concord office an OU? Well, it really
depends on who you want to manage the resources in Concord. Do you
want to create domains or OUs based on location?

Fortunately, through the proper use of OUs and delegation, you are given a
lot of flexibility in determining how to handle the administration. You can
structure the administration in several ways. First, if you choose to create
OUs based on a geographic business structure, you could delegate control
of these OUs based on the job functions of various system administrators.
For example, you could use one user account to administer the Concord
OU. Within the Concord OU, this system administrator could delegate
control of resources represented by the Printers and Scanners OUs.

Alternatively, the OU structure may create a functional representation of
the business. For example, the Engineering OU might contain other OUs
that are based on office locations such as New York and Paris. A system
administrator of the Engineering domain could delegate permissions based
on geography or job functions to the lower OUs. Regardless of whether you
build a departmental, functional, or geographical OU model, keep in mind
that each model excludes other models. This is one of the most important
decisions you need to make. When you are making this decision or
modifying previous decisions, your overriding concern is how it will affect
the management and administration of the network. The good news is that,
because Active Directory has so many features, the model you choose can
be based on specific business requirements rather than imposed by
architectural constraints.

-

Troubleshooting OUs

In general, you will find using OUs to be a relatively straightforward and
painless process. With adequate planning, you’ll be able to implement an
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intuitive and useful structure for OU objects.

The most common problems with OU configuration are related to the OU
structure. When troubleshooting OUs, pay careful attention to the following
factors:

Inheritance By default, Group Policy and other settings are transferred
automatically from parent OUs to child OUs and objects. Even if a specific OU
is not given a set of permissions, objects within that OU might still get them
from parent objects.

Delegation of Administration If you allow the wrong user accounts or
groups to perform specific tasks on OUs, you might be violating your
company’s security policy. Be sure to verify the delegations you have made at
each OU level.

Organizational Issues Sometimes, business practices do not easily map to
the structure of Active Directory. A few misplaced OUs, user accounts,
computer accounts, or groups can make administration difficult or inaccurate.
In many cases, it might be beneficial to rearrange the OU structure to
accommodate any changes in the business organization. In others, it might
make more sense to change business processes.

If you regularly consider each of these issues when troubleshooting problems
with OUs, you will be much less likely to make errors in the Active Directory
configuration.

Creating and Managing Active Directory Objects

Now that you are familiar with the task of creating OUs, you should find
creating and managing other Active Directory objects quite simple. The
following sections will examine the details.

Overview of Active Directory Objects

When you install and configure a domain controller, Active Directory sets up
an organizational structure for you, and you can create and manage several
types of objects.

Active Directory Organization

When you are looking at your Active Directory structure, you will see objects
that look like folders in File Explorer. These objects are containers, or
organizational units (OUs). The difference is that an OU is a container to
which you can link a GPO. Normal containers cannot have a GPO linked to
them. That’s what makes an OU a special container.

By default, after you install and configure a domain controller, you will see the
following organizational sections within the Active Directory Users and
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Computers tool (they look like folders):

Built-In The Built-In container includes all of the standard groups that are
installed by default when you promote a domain controller. You can use these
groups to administer the servers in your environment. Examples include the
Administrators group, Backup Operators group, and Print Operators group.

Computers By default, the Computers container contains a list of the
workstations in your domain. From here, you can manage all of the computers
in your domain.

Domain Controllers The Domain Controllers OU includes a list of all the
domain controllers for the domain.

Foreign Security Principals In environments that have more than one
domain, you may need to grant permissions to users who reside in multiple
domains. Generally, you manage this using Active Directory trees and forests.
However, in some cases, you may want to provide resources to users who
belong to domains that are not part of the forest.

Active Directory uses the concept of foreign security principals to allow
permissions to be assigned to users who are not part of an Active Directory
forest. This process is automatic and does not require the intervention of
system administrators. You can then add the foreign security principals to
domain local groups for which, in turn, you can grant permissions for
resources within the domain. You can view a list of foreign security principals
by using the Active Directory Users and Computers tool.

Foreign security principals containers are any objects to which security can be
assigned and that are not part of the current domain. Security principals are
Active Directory objects to which permissions can be applied, and they can be
used to manage permissions in Active Directory.

Managed Service Accounts The Managed Service Accounts container is a
Windows Server 2016 container. Service accounts are accounts created to run
specific services such as Exchange and SQL Server. Having a Managed Service
Accounts container allows you to control the service accounts better and thus
allows for better service account security. To create Managed Service Accounts,
you must use the New-ADServiceAccount PowerShell command.

Users The Users container includes all the security accounts that are part of
the domain. When you first install the domain controller, there will be several
groups in this container. For example, the Domain Admins group and the
administrator account are created in this container.

You want to be sure to protect the administrator account. You should rename
the admin account and make sure the password is complex. Protected admin
accounts can make your network safer. Every hacker knows that there is an
administrator account on the server by default. Be sure to make your network
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safer by protecting the admin account.

Active Directory Objects

You can create and manage several different types of Active Directory objects.
The following are specific object types:

Computer Computer objects represent workstations that are part of the
Active Directory domain. All computers within a domain share the same
security database, including user and group information. Computer objects are
useful for managing security permissions and enforcing Group Policy
restrictions.

Contact Contact objects are usually used in OUs to specify the main
administrative contact. Contacts are not security principals like users. They are
used to specify information about individuals outside the organization.

Group Group objects are logical collections of users primarily for assigning
security permissions to resources. When managing users, you should place
them into groups and then assign permissions to the group. This allows for
flexible management without the need to set permissions for individual users.

InetOrgPerson The InetOrgPerson object is an Active Directory object that
defines attributes of users in Lightweight Directory Access Protocol (LDAP)
and X.500 directories.

MSIMaging-PSPs MSIMaging-PSPs is a container for all Enterprise Scan
Post Scan Process objects.

MSMQ Queue Alias An MSMQ Queue Alias object is an Active Directory
object for the MSMQ-Custom-Recipient class type. The Microsoft Message
Queuing (MSMQ) Queue Alias object associates an Active Directory path and a
user-defined alias with a public, private, or direct single-element format name.
This allows a queue alias to be used to reference a queue that might not be
listed in Active Directory Domain Services (AD DS).

Organizational Unit An OU object is created to build a hierarchy within the
Active Directory domain. It is the smallest unit that can be used to create
administrative groupings, and it can be used to assign group policies.
Generally, the OU structure within a domain reflects a company’s business
organization.

Printer Printer objects map to printers.

Shared Folder Shared Folder objects map to server shares. They are used to
organize the various file resources that may be available on file/print servers.
Often, Shared Folder objects are used to give logical names to specific file
collections. For example, system administrators might create separate shared
folders for common applications, user data, and shared public files.

User A User object is the fundamental security principal on which Active
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Directory is based. User accounts contain information about individuals as well
as password and other permission information.

Creating Objects Using the Active Directory Users and Computers Tool

Exercise 2.5 walks you through the steps necessary to create various objects
within an Active Directory domain. In this exercise, you create some basic
Active Directory objects. To complete this exercise, you must have access to at
least one Active Directory domain controller, and you should have also
completed the previous exercises in this chapter.

( N\

EXERCISE 2.5

Creating Active Directory Objects

1. Open Active Directory Users and Computers by clicking Start >
Administrative Tools > Active Directory Users And Computers.

2. Expand the current domain to list the objects currently contained
within it. For this exercise, you will use the second- and third-level OUs
contained within the North America top-level OU.

3. Right-click the Corporate OU and select New > User. Fill in the
following information:

First Name: Maria

Initial: D

Last Name: President

Full Name: (leave as default)

User Logon Name: mdpresident (leave default domain)
Click Next to continue.

4. Enter P@ssword for the password for this user and then confirm it.
Note that you can also make changes to password settings here. Click
Next.

5. You will see a summary of the user information. Click Finish to create
the new user.

6. Click the RD container and create another user in that container with
the following information:

First Name: John
Initial: Q
Last Name: Adams

Full Name: (leave as default)
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User Logon Name: jgqadams (leave default domain)
Click Next to continue.

7. Assign the password P@ssword. Click Next and then click Finish to
create the user.

8. Right-click the RD OU and select New > Contact. Use the following
information to fill in the properties of the Contact object:

First Name: Jane

Initials: R

Last Name: Admin

Display Name: jradmin

Click OK to create the new Contact object.

9. Right-click the RD OU and select New > Shared Folder. Enter
Software for the name and \\serveri1\applications for the network
path (also known as the Universal Naming Convention [UNC] path).
Note that you can create the object even though this resource (the
physical server) does not exist. Click OK to create the Shared Folder
object.

10. Right-click the HR OU and select New > Group. Type All Users for
the group name. Do not change the value in the Group Name (Pre—
Windows 2000) field. For Group Scope, select Global, and for Group
Type, select Security. To create the group, click OK.

11. Right-click the Sales OU and select New > Computer. Type
Workstation1 for the name of the computer. Notice that the pre—
Windows 2000 name is automatically populated and that, by default,
the members of the Domain Admins group are the only ones who can
add this computer to the domain. Place a check mark in the Assign This
Computer Account As A Pre-Windows 2000 Computer box and then
click OK to create the Computer object.

12. Close the Active Directory Users and Computers tool.

& J

Configuring the User Principal Name

When you log into a domain, your logon name looks like an email address (for
example, wpanek@willpanek.com). This is called your user principal name
(UPN). A UPN is the username followed by the @ sign and the domain name.
At the time the user account is created, the UPN suffix is generated by default.
The UPN is created as username@bomainName, but an administrator can alter or
change the default UPN. If your forest has multiple domains and you need to
change the UPN to a different domain, you have that ability. To change the
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UPN suffix, in Active Directory Users and Computers, choose a user and go
into their properties. Choose the Attribute Editor tab. Scroll down to the
userPrincipalName attribute and make your changes. These changes then get
replicated to the global catalog.

‘% If your organization has multiple forests set up by a trust, you

can’t change the UPN to a domain in the other forest. Global catalogs are
used to log on users. Because UPNs get replicated to the local forest global
catalog servers, you cannot log on to other forests using the UPN.

. J

Using Templates

Now you are going to dive into user templates. User templates allow an Active
Directory administrator to create a default account (for example,
template_sales) and use that account to create all of the other users who match
it (all the salespeople).

If you are creating multiple accounts, this can save you a lot of time and
resources. For example, if you need to add 35 new salespeople to your
company, you'll create one template for sales and use a copy of that template
for all of the other new accounts. This saves you the trouble of filling out many
of the same fields over and over again. When you copy a template, some of the
information does not get copied over. This is because it is user-specific
information. Here are some of the fields that do not get copied over from a
template:

= Name

= Logon Name

= Password

= Email

= Phone Numbers
= Description

= Office

= Web Page

Many of the important fields such as Member Of (groups to which the user
belongs), Profile Path, Department, and Company all get copied over. There is
one important item that needs to be done when creating a template: the
template account needs to be disabled after creation. You do not want anyone
using this account to access your network. In Exercise 2.6, you will create a
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Sales template to use for your Sales department.

Vs

1.

10.
11.
12.

EXERCISE 2.6

Creating a User Template

Open Active Directory Users and Computers by clicking Start >
Administrative Tools > Active Directory Users And Computers.

. Expand the current domain to list the objects contained within it. For

this exercise, you will use the Sales OU. Right-click the Sales OU and
choose New > User.

Use the following properties:
First Name: Sales
Last Name: Template
Username: sales_ template

Password: P@ssword

4. Click Next and then click Finish.

In the right window, double-click the Sales Template user to open the
properties.

On the General tab, complete the following items:
Description: Template Account
Office: Corporate
Telephone: 999-999-9999
Email: Salet@abc.com
Web: www.abc.com

Click the Profile tab. In the Profile Path field, type
\\ServerA\%username%.

On the Members Of tab, click the Add button. At the Enter The Object
Name To Select box, type Administrator and click the Check Names
button. (Normally you would not add salespeople to the Administrators
group, but you are doing so just for this exercise.) Click OK.

. Click the Account tab. Scroll down in the Account Options box and

check the Account Is Disabled check box.
Click OK in the user’s Properties window to go back to the Sales OU.
Right-click the Sales Template account and choose Copy.

Enter the following information:
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First Name: Jenny

Last Name: Sales

Username: jsales

Password: P@ssword

Uncheck the Account Is Disabled check box.

13. In the right window, double-click the Jenny Sales user to open the
properties.

14. Take a look at the Members Of tab, the General tab, and the Profile tab,
and you will see that some of the fields are prefilled (including the
Administrators group).

15. Close Jenny Sales Properties and exit Active Directory Users and
Computers.

& J

Importing Objects from a File

In Exercise 2.5, you created an account using the Active Directory Users and
Computers tool. But what if you need to bulk import accounts? There are two
main applications for doing bulk imports of accounts: the 1difde.exe utility
and the csvde.exe utility. Both utilities import accounts from files.

The 1difde utility imports from line-delimited files. This utility allows an
administrator to export and import data, thus allowing batch operations such
as Add, Modify, and Delete to be performed in Active Directory. Windows
Server 2016 includes 1difde.exe to help support batch operations.

The csvde. exe utility performs the same export functions as 1difde.exe, but
csvde.exe uses a comma-separated value file format. The csvde. exe utility does
not allow administrators to modify or delete objects. It only supports adding
objects to Active Directory.

Active Directory Migration Tool

Another tool that administrators have used in the past is the Active Directory
Migration Tool (ADMT). ADMT allows an administrator to migrate users,
groups, and computers from a previous version of the server to a current
version of the server.

Administrators also used ADMT to migrate users, groups, and computers
between Active Directory domains in different forests (interforest migration)
and between Active Directory domains in the same forest (intraforest
migration).

At the time this book was written, Microsoft had not yet released a new version
of ADMT that is supported by Windows Server 2016. The reason I even
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mention it in this book is because Microsoft may be releasing a version of it
soon and I wanted you to understand what it can do. Continue to check the
Microsoft website to see whether a new version has been released.

Offline Domain Join of a Computer

Offline domain join gives administrators the ability to preprovision computer
accounts in the domain to prepare operating systems for deployments. At
startup, computers can then join the domain without the need to contact a
domain controller. This helps reduce the time it takes to deploy computers in a
datacenter.

Let’s say your datacenter needs to have multiple virtual machines deployed.
This is where offline domain join can be useful. Upon initial startup after the
operating system is installed, offline domain join allows the virtual machines to
join the domain automatically. No additional steps or restarts are needed.

The following are some of the benefits of using offline domain join:
= There is no additional network traffic for Active Directory state changes.

= There is no additional network traffic for computer state changes to the
domain controller.

= Changes for both the Active Directory state and the computer state can be
completed at a different times.

Managing Object Properties

Once you’ve created the necessary Active Directory objects, you’ll probably
need to make changes to their default properties. In addition to the settings
you made when you were creating Active Directory objects, you can configure
several more properties. You can also access object properties by right-clicking
any object and selecting Properties from the pop-up menu.

Each object type contains a unique set of properties.

User Object Properties

The following list describes some of the properties of a User object (see Figure
2.7):
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Will Panek Properties ? X

Member Of Dial4n Environment Sessions
Remote control Remote Desktop Services Profile COM+
General ~ Address  Account  Profile  Telephones  Organization

ill Panek
First name: Wil Intials:
Last name: Panek
Display name: Wil Panek
Description: Instructor / Author
Office: Studio
Telephone number:  |480-800-0054  Other..
E-mail: Will.Panek @Stormwind .com
Web page: www _StomwindStudios com | Other...
OK Cancel | | Apply Help

FIGURE 2.7 User Properties

General General account information about this user
Address Physical location information about this user

Account User logon name and other account restrictions, such as workstation
restrictions and logon hours

Profile Information about the user’s roaming profile settings

Telephones Telephone contact information for the user

Hi va- Net wor k. Conr LaA
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Organization The user’s title, department, and company information
Member Of Group membership information for the user

Dial-In Remote Access Service (RAS) permissions for the user
Environment Logon and other network settings for the user

Sessions Session limits, including maximum session time and idle session
settings

Remote Control Remote control options for this user’s session

Remote Desktop Services Profile Information about the user’s profile for
use with Remote Desktop Services

Personal Virtual Desktop Allows you to assign a user a specific virtual
machine to use as a personal virtual desktop

COM + Specifies a COM+ partition set for the user

Computer Object Properties

Computer objects have different properties than User objects. Computer
objects refer to the systems that clients are operating to be part of a domain.
The following list describes some Computer object properties:

General Information about the name of the computer, the role of the
computer, and its description

(You can enable an option to allow the Local System account of this machine to
request services from other servers. This is useful if the machine is a trusted
and secure computer.)

Operating System The name, version, and service pack information for the
operating system running on the computer

Member Of Active Directory groups of which this Computer object is a
member

Delegation Allows you to set services that work on behalf of another user
Location A description of the computer’s physical location

Managed By Information about the User or Contact object that is responsible
for managing this computer

Dial-In Sets dial-in options for the computer

Setting Properties for Active Directory Objects

Now that you have seen the various properties that can be set for the Active
Directory objects, let’s complete an exercise on how to configure some of these
properties. Exercise 2.7 walks you through how to set various properties for
Active Directory objects. To complete the steps in this exercise, first you must
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have completed Exercise 2.5.

4 )

’% Although it may seem a bit tedious, it’s always a good idea to enter

as much information as you know about Active Directory objects when you
create them. Although the name Printer1 may be meaningful to you, users
will appreciate the additional information, such as location, when they are
searching for objects.

G J
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EXERCISE 2.7

Managing Object Properties

1. Open Active Directory Users and Computers by clicking Start >
Administrative Tools > Active Directory Users And Computers.

2. Expand the name of the domain and select the RD container. Right-
click the John Q. Adams user account and select Properties.

3. Here you will see the various Properties tabs for the User account.
Make some configuration changes based on your personal preferences.
Click OK to continue.

4. Select the HR OU. Right-click the All Users group and click Properties.
In the All Users Properties dialog box, you will be able to modify the
membership of the group.

Click the Members tab and then click Add. Add the Maria D.
President and John Q. Admin user accounts to the group. Click OK
to save the settings and then OK to accept the group modifications.

5. Select the Sales OU. Right-click the Workstation1 Computer object.
Notice that you can choose to disable the account or reset it (to allow
another computer to join the domain under that same name). From the
context menu, choose Properties. You'll see the properties for the
Computer object.

Examine the various options and make changes based on your
personal preference. After you have examined the available options,
click OK to continue.

6. Select the Corporate OU. Right-click the Maria D. President user
account and choose Reset Password. You will be prompted to enter a
new password, and then you’ll be asked to confirm it. Note that you can
also force the user to change this password upon the next logon, and
you can also unlock the user’s account from here. For this exercise, do
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not enter a new password; just click Cancel.

7. Close the Active Directory Users and Computers tool.

By now, you have probably noticed that Active Directory objects have a lot of
common options. For example, Group and Computer objects both have a
Managed By tab.

Windows Server 2016 allows you to manage many User objects at once. For
instance, you can select several User objects by holding down the Shift or Ctrl
key while selecting. You can then right-click any one of the selected objects and
select Properties to display the properties that are available for multiple users.
Notice that not every user property is available because some properties are
unique to each user. You can configure the Description field for multiple object
selections that include both users and nonusers, such as computers and
groups.

‘% An important thing to think about when it comes to accounts is

the difference between disabling an account and deleting an account.
When you delete an account, the security ID (SID) gets deleted. Even if you
later create an account with the same username, it will have a different SID
number, and therefore it will be a different account. It is sometimes better
to disable an account and place it into a nonactive OU called Disabled. This
way, if you ever need to reaccess the account, you can do so.

g /

Another object management task is the process of deprovisioning.
Deprovisioning is the management of Active Directory objects in the
container. When you remove an object from an Active Directory container, the
deprovisioning process removes the object and synchronizes the container to
stay current.

Understanding Groups

Now that you know how to create user accounts, it’s time to learn how to create
group accounts. As an instructor, I am always amazed when students (who
work in the IT field) have no idea why they should use groups. This is
something every organization should be using.

To illustrate their usefulness, let’s say you have a Sales department user by the
name of wpanek. Your organization has 100 resources shared on the network
for users to access. Because wpanek is part of the Sales department, he has
access to 50 of the resources. The Marketing department uses the other 50. If
the organization is not using groups and wpanek moves from Sales to
Marketing, how many changes do you have to make? The answer is 100. You
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have to move him out of the 50 resources he currently can use and place his
account into the 50 new resources that he now needs.

Now let’s say that you use groups. The Sales group has access to 50 resources,
and the Marketing group has access to the other 50. If wpanek moves from
Sales to Marketing, you need to make only two changes. You just have to take
wpanek out of the Sales group and place him in the Marketing group. Once this
is done, wpanek can access everything he needs to do his job.

Group Properties

Now that you understand why you should use groups, let’s go over setting up
groups and their properties (see Figure 2.8). When you are creating groups, it
helps to understand some of the options that you need to use.

New Object - Group X

—r

i‘;} Create in: StormWindAD.comfArizona

Group name:

|

Group name (pre-Windows 2000):

Group scope Group type
(O Domain local (®) Security
(@) Global (O Distribution
O Universal

Cancel

FIGURE 2.8 New Group dialog box

Group Type You can choose from two group types: security groups and
distribution groups.

Security Groups These groups can have rights and permissions placed on
them. For example, if you want to give a certain group of users access to a
particular printer, but you want to control what they are allowed to do with this
printer, you'd create a security group and then apply certain rights and
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permissions to this group.

Security groups can also receive emails. If someone sent an email to the group,
all users within that group would receive it (as long as they have a mail system
that allows for mail-enabled groups, like Exchange).

Distribution Groups These groups are used for email only (as long as they
have a mail system that allows for mail-enabled groups, like Exchange). You
cannot place permissions and rights for objects on this group type.

Group Scope When it comes to group scopes, you have three choices.

Domain Local Groups Domain local groups are groups that remain in the
domain in which they were created. You use these groups to grant permissions
within a single domain. For example, if you create a domain local group named
HPLaser, you cannot use that group in any other domain, and it has to reside
in the domain in which you created it.

Global Groups Global groups can contain other groups and accounts from
the domain in which the group is created. In addition, you can give them
permissions in any domain in the forest.

Universal Groups Universal groups can include other groups and accounts
from any domain in the domain tree or forest. You can give universal groups
permissions in any domain in the domain tree or forest.

Creating Group Strategies

When you are creating a group strategy, think of this acronym that Microsoft
likes to use in the exam: AGDLP (or AGLP). This acronym stands for a series of
actions you should perform. Here is how it expands:

A Accounts (Create your user accounts.)
G Global groups (Put user accounts into global groups.)
DL Domain local groups (Put global groups into domain local groups.)

P Permissions (Assign permissions such as Deny or Apply on the domain local
group.)

Another acronym that stands for a strategy you can use is AGUDLP (or AULP).
Here is how it expands:

A Accounts (Create your user accounts.)

G Global groups (Put user accounts into global groups.)

U Universal groups (Put the global groups into universal groups.)

DL Domain local groups (Put universal groups into domain local groups.)

P Permissions (Place permissions on the local group.)
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Creating a Group

To create a new group, open the Active Directory Users and Computers snap-
in. Click the OU where the group is going to reside. Right-click and choose New
and then Group. After you create the group, just click the Members tab and
choose Add. Add the users you want to reside in that group, and that’s all there
is to it.

Filtering and Advanced Active Directory Features

The Active Directory Users and Computers tool has a couple of other features
that come in quite handy when you are managing many objects. You can access
the Filter Options dialog box by clicking the View menu in the MMC and
choosing Filter Options. You'll see a dialog box similar to the one shown in
Figure 2.9. Here you can choose to filter objects by their specific types within
the display. For example, if you are an administrator who works primarily with
user accounts and groups, you can select those specific items by placing check
marks in the list. In addition, you can create more complex filters by choosing
Create Custom. Doing so provides you with an interface that looks similar to
that of the Find command.

Filter Options ? X

Filtering
() Show all types of objects
@ Show only the following types of objects:!
-[ |Users ~
["lGroups
[ ]Contacts
| |Computers

[ |Printers
[IShared Folders >

() Create custom filter: Customize...

Maximum number of items displayed per folder: 2000

OK Cancel

FIGURE 2.9 The Filter Options dialog box
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Another option in the Active Directory Users and Computers tool is to view
advanced options. You can enable the advanced options by choosing Advanced
Features in the View menu. This adds some top-level folders to the list under

the name of the domain. Let’s take a look at a couple of the new top-level
folders.

The system folder (shown in Figure 2.10) provides additional features that you
can configure to work with Active Directory. You can configure settings for the
Distributed File System (DFS), IP Security (IPSec) policies, the File Replication
Service (FRS), and more. In addition to the system folder, you’ll see the
LostAndFound folder. This folder contains any files that may not have been
replicated properly between domain controllers. You should check this folder
periodically for any files so that you can decide whether you need to move
them or copy them to other locations.

. Active Directory Users and Computers
File Action View Help
oo (] = 7 i — . -, . —
@ b M| & O ﬁ _‘I 9 = E Ledil ?_:. 3 ETESR
ﬁ.ctwe Directory Users and Com | Mame Type Description
Saved Queries | "] AdminSDHo... Container
v Ej StormWindAD.com 1 BCKUPKEY -
g ‘ g
- B“.I: - BCKUPKEY ... secret
. Builtin S
: BCKUPKEY ... secret
| Computers

: | BCKUPKEY ... secret
Domain Controllers e 7
Hodda | | ComPartitions Container

4 i L
i d 1

Fcreigniuurit}rPrincipar:: e ComPartitio... Container

| Keys 5 L-fiDefault Dom... Domain Policy
" LostAndFound | Dfs-Configu... dfsConfigurati...
| Managed Service Accout | | DFSR-Global... msDFSR-Globa...
=" North America | "] DomainUpd... Container
" Program Data | LY File Replicati... FRS Settings
~ System | ] FileLinks fileLinkTracking
| Users | 171 1P Security  Container
~ NTDS Quotas | T Meetings Container
. TPM Devices 1 MicroseftDNS Container
| Password Se... msDS-Passwor...
| Policies Container
L PSPs msimaging-PS...

I RAS and 1AS ... Container
| RID ManagerS riDManager
“» RpcServices  RPC Services
| Server samServer
| L WinsockServ... Container
I WMIPolicy  Container

FIGURE 2.10 Advanced Features in the system folder of the Active Directory
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Users and Computers tool

As you can see, managing Active Directory objects is generally a simple task.
The Active Directory Users and Computers tool allows you to configure several
objects. Let’s move on to look at one more common administration function:
moving objects.

Moving, Renaming, and Deleting Active Directory Objects

One of the extremely useful features of the Active Directory Users and
Computers tool is its ability to move users and resources easily.

Exercise 2.8 walks you through the process of moving Active Directory objects.
In this exercise, you will make several changes to the organization of Active
Directory objects. To complete this exercise, first you must have completed
Exercise 2.5.

( )\

EXERCISE 2.8

Moving Active Directory Objects

1. Open Active Directory Users and Computers by clicking Start >
Administrative Tools > Active Directory Users And Computers.

2. Expand the name of the domain.

3. Select the Sales OU (under the New York OU), right-click Workstation1,
and select Move. A dialog box appears. Select the RD OU and click OK
to move the Computer object to that container.

4. Click the RD OU and verify that Workstation1 was moved.
5. Close the Active Directory Users and Computers tool.

g J

In addition to moving objects within Active Directory, you can easily rename
them by right-clicking an object and selecting Rename. Note that this option
does not apply to all objects. You can remove objects from Active Directory by
right-clicking them and choosing Delete.

( )

’% Deleting an Active Directory object is an irreversible action. When

an object is destroyed, any security permissions or other settings made for
that object are removed as well. Because each object within Active
Directory contains its own security identifier (SID), simply re-creating an
object with the same name does not place any permissions on it. Before
you delete an Active Directory object, be sure that you will never need it
again. Windows Server 2016 has an Active Directory Recycle Bin to allow
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an administrator to retrieve a deleted object, but in case the Recycle Bin
gets cleared, it’s better to be safe than sorry. Also, the AD Recycle Bin is
disabled by default, so it will be unavailable unless you turn that feature
on. So, what is the moral of this story? Don’t delete AD objects unless you
are absolutely sure you want them gone.

(& J/
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‘% ‘Windows Server 2016 has a check box called Protect Container

From Accidental Deletion for all OUs. If this check box is checked, to delete
or move an OU, you must go into the Active Directory Users and
Computers advanced options. Once you are in the advanced options, you
can uncheck the box to move or delete the OU .

(& J

Resetting an Existing Computer Account

Every computer on the domain establishes a discrete channel of
communication with the domain controller at logon time. The domain
controller stores a randomly selected password (different from the user
password) for authentication across the channel. The password is updated
every 30 days.

Sometimes the computer’s password and the domain controller’s password
don’t match, and communication between the two machines fails. Without the
ability to reset the computer account, you wouldn’t be able to connect the
machine to the domain. Fortunately, you can use the Active Directory Users
and Computers tool to reestablish the connection.

Exercise 2.9 shows you how to reset an existing computer account. You should
have completed the previous exercises in this chapter before you begin this
exercise.

( A

EXERCISE 2.9

Resetting an Existing Computer Account

1. Open Active Directory Users and Computers by clicking Start >
Administrative Tools > Active Directory Users And Computers.

2. Expand the name of the domain.

3. Click the RD OU and then right-click the Workstation1 computer
account.

4. Select Reset Account from the context menu. Click Yes to confirm your
selection. Click OK at the success prompt.
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5. When you reset the account, you break the connection between the
computer and the domain. So, after performing this exercise, reconnect
the computer to the domain if you want it to continue working on the
network.

(& J/

Throughout this book, I have tried to show you the PowerShell way of doing a
task shown previously using an MMC snap-in. Well, this is going to be no
different.

This example shows you how to reset the secure connection between the local
computer and the domain to which it is joined using a PowerShell command.
In this example, the domain controller that performs the operation is specified
as StormbdC1.StormwindAD.com. To execute this PowerShell command, you must
run this command on the local computer:

Test-ComputerSecureChannel -Repair -Server StormDC1.StormwWindAD.com

Understanding Dynamic Access Control

One of the advantages of Windows Server 2016 is the ability to apply data
governance to your file server. This will help control who has access to
information and auditing. You get these advantages through the use of
Dynamic Access Control (DAC). Dynamic Access Control allows you to identify
data by using data classifications (both automatic and manual) and then
control access to these files based on these classifications.

DAC also gives administrators the ability to control file access by using a
central access policy. This central access policy will also allow an administrator
to set up audit access to files for reporting and forensic investigation.

DAC allows an administrator to set up Active Directory Rights Management
Service encryption for Microsoft Office documents. For example, you can set
up encryption for any documents that contain financial information.

Dynamic Access Control gives an administrator the flexibility to configure file
access and auditing to domain-based file servers. To do this, DAC controls
claims in the authentication token, resource properties, and conditional
expressions within permission and auditing entries.

Administrators have the ability to give users access to files and folders based
on Active Directory attributes. For example, a user named Dana is given access
to the file server share because in the user’s Active Directory (department
attribute) properties, the value contains the value Sales.

‘% For DAC to function properly, an administrator must enable

Windows 7/8/10 computers and Windows Server 2012/2012 R2/2016 file
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{servers to support claims and compound authentication. J

Managing Security and Permissions

Now that you understand the basic issues, terms, and Active Directory objects
that pertain to security, it’s time to look at how you can apply this information
to secure your network resources. The general practice for managing security is
to assign users to groups and then grant permissions and logon parameters to
the groups so that they can access certain resources.

For management ease and to implement a hierarchical structure, you can place
groups within OUs. You can also assign Group Policy settings to all of the
objects contained within an OU. By using this method, you can combine the
benefits of a hierarchical structure (through OUs) with the use of security
principals.

The primary tool you use to manage security permissions for users, groups,
and computers is the Active Directory Users and Computers tool. Using this
tool, you can create and manage Active Directory objects and organize them
based on your business needs. Common tasks for many system administrators
might include the following:

= Resetting a user’s password (for example, in cases where they forget their
password)

= Creating new user accounts (when, for instance, a new employee joins the
company)

= Modifying group memberships based on changes in job requirements and
functions

= Disabling user accounts (when, for example, users will be out of the office
for long periods of time and will not require network resource access)

Once you’ve properly grouped your users, you need to set the actual
permissions that affect the objects within Active Directory. The actual
permissions that are available vary based on the type of object. Table 2.1
provides an example of some of the permissions that you can apply to various
Active Directory objects and an explanation of what each permission does.

TABLE 2.1 Permissions of Active Directory objects

Permission Explanation

Control Access Changes security permissions on the object
Create Child Creates objects within an OU (such as other OUs)
Delete Child  Deletes child objects within an OU

Delete Tree  Deletes an OU and the objects within it
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List Contents Views objects within an OU

List Object Views a list of the objects within an OU

Read Views properties of an object (such as a username)
Write Modifies properties of an object

Using ACLs and ACEs

Each object in Active Directory has an access control list. The ACL is a list of
user accounts and groups that are allowed to access the resource. For each
ACL, there is an access control entry that defines what a user or a group can
actually do with the resource. Deny permissions are always listed first. This
means that if users have Deny permissions through user or group membership,
they will not be allowed to access the object, even if they have explicit Allow
permissions through other user or group permissions.

( N\

ﬁ_p Real World Scenario
Using Groups Effectively

You are a new system administrator for a medium-sized organization, and
your network spans a single campus environment. The previous
administrator had migrated the network from Windows Server 2008 to
Windows Server 2016 and everyone seems fine with the network and new
workstations. As you familiarize yourself with the network, you realize that
the previous administrator applied a very ad hoc approach. Many of the
permissions to resources had been given to individual accounts on request.
It seems that there was no particular strategy with regard to
administration.

Management tells you that the company has acquired another company,
ideally the first of several acquisitions. They tell you about these plans
because they do not want any hiccups in the information system as
necessary changes ensue.

You immediately realize that management practices of the past must be
replaced with the best practices that have been developed for networks
over the years. One of the fundamental practices that you need to establish
for this environment is the use of groups to apply permissions and give
privileges to users throughout the network.

It is quite simple to give permissions individually, and in some cases, it
seems like overkill to create a group, give permissions to the group, and
then add a user to the group. Using group-based permissions really pays
off in the long run, however, regardless of how small your network is today.

One constant in the networking world is that networks grow. When they
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grow, it is much easier to add users to a well-thought-out system of groups
and consistently applied policies and permissions than it is to patch these
elements together for each individual user.

Don’t get caught up in the “easy” way of dealing with each request as it
comes down the pike. Take the time to figure out how the system will
benefit from a more structured approach. Visualize your network as
already large with numerous accounts, even if it is still small; this way,
when it grows, you will be well positioned to manage the network as
smoothly as possible.

G J/

Using Group Policy for Security

A very useful and powerful feature of Active Directory is a technology known as
a Group Policy. Through the use of Group Policy settings, system
administrators can assign thousands of different settings and options for users,
groups, and OUs. Specifically, in relation to security, you can use many
different options to control how important features such as password policies,
user rights, and account lockout settings can be configured.

The general process for making these settings is to create a Group Policy object
(GPO)with the settings you want and then link it to an OU or other Active
Directory object.

Table 2.2 lists many Group Policy settings that are relevant to creating a secure
Active Directory environment. Note that this list is not comprehensive—many
other options are available through Windows Server 2016’s administrative
tools.

TABLE 2.2 Group Policy settings used for security purposes

Setting Setting Purpose

section name

Account Enforce Specifies how many passwords will be remembered.
Policies Password This option prevents users from reusing the same
> History passwords whenever they’re changed.

Password

Policy

Account Minimum Prevents users from using short, weak passwords by
Policies Password specifying the minimum number of characters that
> Length the password must include.

Password

Policy

Account Account Specifies how many bad password attempts can be

Policies Lockout entered before the account gets locked out.
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>
Account
Lockout
Policy

Account
Policies
>
Account
Lockout
Policy

Account
Policies
>
Account
Lockout
Policy

Local
Policies
>
Security
Options

Local
Policies
>
Security
Options

Local
Policies
>
Security
Options

Local

Policies
>

Security
Options

Threshold

Account
Lockout
Duration

Reset
Account
Lockout

Counter After

Accounts:

Rename

Administrator

Account

Domain

Controller:
Allow Server
Operators To

Schedule
Tasks

Interactive
Logon: Do
Not Display
Last User

Name

Shutdown:
Allow System
To Be Shut

Down
Without

Having To

Log On

Specifies how long an account will remain locked out
after too many bad password attempts have been
entered. By setting this option to a reasonable value
(such as 30 minutes), you can reduce administrative
overhead while still maintaining fairly strong
security.

Specifies how long the Account Lockout Threshold
counter will hold failed logon attempts before
resetting to o.

Often, when trying to gain unauthorized access to a
computer, individuals attempt to guess the
administrator password. One method for increasing
security is to rename this account so that no
password allows entry using this logon.

This option specifies whether members of the built-
in Server Operators group are allowed to schedule
tasks on the server.

Increases security by not displaying the name of the
last user who logged on to the system.

Allows system administrators to perform remote
shutdown operations without logging on to the
server.

You can use several different methods to configure Group Policy settings using
the tools included with Windows Server 2016. Exercise 2.10 walks through the
steps required to create a basic group policy for the purpose of enforcing
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security settings. To complete the steps of this exercise, you must have
completed Exercise 2.1.

( N\

EXERCISE 2.10

Applying Security Policies by Using Group Policy

1. Open the Group Policy Management Console tool.
2. Expand Domains and then click the domain name.

3. In the right pane, right-click the Default Domain Policy and choose
Edit.

4. In the Group Policy Management Editor window, expand Computer
Configuration > Policies > Windows Settings > Security Settings >
Account Policies > Password Policy.

5. In the right pane, double-click the Minimum Password Length setting.

6. In the Security Policy Setting dialog box, make sure the box labeled
Define This Policy Setting Option is checked. Increase the Password
Must Be At Least value to eight characters.

7. Click OK to return to the Group Policy Management Editor window.

8. Expand User Configuration > Policies > Administrative Templates >
Control Panel. Double-click Prohibit Access To The Control Panel And
PC settings, select Enabled, and then click OK.

9. Close the Group Policy window.

Fine-Grained Password Policies

The Windows 2016 operating systems allow an organization to have different
password and account lockout policies for different sets of users in a domain.
In versions of Active Directory before 2008, an administrator could set up only
one password policy and account lockout policy per domain.

The Default Domain policy for the domain is where these policy settings were
configured. Because domains could have only one password and account
lockout policy, organizations that wanted multiple password and account
lockout settings had to either create a password filter or deploy multiple
domains.

Fine-grained password policies allow you to specify multiple password policies
within a single domain. Let’s say you want administrators not to have to
change their password as frequently as salespeople. Fine-grained password
policies allow you to do just that.

Password Settings objects (PSOs) are created so that you can create fine-
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grained password policies. You create PSOs using the ADSI editor and then
you can use those PSOs to create your fine-grained password policies.

Exercise 2.11 walks through the creation of a custom password policy using the
ADSI Edit tool, and then you will link that policy to a group using Active
Directory Users and Computers. Before completing this exercise, create a new
global group named Passgroup in Active Directory Users and Computers.

’% Administrators also have the ability to create fine-grained

password policies using the Active Directory Administrative Center. I will
show you how to create a new password policy in the section “Using the
Active Directory Administrative Center” later in this chapter.

g /

( N\

EXERCISE 2.11

Fine-Grained Password Policy

1. Open ADSI Edit by pressing the Windows key and choosing ADSI Edit.
2. Right-click ADSI Edit and then choose Connect To.

3. When the Connection Settings dialog box appears, click OK.

4

. In the window on the left, expand Default Naming Context >
DC=yourdomainname,DC=com > CN=System > CN=Password
Settings Container.

5. Right-click CN=Password Settings Container and choose New >
Object.

6. In the Select A Class box, choose msDS-PasswordSettings and click
Next.

7. At the Common Name screen, type CustomPolicy and click Next.

8. At the Password Settings Precedence screen, enter 10 as the value. This
works as a cost value. The lowest priority takes precedence.

9. At the Password Reversible Encryption Status For Users Accounts
screen, set the value to False (recommended by Microsoft).

10. The Password History Length screen shows how many passwords are
remembered before a password can be used again. You can set this for
up to 1,024 remembered passwords. Set the value to 12. Click Next.

11. At the Password Complexity screen, set the value to True.

Hi va- Net wor k. Corr 2
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The next screen will be the Minimum Password Length screen. Set the
value to 8 and click Next.

At the Minimum Password Age screen, you must enter a value for the
amount of time you want the password to be used at a minimum. Time
is done in the I8 format, like so:

—600000000 = 1 minute
—36000000000 = 1 hour
—864000000000 = 1 day

Enter —-8640000000000 (10 zeros) as your value for 10 days and
click Next. You must put the — (minus) sign in the front of the value.

At the Maximum Password Age screen, set the value as —
51840000000000 (10 zeros). This value equals 60 days. Click Next.

At the Lockout Threshold screen, enter 3 and click Next.

At the Observation Window screen, enter —3000000000 (5 minutes)
and click Next.

At the Lockout Duration screen, enter —18000000000 (30 minutes)
and click Next.

Click Finished. If you received any errors, check all of your times to be
sure the — (minus) sign appears in front of the number.

Close ADSI Edit.
Open the Active Directory Users and Computers snap-in.

On the View menu along the top, make sure Advanced Features is
checked.

In the window on the left, expand Active Directory Users And
Computers > yourdomain > System > Password Settings Container.

In the details pane on the right side, right-click CustomPolicy and
choose Properties.

Click the Attribute Editor tab.
Scroll down and select the msps-pPsoAppliesTo attribute. Click Edit.

In the Multi-valued Distinguished Name dialog box, click Add Windows
Account.

Type in Passgroup (this is the group you created before the exercise)
and click the Check Name button. Click OK.

Click OK twice more, and then you are finished. Close the Active
Directory Users and Computers snap-in.
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Publishing Active Directory Objects

One of the main goals of Active Directory is to make resources easy to find.
Two of the most commonly used resources in a networked environment are
server file shares and printers. These are so common, in fact, that most
organizations have dedicated file and print servers. When it comes to
managing these types of resources, Active Directory makes it easy to determine
which files and printers are available to users.

With that being said, take a look at how Active Directory manages to publish
shared folders and printers.

Making Active Directory Objects Available to Users

An important aspect of managing Active Directory objects is that a system
administrator can control which objects users can see. The act of making an
Active Directory object available is known as publishing. The two main types of
publishable objects are Printer objects and Shared Folder objects.

The general process for creating server shares and shared printers has
remained unchanged from previous versions of Windows: you create the
various objects (a printer or a file system folder) and then enable them for
sharing. To make these resources available via Active Directory, however,
there’s an additional step: you must publish the resources. Once an object has
been published in Active Directory, clients will be able to use it.

When you publish objects in Active Directory, you should know the server
name and share name of the resource. When system administrators use Active
Directory objects, they can change the resource to which the object points,
without having to reconfigure or even notify clients. For example, if you move a
share from one server to another, all you need to do is to update the Shared
Folder object’s properties to point to the new location. Active Directory clients
still refer to the resource with the same path and name that they used before.

Publishing Printers

Printers can be published easily within Active Directory. This makes them
available to users in your domain.

Exercise 2.12 walks you through the steps you need to take to share and
publish a Printer object by having you create and share a printer. To complete
the printer installation, you need access to the Windows Server 2016
installation media (via the hard disk, a network share, or the DVD drive).

( N

EXERCISE 2.12

Creating and Publishing a Printer
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10.

11.

Click the Windows key on the keyboard and choose Control Panel.

. Click Devices And Printers > Add A Printer. This starts the Add Printer

Wizard. Then click the Next button.

In the Choose A Local Or Network Printer page, select Add A Local
Printer. This should automatically take you to the next page. If it does
not, click Next.

On the Choose A Printer Port page, select Use An Existing Port. From
the drop-down list beside that option, make sure LPT1: (Printer Port) is
selected. Click Next.

On the Install The Printer Driver page, select Generic for the
manufacturer. For the printer, highlight Generic/Text Only. Click Next.

On the Type A Printer Name page, type Text Printer. Uncheck the Set
As The Default Printer box and then click Next.

The Installing Printer screen appears. After the system is finished, the
Printer Sharing page appears. Make sure the box labeled “Share this
printer so that others on your network can find and use it” is selected,
and accept the default share name of Text Printer.

In the Location section, type Building 203, and in the Comment
section, add the following comment: This is a text-only Printer.
Click Next.

. On the You've Successfully Added Text Printer page, click Finish.

Next you need to verify that the printer will be listed in Active
Directory. Right-click the Text Printer icon and select Printer
Properties.

Select the Sharing tab and make sure that the List In The Directory box
is checked. Note that you can also add additional printer drivers for
other operating systems using this tab. Click OK to accept the settings.

/

Note that when you create and share a printer this way, an Active Directory
Printer object is not displayed within the Active Directory Users and

Computers tool. The printer is actually associated with the Computer object to
which it is connected.

Publishing Shared Folders

Now that you've created and published a printer, you’ll see how the same thing
can be done to shared folders.

Exercise 2.13 walks through the steps required to create a folder, share it, and
then publish it in Active Directory. This exercise assumes you are using the c:

partition; however, you may want to change this based on your server
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configuration. This exercise assumes you have completed Exercise 2.5.

( N

EXERCISE 2.13

Creating and Publishing a Shared Folder

1. Create a new folder in the root directory of your c: partition and name
it Test share. To do this, click the File Explorer link on the toolbar.

2. Right-click the Test share folder. Choose Share With > Specific
People.

3. In the File Sharing dialog box, enter the names of users with whom you
want to share this folder. In the upper box, enter Everyone and then
click Add. Note that Everyone appears in the lower box. Click in the
Permission Level column next to Everyone and choose Read/Write
from the pop-up menu. Then click Share.

4. You’ll see a message that your folder has been shared. Click Done.

5. Click the Windows key on the keyboard and choose Administrative
Tools.

6. Open the Active Directory Users and Computers tool. Expand the
current domain and right-click the RD OU. Select New > Shared
Folder.

7. In the New Object - Shared Folder dialog box, type Shared Folder
Test for the name of the folder. Then type the UNC path to the share
(for example, \\serveri1\Test Share). Click OK to create the share.

(. J

Once you have created and published the Shared Folder object, clients can use
the My Network Places icon to find it. The Shared Folder object will be
organized based on the OU in which you created it. When you use publication,
you can see how this makes it easy to manage shared folders.

Querying Active Directory

So far you've created several Active Directory resources. One of the main
benefits of having all of your resource information in Active Directory is that
you can easily find what you’re looking for using the Find dialog box. Recall
that I reccommended that you always enter as much information as possible
when creating Active Directory objects. This is where that extra effort begins to
pay off.

Exercise 2.14 walks you through the steps to find specific objects in Active
Directory. To complete this exercise, you must have completed Exercise 2.5.

EXERCISE 2.14 w

Hi va- Net wor k. Corr 2
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Finding Objects in Active Directory

1. Open Active Directory Users and Computers by clicking Start >
Administrative Tools > Active Directory Users And Computers.

2. Right-click the name of the domain and select Find.

3. In the Find Users, Contacts, And Groups dialog box, select Users,
Contacts, And Groups from the Find drop-down list. For the In setting,
choose Entire Directory. This searches the entire Active Directory
environment for the criteria you enter.

Note that if this is a production domain and there are many objects,
searching the whole directory may be a time-consuming and
network-intensive operation.

4. In the Name field, type admin and then click Find Now to obtain the
results of the search.

5. Now that you have found several results, you can narrow down the list.
Click the Advanced tab of the Find Users, Contacts, And Groups dialog
box.

In the Field drop-down list, select User > Last Name. For
Condition, select Starts With, and for Value, type admin. Click Add
to add this condition to the search criteria. Click Find Now. Now
only the users that have the last name Admin are shown.

6. When you have finished searching, close the Find Users, Contacts, And
Groups dialog box and exit the Active Directory Users and Computers
tool.

g J

Using the many options available in the Find dialog box, you can usually
narrow down the objects for which you are searching quickly and efficiently.
Users and system administrators alike find this tool useful in environments of
any size. Now that you have seen how to create objects in Active Directory, let’s
take a look at a new Windows Server 2016 feature called Active Directory
Administrative Center.

Using the Active Directory Administrative Center

Windows Server 2016 has a feature called the Active Directory Administrative
Center. This feature allows you to manage many Active Directory tasks from
one central location (see Figure 2.11).
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FIGURE 2.11 Administrative Center Overview screen

Using the Active Directory Administrative Center, here are some of the tasks
that an administrator can perform:

Reset passwords

Create new objects

Delete objects

Move objects

Perform global searches

Configure properties for Active Directory objects

In Windows Server 2016, the Active Directory Administrative Center is just
another tool in your Active Directory tool belt. It does not matter which way
you create your Active Directory objects as long as you have a good
understanding of how to create them.

One of the easy tasks that you can complete with the Active Directory
Administrative center is the ability to create a Fine-Grained Password Policy.

Exercise 2.15 walks you through the steps to create a password policy for the IT
Department. To complete this exercise, you must have a Global Security group

called IT. If you do not have a group called IT, please create the IT group using

Active Directory Users and Computers.
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EXERCISE 2.15

Creating a PSO Using the Active Directory Administrative Center

1. Open the Active Directory Administrative Center by clicking Start >
Administrative Tools > Active Directory Administrative Center.

2. Expand the domain, expand System, and then click Password Settings
Container (see Figure 2.12).

3. In the right-hand side under Tasks, choose New > Password Settings
(see Figure 2.13).

4. When the Password Settings dialog box appears, fill in the following
settings (see Figure 2.14):
m Name: ITpso
= Precedence: 10
= Enforce Minimum Password Length: checked
= Minimum Password Length (characters): 8
= Enforce Password History: checked
= Number Of Passwords Remembered: 24
= Password Must Meet Complexity Requirements: checked
= Protect From Accidental Deletion: checked
= Enforce Minimum Password Age: checked
= User Cannot Change The Password Within: 1 (for 1 day)
= Enforce Maximum Password Age: checked
= User Must Change The Password After: 60 (for 60 days)
= Enforce Account Lockout Policy: checked
= Number Of Failed Logon Attempts Allowed: 5
» Reset Failed Logon Attempts Count After (min): 30

= Account Will Be Locked Out : Until An Administrator Manually
Unlocks The Account

= Protect From Accidental Deletion: checked
» Description: IT Department Password Policy
5. Click the Add button.

6. Type in IT and click the Check Names button (see Figure 2.15). Then
click OK.
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7. Click OK to complete the PSO. Close the Active Directory
Administrative Center.
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Using the Command Prompt for Active Directory
Configuration

Many IT administrators like to use command-line commands to configure and
maintain their Active Directory environment. One advantage of using

command-line commands is the ability to do multiple changes at once using
batch files.

Another advantage of knowing how to manipulate Active Directory using the
command prompt is working with Windows Server 2016 Server Core. Server
Core is an installation of Windows Server 2016 that has no GUI windows. One
of the ways to configure Server Core is to use commands in the command
prompt window.

Table 2.3 shows you many of the command prompt commands and explains
how each command affects Active Directory.

TABLE 2.3 Command prompt commands

Command Explanation

Csvde This command allows you to import and export data from Active
Directory. The data gets stored in a comma-separated value
(CSV) format.

Dcdiag This troubleshooting command checks the state of your domain
controllers in your forest and sends back a report of any
problems.

Djoin This command allows a computer account to join a domain, and
it runs an offline domain join when a computer restarts.
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Dsacls

Dsadd

Dsamain

Dsdbutil

Dsget

Dsmgmt

Dsmod

Dsmove

Dsquery
Dsrm

Ldifde

Ntdsutil

Repadmin

This command allows you to see and change permissions in the

access control list for objects in Active Directory Domain Services
(AD DS).

This command allows you to add an object to the AD DS
directory.

This command shows the Active Directory data stored in either a
snapshot or a backup as if it were in a Lightweight Directory
Access Protocol (LDAP) server.

This command provides database utilities for Active Directory
Lightweight Directory Services (AD LDS).

This command shows the properties of an object in the AD DS
directory.

This command gives an administrator management utilities for
AD LDS.

This command allows you to modify an AD DS object.

This command allows you to move an object in an Active
Directory domain from its current OU to a new OU within the
same forest.

This command allows you to query AD DS.
This command removes an object from the AD DS directory.

This command allows you to import and export data from Active
Directory. The data is stored as LDAP Data Interchange Format
(LDIF).

This is one of the most important commands for Active
Directory. It allows you to do maintenance on the Active
Directory database.

This command allows administrators to diagnose Active
Directory replication problems between domain controllers.

PowerShell for Active Directory

Table 2.4 will show you just some of the available PowerShell commands for
maintaining Active Directory. These PowerShell commands can help you do
everything from unlocking disabled accounts to doing password resets.

Vs

-

‘% To see a complete list of PowerShell commands for Active

Directory, please visit Microsoft’s website at:
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https://technet.microsoft.com/en-us/library/ee617195.aspx
TABLE 2.4 PowerShell commands for Active Directory

Command Explanation

Add- This command allows an administrator to add
ADComputerServiceAccount  geryice accounts to Active Directory.
Add-ADGroupMember This command allows you to add users to an

Active Directory group.

Disable-ADAccount Administrators can use this command to
disable an Active Directory account.

Enable-ADAccount Administrators can use this command to enable
an Active Directory account.

Get-ADComputer This command allows you to view one or more
Active Directory computers.

Get-ADDomain Administrators can use this command to view
an Active Directory domain.

Get- This command allows you to view the
ADFineGrainedPasswordPolicy Active Directory fine-grained password policies.

Get-ADGroup Administrators can use this command to view
Active Directory groups.

Get-ADGroupMember This command allows you to view the users in
an Active Directory group.

Get-ADServiceAccount Administrators can use this command to view
the Active Directory service accounts.

Get-ADUser This command allows you to view one or more
Active Directory users.

New-ADComputer Administrators can use this command to create
a new Active Directory computer.

New-ADGroup Administrators can use this command to create
a new Active Directory group.

New-ADServiceAccount This command is the only way that you can
create a new Managed Service Account.

New-ADUser Administrators can use this command to create
a new Active Directory user.

Set-ADAccountPassword This command allows you to modify the
password of an Active Directory account.

Unlock-ADAccount Administrators can use this command to unlock
an Active Directory account.

Hi va- Net wor k. Corr 2
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Summary

This chapter covered the fundamentals of administering Active Directory. The
most important part of administering Active Directory is learning about how to
work with OUs. Therefore, you should be aware of the purpose of OUs; that is,
they help you to organize and manage the directory. For instance, think of
administrative control. If you wanted to delegate rights to another
administrator (such as a sales manager), you could delegate that authority to
that user within the Sales OU. As the system administrator, you would retain
the rights to the castle.

You also looked at how to design an OU structure from an example. The
example showed you how to design a proper OU layout. You can also create,
organize, and reorganize OUs if need be.

In addition, you took a look at groups and group strategies. There are different
types of groups (domain local, global, and universal groups), and you should
know when each group is available and when to use each group.

Finally, this chapter covered how to use the Active Directory Users and
Computers tool to manage Active Directory objects. If you're responsible for
day-to-day system administration, there’s a good chance that you are already
familiar with this tool; if not, you should be after reading this chapter. Using
this tool, you learned how to work with Active Directory objects such as User,
Computer, and Group objects.

Exam Essentials

Understand the purpose of OUs. OUs are used to create a hierarchical,
logical organization for objects within an Active Directory domain.

Know the types of objects that can reside within OUs. OUs can contain
Active Directory User, Computer, Shared Folder, and other objects.

Understand how to use the Delegation of Control Wizard. The
Delegation of Control Wizard is used to assign specific permissions at the level
of OUs.

Understand the concept of inheritance. By default, child OUs inherit
permissions and Group Policy assignments set for parent OUs. However, these
settings can be overridden for more granular control of security.

Know groups and group strategies. You can use three groups: domain
local, global, and universal. Understand the group strategies and when they

apply.
Understand how Active Directory objects work. Active Directory

objects represent some piece of information about components within a
domain. The objects themselves have attributes that describe details about
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them.

Understand how Active Directory objects can be organized. By using
the Active Directory Users and Computers tool, you can create, move, rename,
and delete various objects.

Understand how to import bulk users. You can import multiple accounts
by doing a bulk import. Bulk imports use files to import the data into Active
Directory. Know the two utilities (1difde.exe and csvde.exe) you need to
perform the bulk imports and how to use them.

Learn how resources can be published. A design goal for Active
Directory was to make network resources easier for users to find. With that in
mind, you should understand how using published printers and shared folders
can simplify network resource management.

Review Questions

You can find the answers in the Appendix.

1. You are the administrator of an organization with a single Active Directory
domain. A user who left the company returns after 16 weeks. The user tries
to log on to their old computer and receives an error stating that
authentication has failed. The user’s account has been enabled. You need to

ensure that the user is able to log on to the domain using that computer.
What do you do?

A. Reset the computer account in Active Directory. Disjoin the computer
from the domain, and then rejoin the computer to the domain.

B. Run the Abadd command to rejoin the computer account.

C. Run the MMC utility on the user’s computer, and add the Domain
Computers snap-in.

D. Re-create the user account and reconnect the user account to the
computer account.

2. You are the administrator of an organization with a single Active Directory
domain. One of your senior executives tries to log on to a machine and
receives the error “This user account has expired. Ask your administrator to
reactivate your account.” You need to make sure that this doesn’t happen
again to this user. What do you do?

A. Configure the domain policy to disable account lockouts.

B. Configure the password policy to extend the maximum password age to
0.

C. Modify the user’s properties to set the Account Never Expires setting.
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D. Modify the user’s properties to extend the maximum password age to 0.

. You need to create a new user account using the command prompt. Which
command would you use?

A. dsmodify
B. dscreate
C. dsnew
D. dsadd

. Maria is a user who belongs to the Sales distribution global group. She is
not able to access the laser printer that is shared on the network. The Sales
global group has full access to the laser printer. How do you fix the
problem?

A. Change the group type to a security group.

B. Add the Sales global group to the Administrators group.

C. Add the Sales global group to the Printer Operators group.
D. Change the Sales group to a local group.

. You are a domain administrator for a large domain. Recently, you have
been asked to make changes to some of the permissions related to OUs
within the domain. To restrict security for the Texas OU further, you
remove some permissions at that level. Later, a junior system administrator
mentions that she is no longer able to make changes to objects within the
Austin OU (which is located within the Texas OU). Assuming that no other
changes have been made to Active Directory permissions, which of the
following characteristics of OUs might have caused the change in
permissions?

A. Inheritance

B. Group Policy

C. Delegation

D. Object properties

. Isabel, a system administrator, created a new Active Directory domain in an
environment that already contains two trees. During the promotion of the
domain controller, she chose to create a new Active Directory forest. Isabel
is a member of the Enterprise Administrators group and has full
permissions over all domains. During the organization’s migration to Active
Directory, many updates were made to the information stored within the
domains. Recently, users and other system administrators have complained
about not being able to find specific Active Directory objects in one or more
domains (although the objects exist in others). To investigate the problem,
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Isabel wants to check for any objects that have not been properly replicated
among domain controllers. If possible, she would like to restore these
objects to their proper place within the relevant Active Directory domains.

Which two of the following actions should she perform to be able to view
the relevant information? (Choose two.)

A. Change Active Directory permissions to allow object information to be
viewed in all domains.

Select the Advanced Features item in the View menu.
Promote a member server in each domain to a domain controller.

Rebuild all domain controllers from the latest backups.

m Y 0w

Examine the contents of the LostAndFound folder using the Active
Directory Users and Computers tool.

7. You are a consultant hired to evaluate an organization’s Active Directory
domain. The domain contains more than 200,000 objects and hundreds of
OUs. You begin examining the objects within the domain, but you find that
the loading of the contents of specific OUs takes a long time. Furthermore,
the list of objects can be large. You want to do the following:

= Use the built-in Active Directory administrative tools and avoid the use
of third-party tools or utilities.

= Limit the list of objects within an OU to only the type of objects that
you’re examining (for example, only Computer objects).

= Prevent any changes to the Active Directory domain or any of the
objects within it.

Which one of the following actions meets these requirements?

A. Use the Filter option in the Active Directory Users and Computers tool
to restrict the display of objects.

B. Use the Delegation of Control Wizard to give yourself permissions over
only a certain type of object.

C. Implement a new naming convention for objects within an OU and then
sort the results using this new naming convention.

D. Use the Active Directory Domains and Trusts tool to view information
from only selected domain controllers.

E. Edit the domain Group Policy settings to allow yourself to view only the
objects of interest.

8. You are the administrator for a small organization with four servers. You
have one file server named StormSrvA that runs Windows Server 2016. You
have a junior administrator who needs to do backups on this server. You
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need to ensure that the junior admin can use Windows Server Backup to
create a complete backup of StormSrvA. What should you configure to
allow the junior admin to do the backups?

A. The local groups by using Computer Management

B. A task by using Authorization Manager

C. The User Rights Assignment by using the Local Group Policy Editor
D. The Role Assignment by using Authorization Manager

. Miguel is a junior-level system administrator, and he has basic knowledge
about working with Active Directory. As his supervisor, you have asked
Miguel to make several security-related changes to OUs within the
company’s Active Directory domain. You instruct Miguel to use the basic
functionality provided in the Delegation of Control Wizard. Which of the
following operations are represented as common tasks within the
Delegation of Control Wizard? (Choose all that apply.)

A. Reset passwords on user accounts.

B. Manage Group Policy links.

C. Modify the membership of a group.
D. Create, delete, and manage groups.

. You are the primary system administrator for a large Active Directory
domain. Recently, you have hired another system administrator upon
whom you intend to offload some of your responsibilities. This system
administrator will be responsible for handling help desk calls and for basic
user account management. You want to allow the new employee to have
permissions to reset passwords for all users within a specific OU. However,
for security reasons, it’s important that the user not be able to make
permissions changes for objects within other OUs in the domain. Which of
the following is the best way to do this?

A. Create a special administration account within the OU and grant it full
permissions for all objects within Active Directory.

B. Move the user’s login account into the OU that the new employee is to
administer.

C. Move the user’s login account to an OU that contains the OU (that is,
the parent OU of the one that the new employee is to administer).

D. Use the Delegation of Control Wizard to assign the necessary
permissions on the OU that the new employee is to administer.
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Chapter 3
Maintaining Active Directory

THE FOLLOWING 70-742 EXAM OBJECTIVES ARE COVERED IN
THIS CHAPTER:

» . Maintain Active Directory

» This objective may include but is not limited to: Back up Active
Directory and SYSVOL; manage Active Directory offline; perform offline
defragmentation of an Active Directory database; clean up metadata;
configure Active Directory snapshots; perform object- and container-
level recovery; perform Active Directory restore; configure and restore
objects by using the Active Directory Recycle Bin; configure replication
to Read-Only Domain Controllers (RODCs); configure Password
Replication Policy (PRP) for RODC; monitor and manage replication;
upgrade SYSVOL replication to Distributed File System Replication
(DFSR).

» .Configure Active Directory in a complex enterprise
environment

= This objective may include but is not limited to: Configure a multi-
domain and multi-forest Active Directory infrastructure; deploy
Windows Server 2016 domain controllers within a pre-existing Active
Directory environment; upgrade existing domains and forests; configure
domain and forest functional levels; configure multiple user principal
name (UPN) suffixes; configure external, forest, shortcut, and realm
trusts; configure trust authentication; configure SID filtering; configure
name suffix routing; configure sites and subnets; create and configure
site links; manage site coverage; manage registration of SRV records;
move domain controllers between sites; configure account policies.

C ey Microsoft has designed Active Directory to be an enterprise-
wide solution for managing network resources. In previous chapters, you saw
how to create Active Directory objects based on an organization’s logical
design. Domain structure and organizational unit (OU) structure, for example,
should be designed based primarily on an organization’s business needs.
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Now it’s time to learn how Active Directory can map to an organization’s
physical requirements. Specifically, you must consider network connectivity
between sites and the flow of information between domain controllers (DCs)
under less-than-ideal conditions. These constraints determine how domain
controllers can work together to ensure that the objects within Active Directory
remain synchronized no matter how large and geographically dispersed the
network.

Fortunately, through the use of the Active Directory Sites and Services
administrative tool, you can quickly and easily create the various components
of an Active Directory replication topology. Using this tool, you can create
objects called sites, place servers in sites, and create connections between sites.
Once you have configured Active Directory replication to fit your current
network environment, you can sit back and allow Active Directory to make sure
that information remains consistent across domain controllers.

This chapter covers the features of Active Directory, which allow system
administrators to modify the behavior of replication based on their physical
network design. Through the use of sites, system and network administrators
will be able to leverage their network infrastructure best to support Windows
Server 2016 and Active Directory.

So far, you have learned the steps necessary to install the Domain Name
System (DNS) and to implement the first Active Directory domain. Although I
briefly introduced multidomain Active Directory structures earlier, I focused
on only a single domain and the objects within it.

Many businesses find that using a single domain provides an adequate solution
to meet their business needs. By working with trees and forests, however, large
organizations can use multiple domains to organize their environments better.

Overview of Network Planning

Before I discuss sites and replication, you need to understand some basic
physical and network concepts.

The Three Types of Networks

When designing networks, system and network administrators use the
following terms to define the types of connectivity between locations and
servers:

Local Area Networks A local area network (LAN) is usually characterized
as a high-bandwidth network. Generally, an organization owns all of its LAN
network hardware and software. Ethernet is by far the most common
networking standard. Ethernet speeds are generally at least 10 Mbps and can
scale to multiple gigabits per second. Currently, the standard for Ethernet is
the 10 Gigabit Ethernet, which runs at 10 times the speed of Gigabit Ethernet
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(1 GB). Several LAN technologies, including routing and switching, are
available to segment LANs and to reduce contention for network resources.

Wide Area Networks The purpose of a wide area network (WAN) is similar
to that of a LAN, that is, to connect network devices. Unlike LANSs, however,
WANS are usually leased from third-party telecommunications carriers and
organizations known as Internet service providers (ISPs). Although extremely
high-speed WAN connections are available, they are generally costly for
organizations to implement through a distributed environment. Therefore,
WAN connections are characterized by lower-speed connections and,
sometimes, nonpersistent connections.

The Internet The Internet is a worldwide public network infrastructure
based on the Internet Protocol (IP). Access to the Internet is available through
Internet service providers (ISPs). Because it is a public network, there is no
single “owner” of the Internet. Instead, large network and telecommunications
providers constantly upgrade the infrastructure of this network to meet
growing demands.

Organizations use the Internet regularly to sell and market their products and
services. For example, it’s rare nowadays to see advertisements that don’t
direct you to one website or another. Through the use of technologies such as
virtual private networks (VPNs), organizations can use encryption and
authentication technology to enable secure communications across the
Internet.

Exploring Network Constraints

In an ideal situation, a high-speed network would connect all computers and
networking devices. In such a situation, you would be able to ensure that any
user of your network, regardless of location, would be able to access resources
quickly and easily. When you are working in the real world, however, you have
many other constraints to keep in mind, including network bandwidth and
network cost.

Network Bandwidth

Network bandwidth generally refers to the amount of data that can pass
through a specific connection in a given amount of time. For example, in a
WAN situation, a T1 may have 1.544 Mbps (megabits per second), while a DSL
might have a bandwidth of 56 Kbps or 57.6 Kbps (kilobits per second) or more.
On the other hand, your LAN’s Ethernet connection may have a bandwidth of
100 Mbps or 1000 Mbps. Different types of networks work at different speeds.
Therefore, it’s imperative that you always consider network bandwidth when
thinking about how to deploy domain controllers in your environment.

Network Cost
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Cost is perhaps the single largest factor in determining a network design. If
cost were not a constraint, organizations would clearly elect to use high-
bandwidth connections for all of their sites. Realistically, trade-offs in
performance must be made for the sake of affordability. Some factors that can
affect the cost of networking include the distance between networks and the
types of technology available at locations throughout the world. In remote or
less-developed locations, you may not even be able to get access through an
ISP or telecom beyond a satellite connection or dial-up, and what is available
can be quite costly. Network designers must keep these factors in mind, and
they must often settle for less-than-ideal connectivity.

You have considered the monetary value of doing business. Now let’s consider
another aspect of cost. When designing and configuring networks, you can
require certain devices to make data-transport decisions automatically based
on an assigned network cost. These devices are commonly known as routers,
and they use routing protocols to make routing decisions. One of the elements
a router uses to configure a routing protocol is its ability to adjust the cost of a
route. For example, a router may have multiple ways to connect to a remote
site, and it may have multiple interfaces connected to it, each with different
paths out of the network to which it is connected locally. When two or more
routes are available, you can set up a routing protocol that states that the route
with the lower cost is automatically used first.

Another cost is personnel. Do you have the personnel to do the job, or do you
need to hire a consultant? Remember that even if you use individuals already
on staff, they will be spending time on these projects. When your IT team is
working on a project, this is a cost because they cannot also be working on day-
to-day tasks.

All of these factors play an important role when you make your Active
Directory implementation decisions.

Overview of Active Directory Replication and Sites

Now I need to address two topics that not only are covered heavily on the
Microsoft exams but are two areas that all IT administrators should
understand. Understanding Active Directory replication and sites can help you
fine-tune a network to run at peak performance.

Replicating Active Directory

Regardless of the issues related to network design and technological
constraints, network users have many different requirements and needs that
must be addressed. First, network resources, such as files, printers, and shared
directories, must be made available. Similarly, the resources stored within
Active Directory, and its security information in particular, are required for
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many operations that occur within domains.

With these issues in mind, take a look at how you can configure Active
Directory to reach connectivity goals using replication.

Active Directory was designed as a scalable, distributed database that contains
information about an organization’s network resources. In previous chapters,
you saw how you can create and manage domains and how you can use domain
controllers to store Active Directory databases.

Even in the simplest of network environments, you generally need more than
one domain controller. The major reasons for this are fault tolerance (if one
domain controller fails, others can still provide services as needed) and
performance (the workload can be balanced between multiple domain
controllers). Windows Server 2016 domain controllers have been designed to
contain read-write copies as well as read-only copies of the Active Directory
database. However, the domain controllers must also remain current when
objects are created or modified on other domain controllers.

To keep information consistent between domain controllers, you use Active
Directory replication. Replication is the process by which changes to the
Active Directory database are transferred between domain controllers. The
result is that all of the domain controllers within an Active Directory domain
contain up-to-date information and achieve convergence. Keep in mind that
domain controllers may be located very near to each other (for example, within
the same server rack), or they may be located across the world from each other.
Although the goals of replication are quite simple, the real-world constraints of
network connections between servers cause many limitations that you must
accommodate. If you have a domain controller on your local LAN, you may
find that you have Gigabit Ethernet, which runs at 1000 Mbps between your
server connections, whereas you may have a domain controller on the other
side or a WAN where the network link runs at a fraction of a T1, 56 Kbps.
Replication traffic must traverse each link to ensure convergence no matter
what the speed or what bandwidth is available.

Throughout this chapter, you will study the technical details of Active
Directory replication. You will also learn how to use the concept of sites and
site links to map the logical structure of Active Directory to a physical network
topology to help it work efficiently, no matter the type of link with which you
are working.

Understanding Active Directory Site Concepts

One of the most important aspects of designing and implementing Active
Directory is understanding how it allows you to separate the logical
components of the directory service from the physical components.

The logical components—Active Directory domains, OUs, users, groups, and
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computers—map to the organizational and business requirements of a
company.

The physical components, on the other hand, are designed based on the
technical issues involved in keeping the network synchronized (that is, making
sure that all parts of the network have the same up-to-date information).
Active Directory uses the concept of sites to map to an organization’s physical
network. Stated simply, a site is a collection of well-connected subnets. The
technical implications of sites are described later in this chapter.

It is important to understand that no specified relationship exists between
Active Directory domains and Active Directory sites. An Active Directory site
can contain many domains. Alternatively, a single Active Directory domain can
span multiple sites. Figure 3.1 illustrates this very important characteristic of
domains and sites.

Domain A

----------------------------------

Domain
Controllers

Domain A

------------

Domain B Domain C

______________

__________________________________

One Site, One Domain,
Multiple Domains Multiple Sites

FIGURE 3.1 Potential relationships between domains and sites

There are two main reasons to use Active Directory sites: service requests and
replication.

Service Requests

Clients often require the network services of a domain controller. One of the
most common reasons for this is that they need the domain controller to
perform network authentication. If your Active Directory network is set up
with sites, clients can easily connect to the domain controller that is located
closest to them. By doing this, they avoid many of the inefficiencies associated
with connecting to distant domain controllers or to those that are located on
the other side of a slow network connection. For example, by connecting to a
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local domain controller, you can avoid the problems associated with a
saturated network link that might cause two domain controllers to be out of
sync with each other.

Replication

As mentioned earlier, the purpose of Active Directory replication is to ensure
that the information stored on all domain controllers within a domain remains
synchronized. In environments with many domains and domain controllers,
multiple communication paths usually connect them, which makes the
synchronization process more complicated. A simple method of transferring
updates and other changes to Active Directory involves all of the servers
communicating directly with each other as soon as a change occurs; they can
all update with the change and reach convergence again. This is not ideal,
however, because it places high requirements on network bandwidth and is
inefficient for many network environments that use slower and more costly
WAN links, especially if all environments update at the same time. Such
simultaneous updating could cause the network connection at the core of your
network to become saturated and decrease the performance of the entire WAN.

Using sites, Active Directory can automatically determine the best methods for
performing replication operations. Sites take into account an organization’s
network infrastructure, and Active Directory uses these sites to determine the
most efficient method for synchronizing information between domain
controllers. System administrators can make their physical network design
map to Active Directory objects. Based on the creation and configuration of
these objects, the Active Directory service can then manage replication traffic
in an efficient way.

Whenever a change is made to the Active Directory database on a domain
controller, the change is given an update sequence number. The domain
controller can then propagate these changes to other domain controllers based
on replication settings.

Windows Server 2016 uses a feature called linked value replication that is
active only when the domain is in the Windows Server 2003, Windows Server
2008, Windows Server 2008 R2, Windows Server 2012, Windows Server 2012
R2, or Windows Server 2016 domain functional level. With linked value
replication, only the group member is replicated. This greatly enhances
replication efficiency and cuts down on network traffic utilization. Linked
value replication is automatically enabled in Windows Server 2003, Windows
Server 2008/2008 R2, Windows Server 2012/2012 R2, and Windows Server
2016 functional-level domains.

Planning Your Sites
Much of the challenge of designing Active Directory is related to mapping a

Hi va- Net wor k. Corr 2


https://technet24.ir
https://technet24.ir
https://technet24.ir
http://www.hiva-network.com/

company’s business processes to the structure of a hierarchical data store. So
far, you've seen many of these requirements. What about the existing network
infrastructure, however? Clearly, when you plan for and design the structure of
Active Directory, you must take into account your LAN and WAN
characteristics. Let’s see some of the ways that you can use Active Directory
sites to manage replication traffic.

Synchronizing Active Directory is extremely important. To keep security
permissions and objects within the directory consistent throughout the
organization, you must use replication. The Active Directory data store
supports multimaster replication; that is, data can be modified at any domain
controller within the domain because replication ensures that information
remains consistent throughout the organization.

Ideally, every site within an organization has reliable, high-speed connections
with the other sites. A much more realistic scenario, however, is one in which
bandwidth is limited and connections are sometimes either sporadically
available or completely unavailable.

Using sites, network and system administrators can define which domain
controllers are located on which areas of the network. These settings can be
based on the bandwidth available between the areas of the network.
Additionally, these administrators can define subnets—logically partitioned
areas of the network—between areas of the network. Subnets are designed by
subdividing IP addresses into usable blocks for assignment, and they are also
objects found within the Sites and Services Microsoft Management Console
(MMC) in the Administrative Tools folder. Windows Server 2016 Active
Directory services use this information to decide how and when to replicate
data between domain controllers.

Directly replicating information between all domain controllers might be a
viable solution for some companies. For others, however, this might result in a
lot of traffic traveling over slow or undersized network links. One way to
synchronize data efficiently between sites that have slow connections is to use
a bridgehead server. Bridgehead servers are designed to accept traffic between
two remote sites and then to forward this information to the appropriate
servers. Figure 3.2 provides an example of how a bridgehead server can reduce
network bandwidth requirements and improve performance. Reduced network
bandwidth requirements and improved performance can also be achieved by
configuring replication to occur according to a predefined schedule if
bandwidth usage statistics are available.
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FIGURE 3.2 Using a bridgehead server

Bridgehead servers do not fit a normal hub-and-spoke WAN topology. Such a
topology usually involves a core site (for example, company headquarters) with
remote sites as links one off from the core. However, you can use a bridgehead
server design to fit a distributed star, where you have a hub-and-spoke
topology design with additional spokes coming out of the first set of spokes.
Doing so would make some of your spoke sites into smaller core sites. It is at
these sites that you would place your bridgehead servers. In Figure 3.2, you can
see that your Asia headquarters site is also where you can connect to India,
China, and Hong Kong, thus making the Asia headquarters the ideal site for
the bridgehead server.

In addition to managing replication traffic, sites offer the advantage of allowing
clients to access the nearest domain controller. This prevents problems with
user authentication across slow network connections, and it can help find the
shortest and fastest path to resources such as files and printers. Therefore,
Microsoft recommends that you place at least one domain controller at each
site that contains a slow link. Preferably, this domain controller also contains a
copy of the global catalog so that logon attempts and resource search queries
do not occur across slow links. The drawback, however, is that deploying more
copies of the global catalog to servers increases replication traffic.

Through proper planning and deployment of sites, organizations can best use
the capabilities of the network infrastructure while keeping Active Directory
synchronized.

Understanding Distributed File System Replication
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DES Replication (DFSR) was created to replace the File Replication Service
(FRS) that was introduced in the Windows 2000 Server operating systems.
DFSR is a state-based, multimaster replication engine that supports replication
scheduling and bandwidth throttling. DFSR has the ability to detect insertions,
removals, and rearrangements of data in files. This allows DFS Replication to
replicate only the changed file blocks when files are updated.

The DFS Replication component uses many different processes to keep data
synchronized on multiple servers. To understand the DFSR process, it is
helpful to understand some of the following concepts:

= DFSR is a multitasker replication engine, and changes that occur on one of
the members are then replicated to all of the other members of the
replication group.

= DFSR uses the update sequence number (USN) journal to detect changes
on the volume, and then DFSR replicates the changes only after the file is
closed.

= Before sending or receiving a file, DFSR uses a staging folder to stage the
file.

= When a file is changed, DFSR replicates only the changed blocks and not
the entire file. The RDC protocol is what helps determine the blocks that
have changed in the file.

= One of the advantages of DFSR is that it is self-healing and can
automatically recover from USN journal wraps, USN journal loss, or loss of
the DFS Replication database.

= Windows Server 2016 DFSR includes the ability to add a failover cluster as
a member of a replication group.

= Windows Server 2016 DFSR allows for read-only replicated folders on a
particular member in which users cannot add or change files.

= In Windows Server 2016, it is possible to make changes to the sysvoL folder
of an RODC.

The pfsrdiag.exe command-line tool includes three Windows Server 2016
command-line switches that provide enhanced diagnostic capabilities for
DFSR:

Dfsrdiag.exe Replstate When you use the Replstate switch, a summary of the
replication status across all connections on the specified replication group
member is provided. The Replstate switch takes a snapshot of the internal
state of the DFSR service, and the updates that are currently being processed
(downloaded or served) by the service are shown in a list.

Dfsrdiag.exe IdRecord When replicating a file or folder, the DFSR service
creates an ID record, and an administrator can use this ID record to determine
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whether a file has replicated properly to a specific member. The 1drecord
switch returns the DFSR ID record for the file or folder that you specify by
using its path or its unique identifier (UID).

Dfsrdiag.exe FileHash The FileHash switch, when used against a particular
file, will compute and display the hash value that is generated by the DFSR
service. An administrator can then look at the hash values to compare two files.
If the hash values for the two files are the same, then the two files are the same.

Implementing Sites and Subnets

Now that you have a good idea of the goals of replication, take a look at the
following quick overview of the various Active Directory objects that are related
to physical network topology.

The basic objects that are used for managing replication include the following:

Subnets A subnet is a partition of a network. As I started to discuss earlier,
subnets are logical IP blocks usually connected to other IP blocks through the
use of routers and other network devices. All of the computers that are located
on a given subnet are generally well connected with each other.

4 N\

"5’1 It is extremely important to understand the concepts of TCP/IP

and the routing of network information when you are designing the
topology for Active Directory replication.

(. J

Sites An Active Directory site is a logical object that can contain servers and
other objects related to Active Directory replication. Specifically, a site is a
grouping of related subnets. Sites are created to match the physical network
structure of an organization. Sites are primarily used for slow WAN links. If
your network is well connected (using fiber optics, Category 6 Ethernet, and so
on), then sites are not needed.

Site Links A site link is created to define the types of connections that are
available between the components of a site. Site links can reflect a relative cost
for a network connection and can also reflect the bandwidth that is available
for communications.

All of these components work together to determine how information is used
to replicate data between domain controllers. Figure 3.3 provides an example
of the physical components of Active Directory.
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FIGURE 3.3 Active Directory replication objects

Many issues are related to configuring and managing sites, and all of them are
covered in this chapter. Overall, using sites allows you to control the behavior
of Active Directory replication between domain controllers. With this
background and goal in mind, let’s look at how you can implement sites to
control Active Directory replication so that it is efficient and in sync.

If you do not have replication set up properly, after a while you will experience
problems with your domain controllers. An example of a common replication
problem is event log event ID 1311, which states that the Windows NT
Directory Services (NTDS) Knowledge Consistency Checker (KCC) has found
(and reported) a problem with Active Directory replication. This error message
states that the replication configuration information in Active Directory does
not accurately reflect the physical topology of the network. This error is
commonly found on ailing networks that have replication problems for one
reason or another.

Creating Sites

The primary method for creating and managing Active Directory replication
components is to utilize the Active Directory Sites and Services tool or the
MMC found within the Administrative Tools folder. Using this administrative
component, you can graphically create and manage sites in much the same way
that you create and manage OUs.

Exercise 3.1 walks you through the process of creating Active Directory sites.
For you to complete this exercise, the local machine must be a domain
controller. Also, this exercise assumes that you have not yet changed the
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default domain site configuration.

4 )

‘% .Do not perform any testing on a production system or network.

Make sure you test site configuration in a lab setting only.

- J/

( N

EXERCISE 3.1

Creating Sites

1. Open the Active Directory Sites and Services tool from the
Administrative Tools program group.

2. Expand the sites folder.

3. Right-click the Default-First-Site-Name item and choose Rename.
Rename the site CorporateHQ (see Figure 3.4).

4. Create a new site by right-clicking the sites object and selecting New
Site.

5. In the New Object — Site dialog box, type Farmington for the site
name. Click the DEFAULTIPSITELINK item, and an information
screen pops up. Then click OK to create the site. Note that you cannot
include spaces or other special characters in the name of a site.

6. Notice that the Farmington site is now listed under the sites object.

7. Create another new site and name it Portsmouth. Again, choose the
DEFAULTIPSITELINK item. Notice that the new site is listed under the
Sites object.

8. When you have finished, close the Active Directory Sites and Services
tool.
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FIGURE 3.4 Renaming the site to CorporateHQ

Creating Subnets

Once you have created the sites that map to your network topology, it’s time to
define the subnets that define the site boundaries.

Subnets are based on TCP/IPv4 or TCP/IPv6 address information. For
example, the IPv4 address may be 10.10.0.0, and the subnet mask may be
255.255.0.0. This information specifies that all of the TCP/IP addresses that
begin with the first two octets are part of the same TCP/IP subnet. All of the
following TCP/IP addresses would be within this subnet:

= 10.10.1.5
= 10.10.100.17
= 10.10.110.120

The Active Directory Sites and Services tool expresses these subnets in a
somewhat different notation. It uses the provided subnet address and appends
a slash followed by the number of bits in the subnet mask. In the example in
the previous paragraph, the subnet would be defined as 10.1.0.0/16.

Remember that sites typically represent distinct physical locations, and they
almost always have their own subnets. The only way for a domain controller in
one site to reach a DC in another site is to add subnet information about the
remote site. Generally, information regarding the definition of subnets for a
specific network environment will be available from a network designer.
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Exercise 3.2 walks you through the steps that you need to take to create
subnets and assign subnets to sites. To complete the steps in this exercise, you
must have completed Exercise 3.1.

( B

EXERCISE 3.2

Creating Subnets

1. Open the Active Directory Sites and Services tool from the
Administrative Tools program group.

2. Expand the sites folder. Right-click the subnets folder and select New
Subnet.

3. In the New Object — Subnet dialog box, you are prompted for
information about the IPv4 or IPv6 details for the new subnet. For the
prefix, type 10.10.1.0/24 (you are staying with the more commonly
used IPv4). This actually calculates out to 10.10.1.0 with the mask of
255.255.255.0. Click the Farmington site and then click OK to create
the subnet.

4. In the Active Directory Sites and Services tool, right-click the newly
created 10.10.1.0/24 subnet object and select Properties.

5. On the subnet’s Properties dialog box, type Farmington 100 MB
LAN for the description. Click OK to continue.

6. Create a new subnet using the following information:
Address: 160.25.0.0/16
Site: Portsmouth
Description: Portsmouth 1t0o0Mbit LAN
7. Finally, create another subnet using the following information:
Address: 176.33.0.0/16
Site: CorporateHQ
Description: Corporate 100Mbit switched LAN

8. When finished, close the Active Directory Sites and Services tool.

So far, you have created the basic components that govern Active Directory
sites and subnets. You also linked these two components by defining which
subnets belong in which sites. These two steps—creating sites and creating
subnets—form the basis of mapping the physical network infrastructure of an
organization to Active Directory. Now look at the various settings that you can
make for sites.

Hi va- Net wor k. Corr 2
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Configuring Sites

Once you have created Active Directory sites and have defined which subnets
they contain, it’s time to make some additional configuration settings for the
site structure. Specifically, you’ll need to assign servers to specific sites and
configure the site-licensing options. By placing servers in sites, you tell Active
Directory replication services how to replicate information for various types of
servers. Later in this chapter, you’ll examine the details of working with
replication within and between sites.

In Exercise 3.3, you will add servers to sites and configure CorpDC1 options. To
complete the steps in this exercise, you must have completed Exercise 3.1 and
Exercise 3.2.

4 R

EXERCISE 3.3

Configuring Sites

1. Open the Active Directory Sites and Services tool from the
Administrative Tools program group.

2. Expand the sites folder and click and expand the Farmington site.

3. Right-click the Servers container in the Farmington site and select New
> Server. Type FarmingtonDC1 for the name of the server and then
click OK.

4. Create a new Server object within the CorporateHQ site and name it
CorpDCi. Note that this object also includes the name of the local
domain controller.

5. Create two new Server objects within the Portsmouth site and name
them PortsmouthDC1 and PortsmouthDC2.

6. Right-click the CorpDC1 server object and select Properties. On the
General tab of the CorpDC1 Properties box, select SMTP in the
Transports Available For Inter-site Data Transfer box and click Add to
make this server a preferred IP bridgehead server. Click OK to accept
the settings.

7. When you have finished, close the Active Directory Sites and Services
tool.

g J/

With the configuration of the basic settings for sites out of the way, it’s time to
focus on the real details of the site topology—creating site links and site link
bridges.

Configuring Replication
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Sites are generally used to define groups of computers that are located within a
single geographic location. In most organizations, machines that are located in
close physical proximity (for example, within a single building or branch office)
are well connected. A typical example is a LAN in a branch office of a company.
All of the computers may be connected using Ethernet, and routing and
switching technology may be in place to reduce network congestion.

Often, however, domain controllers are located across various states, countries,
and even continents. In such a situation, network connectivity is usually much
slower, less reliable, and more costly than that for the equivalent LAN.
Therefore, Active Directory replication must accommodate this situation
accordingly. When managing replication traffic within Active Directory sites,
you need to be aware of two types of synchronization:

Intrasite Intrasite replication refers to the synchronization of Active
Directory information between domain controllers that are located in the same
site. In accordance with the concept of sites, these machines are usually well
connected by a high-speed LAN.

Intersite Intersite replication occurs between domain controllers in different
sites. Usually, this means there is a WAN or other type of low-speed network
connection between the various machines. Intersite replication is optimized for
minimizing the amount of network traffic that occurs between sites.

In the following sections, you’ll look at ways to configure both intrasite and
intersite replication. Additionally, you’ll see features of Active Directory
replication architecture that you can use to accommodate the needs of almost
any environment.

Intrasite Replication

Intrasite replication is generally a simple process. One domain controller
contacts the others in the same site when changes to its copy of Active
Directory are made. It compares the update sequence numbers in its own copy
of Active Directory with those of the other domain controllers; then the most
current information is chosen by the DC in question, and all domain
controllers within the site use this information to make the necessary updates
to their database.

Because you can assume that the domain controllers within an Active Directory
site are well connected, you can pay less attention to exactly when and how
replication takes place. Communications between domain controllers occur
using the Remote Procedure Call (RPC) protocol. This protocol is optimized
for transmitting and synchronizing information on fast and reliable network
connections. The RPC protocol provides for fast replication at the expense of
network bandwidth, which is usually readily available because most LANs
today are running on Fast Ethernet (100 Mbps) at a minimum.
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Intersite Replication

Intersite replication is optimized for low-bandwidth situations and network
connections that have less reliability. Intersite replication offers several
features that are tailored toward these types of connections. To begin with, two
different protocols may be used to transfer information between sites:

RPC over IP When connectivity is fairly reliable, IP is a good choice. IP-based
communications require you to have a live connection between two or more
domain controllers in different sites and let you transfer Active Directory
information. RPC over IP was originally designed for slower WANs in which
packet loss and corruption may often occur.

Simple Mail Transfer Protocol Simple Mail Transfer Protocol (SMTP) is
perhaps best known as the protocol that is used to send and receive email
messages on the Internet. SMTP was designed to use a store-and-forward
mechanism through which a server receives a copy of a message, records it to
disk, and then attempts to forward it to another email server. If the destination
server is unavailable, it holds the message and attempts to resend it at periodic
intervals.

This type of communication is extremely useful for situations in which network
connections are unreliable or not always available. For example, if a branch
office in Peru were connected to the corporate office through a dial-up
connection that is available only during certain hours, SMTP would be a good
choice for communication with that branch.

SMTP is an inherently insecure network protocol. Therefore, if you would like
to ensure that you transfer replication traffic securely and you use SMTP for
Active Directory replication, you must take advantage of Windows Server
2016’s Certificate Services functionality.

Other intersite replication characteristics are designed to address low-
bandwidth situations and less-reliable network connections. These features
give you a high degree of flexibility in controlling replication configuration.
They include the following;:

= Compression of Active Directory information. This compression is helpful
because changes between domain controllers in remote sites may include a
large amount of information and also because network bandwidth tends to
be less available and more costly.

= Site links and site link bridges help determine intersite replication
topology.

m Replication can occur based on a schedule defined by system
administrators.

You can configure intersite replication by using the Active Directory Sites and
Services tool. Select the name of the site for which you want to configure
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settings. Then right-click the NTDS Site Settings object in the right window
pane and select Properties. By clicking the Change Schedule button in the
NTDS Site Settings Properties dialog box, you’ll be able to configure how often
replication occurs between sites (see Figure 3.5).
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FIGURE 3.5 Configuring intersite replication schedules

"5'1 You will see how to set the replication schedule in Exercise 3.4.

In the following sections, you will see how to configure site links and site link
bridges as well as how to manage connection objects and bridgehead servers.

Creating Site Links and Site Link Bridges

The overall topology of intersite replication is based on the use of site links and
site link bridges. Site links are logical connections that define a path between
two Active Directory sites. Site links can include several descriptive elements
that define their network characteristics. Site link bridges are used to connect
site links so that the relationship can be transitive. Figure 3.6 provides an
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example of site links and site link bridges.
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FIGURE 3.6 An example of site links and site link bridges

Both of these types of logical connections are used by Active Directory services
to determine how information should be synchronized between domain
controllers in remote sites. The Knowledge Consistency Checker (KCC) uses
this information, which forms a replication topology based on the site topology
created. The KCC service is responsible for determining the best way to
replicate information within sites.

When creating site links for your environment, you’ll need to consider the
following factors:

Transporting Information You can choose to use either RPC over IP or
SMTP for transferring information over a site link. You will need to determine
which is best based on your network infrastructure and the reliability of
connections between sites.

Assigning a Cost Value You can create multiple site links between sites and
assign site links a cost value based on the type of connection. The system
administrator determines the cost value, and the relative costs of site links are
then used (by the system) to determine the optimal path for replication. The
lower the cost, the more likely the link is to be used for replication.


https://technet24.ir
https://technet24.ir

For example, a company may primarily use a T1 link between branch offices,
but it may also use a slower and circuit-switched dial-up ISDN connection for
redundancy (in case the T1 fails). In this example, a system administrator may
assign a cost of 25 to the T1 line and a cost of 100 to the ISDN line. This
ensures that the more reliable and higher-bandwidth T1 connection is used
whenever it’s available but that the ISDN line is also available.

Determining a Replication Schedule Once you've determined how and
through which connections replication will take place, it’s time to determine
when information should be replicated. Replication requires network resources
and occupies bandwidth. Therefore, you need to balance the need for
consistent directory information with the need to conserve bandwidth. For
example, if you determine that it’s reasonable to have a lag time of six hours
between when an update is made at one site and when it is replicated to all
others, you might schedule replication to occur once in the morning, once
during the lunch hour, and more frequently after normal work hours.

Based on these factors, you should be able to devise a strategy that allows you
to configure site links.

Exercise 3.4 walks you through the process of creating site links and site link
bridges. To complete the steps in this exercise, you must have completed
Exercises 3.1, 3.2, and 3.3.

( )\

EXERCISE 3.4

Creating Site Links and Site Link Bridges

1. Open the Active Directory Sites and Services tool from the
Administrative Tools program group.

2. Expand the Sites, Inter-site Transports, and IP objects. Right-click the
DEFAULTIPSITELINK item in the right pane and select Rename.
Rename the object Corporate WAN.

3. Right-click the CorporateWAN link and select Properties. In the
General tab of the CorporateWAN Properties dialog box, type T1
Connecting Corporate and Portsmouth Offices for the
description. Remove the Farmington site from the link by highlighting
Farmington in the Sites In This Site Link box and clicking Remove. For
the Cost value, type 50 and specify that replication should occur every
60 minutes. To create the site link, click OK.

4. Right-click the 1p folder and select New Site Link. In the New Object —
Site Link dialog box, name the link CorporateDialup. Add the
Farmington and CorporateHQ sites to the site link and then click OK.

5. Right-click the CorporateDialup link and select Properties. In the
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General tab of the CorporateDialup Properties dialog box, type ISDN
Dialup between Corporate and Farmington for the description.
Set the Cost value to 100 and specify that replication should occur
every 120 minutes. To specify that replication should occur only during
certain times of the day, click the Change Schedule button.

6. In the Schedule For Corporate Dialup dialog box, highlight the area
between 8:00 a.m. and 6:00 p.m. for the days Monday through Friday
and click the Replication Not Available option. This will ensure that
replication traffic is minimized during normal work hours.

7. Click OK to accept the new schedule and then click OK again to create
the site link.

8. Right-click the IP object and select New Site Link Bridge. In the New
Object — Site Link Bridge dialog box, name the site link bridge
CorporateBridge. Note that the CorporateDialup and Corporate WAN
site links are already added to the site link bridge. Because there must
be at least two site links in each bridge, you will not be able to remove
these links. Click OK to create the site link bridge.

9. When finished, close the Active Directory Sites and Services tool.

Creating Connection Objects

Generally, it is a good practice to allow Active Directory’s replication
mechanisms to schedule and manage replication functions automatically. In
some cases, however, you may want to have additional control over replication.
Perhaps you want to replicate certain changes on demand (for example, when
you create new accounts). Or you may want to specify a custom schedule for
certain servers.

Connection objects provide you with a way to set up these different types of
replication schedules. You can create connection objects with the Active
Directory Sites and Services tool by expanding a server object, right-clicking
the NTDS Settings object, and selecting New Active Directory Domain Services
Connection.

Within the properties of the connection object, which you can see in the right
pane of the Active Directory Sites and Services tool, you can specify the type of
transport to use for replication (RPC over IP or SMTP), the schedule for
replication, and the domain controllers that participate in the replication.
Additionally, you can right-click the connection object and select Replicate
Now.

Moving Server Objects Between Sites

Using the Active Directory Sites and Services tool, you can easily move servers
between sites. To do this, simply right-click the name of a domain controller
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and select Move. You can then select the site to which you want to move the
domain controller object.

Figure 3.7 shows the Move Server dialog box. After the server is moved, all
replication topology settings are updated automatically. If you want to choose
custom replication settings, you’ll need to create connection objects manually
(as described earlier).
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FIGURE 3.7 Choosing a new site for a specific server

In Exercise 3.5, you move a server object between sites. To complete the steps
in this exercise, you must have completed the previous exercises in this
chapter.

( N\

EXERCISE 3.5

Moving Server Objects Between Sites

1. Open the Active Directory Sites and Services administrative tool.
2. Right-click the server named PortsmouthDC1 and select Move.

3. In the Move Server dialog box, select the Farmington site and then click
OK. This moves this server to the Farmington site.

4. To move the server back, right-click PortsmouthDC1 (now located in
the Farmington site) and then click Move. Select Portsmouth for the
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destination site.

5. When finished, close the Active Directory Sites and Services
administrative tool.

Creating Bridgehead Servers

By default, all of the servers in one site communicate with all of the servers in
another site. You can, however, further control replication between sites by
using bridgehead servers. As mentioned earlier in the chapter, using
bridgehead servers helps minimize replication traffic, especially in larger
distributed star network topologies, and it allows you to dedicate machines
that are better connected to receive replicated data. Data is replicated between
sites every 180 minutes by default. Figure 3.8 provides an example of how
bridgehead servers work.
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FIGURE 3.8 A replication scenario using bridgehead servers

You can use a bridgehead server to specify which domain controllers are
preferred for transferring replication information between sites. Different
bridgehead servers can be selected for RPC over IP and SMTP replication, thus
allowing you to balance the load. To create a bridgehead server for a site,
simply right-click a domain controller and select Properties, which brings up
the bridgehead server’s Properties dialog box. To make the server a bridgehead
server, just select one or both replication types (called transports) from the left
side of the dialog box and click the Add button to add them to the right side of
the dialog box.

RODCs and Replication
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I have talked quite a bit about read-only domain controllers (RODCs)
throughout the book. It’s important that you understand that since RODCs
don’t actually commit changes against the Active Directory Domain Services
(AD DS) database within your environment, then replication to and from your
primary domain controller (PDC) and your RODCs can occur only one way.
This is referred to as unidirectional replication. Any writable domain
controller that serves as a replication partner to one of your RODCs will never
pull changes from that RODC by design. This helps ensure that no malicious or
corrupt changes that are made from an RODC are replicated throughout your
entire forest. The RODC performs normal inbound replication for AD DS and
Sysvol changes. Any other shares on an RODC that you configure to replicate
using DFS Replication would still use bidirectional replication.

RODCs come with additional configuration settings like the Password
Replication Policy (PRP). The PRP is used to determine which user’s
credentials can be cached locally on a specific RODC. By default, an RODC will
not cache an Active Directory user’s credentials. That would defeat the purpose
of an RODC. When a user wants to authenticate to an RODC, the
authentication request is forwarded to a writable domain controller for
authentication. If the request succeeds, it is then passed back to the RODC, and
then that user will be able to log in to the domain.

Nonetheless, it is possible to allow certain user credentials to be cached on an
RODC by configuring the PRP. Once a user has been added to the Allowed
RODC Password Replication group, then that user’s credentials will be cached,
and that RODC would be able to authenticate that user locally again in the
future. Because the RODC maintains only a subset of user credentials, if the
RODC is compromised or stolen, only the user accounts that had been cached
on the RODC must have their passwords changed. To configure an RODC PRP,
open the properties of an RODC computer object in Active Directory and select
the Password Replication Policy tab.

Configuring Server Topology

When you are using environments that require multiple sites, you must
carefully consider where you place your servers. In doing so, you can greatly
improve performance and end user experience by reducing the time they must
spend performing common operations, such as authentication or searching
Active Directory for resources.

There are two main issues to consider when you are designing a distributed
Active Directory environment. The first is how you should place domain
controllers within the network environment. The second is how to manage the
use of global catalog servers. Finding the right balance between servers, server
resources, and performance can be considered an art form for network and
system administrators. In the following sections, you’ll look at some of the
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important considerations that you must take into account when you design a
replication server topology.

Placing Domain Controllers

Microsoft highly recommends that you have at least two domain controllers in
each domain of your Active Directory environment. As mentioned earlier in
this chapter, using additional domain controllers provides the following
benefits:

= Increased network performance:
» The servers can balance the burden of serving client requests.

= Clients can connect to the server closest to them instead of performing
authentication and security operations across a slow WAN link.

» Fault tolerance (In case one domain controller fails, the other still contains
a valid and usable copy of the Active Directory database.)

= In Windows Server 2016, RODCs help increase security when users connect
to a domain controller in an unsecured remote location.

Placing Global Catalog Servers

A global catalog (GC) server is a domain controller that contains a copy of all
of the objects contained in the forest-wide domain controllers that compose
the Active Directory database. Making a domain controller a GC server is
simple, and you can change this setting quite easily. That brings us to the
harder part—determining which domain controllers should also be GC servers.

Where you place domain controllers and GC servers and how many you deploy
are important network planning decisions. Generally, you want to make GC
servers available in every site that has a slow link. This means the most logical
places to put GC servers are in every site and close to the WAN link for the best
possible connectivity. However, having too many GC servers is a bad thing. The
main issue is associated with replication traffic—you must keep each GC server
within your environment synchronized with the other servers. In a very
dynamic environment, using additional GC servers causes a considerable
increase in network traffic. Therefore, you will want to find a good balance
between replication burdens and GC query performance in your own large
multidomain environment.

To create a GC server, simply expand the Server object in the Active Directory
Sites and Services tool, right-click NTDS Settings, and select Properties to
bring up the NTDS Settings Properties dialog box (see Figure 3.9). To
configure a server as a GC server, simply place a check mark in the Global
Catalog box.
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FIGURE 3.9 Enabling the global catalog on an Active Directory domain
controller

Accommodating a Changing Environment

You're a system administrator for a medium-sized business that consists of
many offices located throughout the world. Some of these offices are well
connected because they use high-speed, reliable links, while others are not
so fortunate. Overall, things are going well until your CEO announces that
the organization will be merging with another large company and that the
business will be restructured. The restructuring will involve opening new
offices, closing old ones, and transferring employees to different locations.
Additionally, changes in the IT budget will affect the types of links that
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exist between offices. Your job as the system administrator is to ensure
that the network environment and, specifically, Active Directory keep pace
with the changes and ultimately outperform them.

An important skill for any technical professional is the ability to adapt
quickly and efficiently to a changing organization. When a business grows,
restructures, or forms relationships with other businesses, often many IT-
related changes must also occur. You may have to create new network
links, for example.

Fortunately, Active Directory was designed with these kinds of challenges
in mind. For example, you can use the Active Directory Sites and Services
administrative tool to reflect physical network changes in Active Directory
topology. If a site that previously had 64 Kbps of bandwidth is upgraded to
a T1 connection, you can change those characteristics for the site link
objects. Conversely, if a site that was previously well connected is reduced
to a slow, unreliable link, you can reconfigure the sites, change the site link
transport mechanisms (perhaps from IP to SMTP to accommodate a
nonpersistent link), and create connection objects (which would allow you
to schedule replication traffic to occur during the least busy hours).

Suppose further that many of your operations move overseas to a
European division. This might call for designating specific domain
controllers as preferred bridgehead servers to reduce the amount of
replication traffic over costly and slow overseas links.

Sweeping organizational changes inevitably require you to move servers
between sites. For example, an office may close and its domain controllers
may move to another region of the world. Again, you can accommodate
this change by using Active Directory administrative tools. You may change
your OU structure to reflect new logical and business-oriented changes,
and you can move server objects between sites to reflect physical network
changes.

Rarely can the job of mapping a physical infrastructure to Active Directory
be “complete.” In most environments, it’s safe to assume that you will
always need to make changes based on business needs. Overall, however,
you should feel comfortable that the physical components of Active
Directory are at your side to help you accommodate these changes.
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Using Universal Group Membership Caching

To understand how Universal Group Membership Caching (UGMC) works, you
must first understand how authentication works. When a user tries to
authenticate with a domain controller, the first action that takes place is that
the domain controller checks with the global catalog to see to which domain
the user belongs.
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If the domain controller (the one to which the user is trying to authenticate) is
not a GC, then the domain controller sends a request to the GC to verify the
user’s domain. The GC responds with the user’s information, and the domain
controller authenticates the user (if the user belongs to the same domain as the
domain controller).

There are two ways to speed up the authentication process. First, you can make
all of the domain controller’s global catalogs. But then you end up with a lot of
GC replication traffic. This becomes even more of an issue if you have multiple
sites. Now replication traffic can be too large for your site link connections.

Thus, if you have a slower site link connection or multiple domains, you can
use Universal Group Membership Caching. If you are using UGMC, after a
domain controller communicates with the global catalog, the domain
controller will then cache the user’s credentials for eight hours by default. Now
if the user logs off the domain and then logs back into the domain, the domain
controller will use the cached credentials and not ask the global catalog. The
downside to using UGMC is that it is for authentication only. Global catalogs
help speed up Active Directory searches, and they work with Directory
Service—enabled applications (applications that have to work with Active
Directory) such as Exchange and SQL.

Domain Controller Cloning

Throughout the book, I have talked about why so many organizations are
switching to virtualization in their server rooms. Virtualization allows an
administrator to take one physical server and turn it into multiple virtual
servers by using Windows Server 2016.

In Windows Server 2016, administrators can now easily and safely create
replica domain controllers by copying an existing virtual domain controller.
Before Windows Server 2012, an administrator would have to deploy a server
image that they prepared by using sysprep.exe. After going through the
process of using sysprep.exe, the administrator would have to promote this
server to a domain controller and then complete additional configuration
requirements for deploying each replica domain controller.

Domain controller cloning allows an administrator to deploy rapidly a large
number of domain controllers. To set up domain controller cloning, you must
be a member of the Domain Admins group or have the equivalent permissions.
The administrator must then run Windows PowerShell from an elevated
command prompt.

Only Windows Server 2012 or Windows Server 2016 domain controllers that
are hosted on a VM-compatible hypervisor can be used as a source for cloning.
You should also make sure that the domain controller that you choose to clone
is in a healthy state (use computer management to see the computer’s state).
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The following example is used to create a clone domain controller named
TestClone with a static IP address of 10.0.0.5 and a subnet mask of
255.255.0.0. This command also configures the DNS Server and WINS server
configurations.

New-ADDCCloneConfigFile -CloneComputerName "TestClone" -Static -
IPv4Address "10.0.0.5" -IPv4DNSResolver "10.0.0.1" -IPv4SubnetMask
"255,255.0.0" -PreferredwinsServer "10.0.0.1" -AlternateWinsServer
"10.0.0.2"

4 )\

’% ‘When you are ready to clone a domain controller, I recommend

you visit Microsoft’s TechNet site for all of the PowerShell commands
needed to complete this entire process.

- J/

Configuring DNS SRV Records

When setting up Active Directory, there are a few DNS Service (SRV) records
that are needed. SRV records show that a machine is running a specific service.
There are a few services that are needed for the network to properly function.
DNS must have service records for the domain controllers, global catalogs,
PDC emulator, and the Kerberos KDC service.

The easiest way to configure the SRV records is to have these machines all be
DNS clients. DNS clients will send their client information to the DNS server
by default. But if the servers are not DNS clients or for some reason they do not
register with DNS, you may need to manually create these SRV records. To
manually create the SRV records, complete the following steps:

1. Open the DNS management tool by clicking Start > Administrative Tools
> DNS.

Expand the Forward Lookup Zone and expand your zone name.
Right click _TCP and choose Other New Record.
Choose SRV record.

Enter the SRV record information.

AR S

Monitoring and Troubleshooting Active Directory
Replication

For the most part, domain controllers handle the replication processes
automatically. However, system administrators still need to monitor the
performance of Active Directory replication because failed network links and
incorrect configurations can sometimes prevent the synchronization of
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information between domain controllers.

You can monitor the behavior of Active Directory replication and troubleshoot
the process if problems occur.

About System Monitor

The Windows Server 2016 System Monitor administrative tool was designed so
that you can monitor many performance statistics associated with using Active
Directory. Included within the various performance statistics that you can
monitor are counters related to Active Directory replication.

Troubleshooting Replication

A common symptom of replication problems is that information is not updated
on some or all domain controllers. For example, a system administrator creates
a user account on one domain controller, but the changes are not propagated
to other domain controllers. In most environments, this is a potentially serious
problem because it affects network security and can prevent authorized users
from accessing the resources they require.

You can take several steps to troubleshoot Active Directory replication. These
steps are discussed in the following sections.

Verifying Network Connectivity

For replication to work properly in distributed environments, you must have
network connectivity. Although ideally all domain controllers would be
connected by high-speed LAN links, this is rarely the case for larger
organizations. In the real world, dial-up connections and slow connections are
common. If you have verified that your replication topology is set up properly,
you should confirm that your servers are able to communicate. Problems such
as a failed dial-up connection attempt can prevent important Active Directory
information from being replicated.

Verifying Router and Firewall Configurations

Firewalls are used to restrict the types of traffic that can be transferred
between networks. They are mainly used to increase security by preventing
unauthorized users from transferring information. In some cases, company
firewalls may block the types of network access that must be available for
Active Directory replication to occur. For example, if a specific router or
firewall prevents data from being transferred using SMTP, replication that uses
this protocol will fail.

Examining the Event Logs

Whenever an error in the replication configuration occurs, the computer writes
events to the Directory Service and File Replication Service event logs. By
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using the Event Viewer administrative tool, you can quickly and easily view the
details associated with any problems in replication. For example, if one domain
controller is unable to communicate with another to transfer changes, a log
entry is created.

Verifying That Information Is Synchronized

It’s often easy to forget to perform manual checks regarding the replication of
Active Directory information. One of the reasons for this is that Active
Directory domain controllers have their own read-write copies of the Active
Directory database. Therefore, if connectivity does not exist, you will not
encounter failures while creating new objects.

It is important to verify periodically that objects have been synchronized
between domain controllers. This process might be as simple as logging on to a
different domain controller and looking at the objects within a specific OU.
This manual check, although it might be tedious, can prevent inconsistencies
in the information stored on domain controllers, which, over time, can become
an administration and security nightmare.

Verifying Authentication Scenarios

A common replication configuration issue occurs when clients are forced to
authenticate across slow network connections. The primary symptom of the
problem is that users complain about the amount of time it takes them to log
on to Active Directory (especially during a period when there’s a high volume
of authentications, such as at the beginning of the workday).

Usually, you can alleviate this problem by using additional domain controllers
or reconfiguring the site topology. A good way to test this is to consider the
possible scenarios for the various clients that you support. Often, walking
through a configuration, such as “A client in Domain1 is trying to authenticate
using a domain controller in Domain2, which is located across a slow WAN
connection,” can be helpful in pinpointing potential problem areas.

Verifying the Replication Topology

The Active Directory Sites and Services tool allows you to verify that a
replication topology is logically consistent. You can quickly and easily perform
this task by right-clicking NTDS Settings within a Server object and choosing
All Tasks > Check Replication. If any errors are present, a dialog box alerts
you to the problem.

Another way to verify replication is by using the command-line utility
Repadmin. Table 3.1 shows some of the Repadmin commands.

TABLE 3.1 Repadmin commands

Command Description
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Repadmin Lists the bridgehead servers for a specified site.
Bridgeheads

Repadmin Returns a server name when given a GUID.
dsaguid

Repadmin Shows a list of failed replication events.

failcache

Repadmin Returns the server name of the Inter-Site Topology Generator

istg (ISTG) server for a specified site. The ISTG manages the inbound
replication connection objects for the bridgehead servers in a
site.

Repadmin Forces the Knowledge Consistency Checker (KCC) to recalculate

kee replication topology for a specified domain controller. The KCC
modifies data in the local directory in response to system-wide
changes.

Repadmin Shows the amount of time between replications.
latency

Repadmin Shows tasks waiting in the replication queue.
queue

Repadmin Uses routing information to determine the cost of a route from a
querysites gpecified site to another specified site or to other sites.

Repadmin Starts a replication event for the specified directory partition
replicate  hetween domain controllers.

Repadmin Displays the replication state and relative health of a forest.
replsummary

Repadmin Displays replication partners for each directory partition on a
showrepl  gpecified domain controller.

Reasons for Creating Multiple Domains

Before you look at the steps that you must take to create multiple domains,
become familiar with the reasons an organization might want to create them.

In general, you should always try to reflect your organization’s structure within
a single domain. By using organizational units (OUs) and other objects, you
can usually create an accurate and efficient structure within one domain.
Creating and managing a single domain is usually much simpler than
managing a more complex environment consisting of multiple domains.

That being said, you should familiarize yourself with some real benefits and
reasons for creating multiple domains and some drawbacks of using them.

Reasons for Using Multiple Domains

You might need to implement multiple domains for several reasons. These
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reasons include the following considerations:

Scalability Although Microsoft has designed Active Directory to
accommodate millions of objects, this may not be practical for your current
environment. Supporting thousands of users within a single domain requires
more disk space, greater central processing unit (CPU) usage, and additional
network burdens on your domain controllers (computers containing Active
Directory security information). To determine the size of the Active Directory
domain your network can support, you need to plan, design, test, and analyze
within your own environment.

Reducing Replication Traffic All of the domain controllers in a domain
must keep an up-to-date copy of the entire Active Directory database. For
small to medium-sized domains, this is generally not a problem. Windows
Server 2016 and Active Directory manage all of the details of transferring the
database behind the scenes. Other business and technical limitations might,
however, affect Active Directory’s ability to perform adequate replication. For
example, if you have two sites that are connected by a slow network link (or a
sporadic link or no link at all), replication is not practical. In this case, you
would probably want to create separate domains to isolate replication traffic.
Sporadic coverage across the wide area network (WAN) link would come from
circuit-switching technologies such as Integrated Services Digital Network
(ISDN) technologies. If you didn’t have a link at all, then you would have a
service provider outage or some other type of disruption. Separate domains
mean separate replication traffic, but the amount of administrative overhead is
increased significantly.

Because it’s common to have WAN links in your business environment, you
will always need to consider how your users authenticate to a domain
controller (DC). DCs at a remote site are commonly used to authenticate users
locally to their local area network (LAN). The most common design involves
putting a DC at each remote site to keep authentication traffic from traversing
the WAN. If it is the other way around, the authentication traffic may cause
users problems if WAN utilization is high or if the link is broken and no other
way to the central site is available. The design you are apt to see most often is
one in which each server replicates its database of information to each other’s
server so that the network and its systems converge.

However, it’s important to realize that the presence of slow WAN links alone is
not a good reason to break an organization into multiple domains. The most
common solution is to set up site links with the Sites and Services Microsoft
Management Console (MMC). When you use this MMC, you can manage
replication traffic and fine-tune independently of the domain architecture.

You would want to use a multidomain architecture, such as when two
companies merge through an acquisition, for the following reasons:

Meeting Business Needs Several business needs might justify the creation
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of multiple domains. Business needs can be broken down even further into
organizational and political needs.

One of the organizational reasons for using multiple domains is to avoid
potential problems associated with the Domain Administrator account. At least
one user needs to have permissions at this level. If your organization is unable
or unwilling to trust a single person to have this level of control over all
business units, then multiple domains may be the best answer. Because each
domain maintains its own security database, you can keep permissions and
resources isolated. Through the use of trusts, however, you can still share
resources.

A political need for separate domains might arise if you had two companies
that merged with two separate but equal management staffs and two sets of
officers. In such a situation, you might need to have Active Directory split into
two separate databases to keep the security of the two groups separate. Some
such organizations may need to keep the internal groups separate by law. A
multidomain architecture provides exactly this type of pristinely separate
environment.

Many Levels of Hierarchy Larger organizations tend to have complex
internal and external business structures that dictate the need for many
different levels of organization. For example, two companies might merge and
need to keep two sets of officers who are managed under two different logical
groupings. In the, “Administer Active Directory” chapter, I showed you that
you can use OUs to help group different branches of the company so that you
can assign permissions, delegations, or whatever else you can think of without
affecting anyone else. Managing data becomes much easier when you’re using
OUs, and if you design them correctly, OUs will help you control your network
right from one console. You may need only one level of management—your
company may be small enough to warrant the use of the default OU structure
you see when Active Directory is first installed. If, however, you find that you
need many levels of OUs to manage resources (or if large numbers of objects
exist within each OU), it might make sense to create additional domains. Each
domain would contain its own OU hierarchy and serve as the root of a new set
of objects.

Decentralized Administration Two main models of administration are
commonly used: a centralized administration model and a decentralized
administration model. In the centralized administration model, a single IT
organization is responsible for managing all of the users, computers, and
security permissions for the entire organization. In the decentralized
administration model, each department or business unit might have its own IT
department. In both cases, the needs of the administration model can play a
significant role in whether you decide to use multiple domains.

Consider, for example, a multinational company that has a separate IT
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department for offices in each country. Each IT department is responsible for
supporting only the users and computers within its own region. Because the
administration model is largely decentralized, creating a separate domain for
each of these major business units might make sense from a security and
maintenance standpoint.

Multiple DNS or Domain Names Another reason you may need to use a
multidomain architecture is if you want or plan to use multiple DNS names
within your organization. If you use multiple DNS names or domain names,
you must create multiple Active Directory domains. Each AD domain can have
only one fully qualified domain name (FQDN). An FQDN is the full name of a
system that consists of a local host, a second-level domain name, and a top-
level domain (TLD). For example, corp.willPanek.comis an FQDN, .com is the
TLD, www is the host, and willpanek is the second-level domain name.

Legality One final reason you may need to use a multidomain architecture is
legality within your organization. Some corporations have to follow state or
federal regulations and laws. For this reason, they may need to have multiple
domains.

Drawbacks of Multiple Domains

Although there are many reasons why it makes sense to have multiple
domains, there are also reasons why you should not break an organizational
structure into multiple domains, many of which are related to maintenance
and administration. Here are some of the drawbacks to using multiple
domains:

Administrative Inconsistency One of the fundamental responsibilities of
most system administrators is implementing and managing security. When
you are implementing Group Policy and security settings in multiple domains,
you want to be careful to ensure that the settings are consistent. In Windows
Server 2016, security policies can be different between and within the same
domains. If this is what the organization intended, then it is not a problem.
However, if an organization wants to make the same settings apply to all users,
then each domain requires a separate GPO with similar security settings.

Increased Management Challenges Managing servers, users, and
computers can become a considerable challenge when you are also mana